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Preambolo

Questo documento costituisce la traduzione italiana dell’originale guida all’uso, installazione e
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getto alla GNU General Public License. Maggiori informazioni alla homepage di Quantum GIS
http://qgis.osgeo.org.
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del documento stesso, mentre cliccando su un link esterno si aprirà un indirizzo internet. Nel formato
PDF, i collegamenti interni sono mostrati in colore blu, mentre quelli esterni sono mostrati in colore
rosso e gestiti dal browser di sistema. In formato HTML il browser mostra e gestisce in maniera
identica entrambi i tipi di collegamento.
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License of this document

Permission is granted to copy, distribute and/or modify this document under the terms of the GNU
Free Documentation License, Version 1.3 or any later version published by the Free Software Foun-
dation; with no Invariant Sections, no Front-Cover Texts and no Back-Cover Texts. A copy of the
license is included in section D entitled GNU Free Documentation License.
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1. Premessa

Benvenuti nel meraviglioso mondo dei Sistemi Informativi Geografici (Geographical Information Sy-
stems, GIS). Quantum GIS (QGIS) è un Sistema Informativo Geografico a codice aperto (Open
Source). Il progetto è nato nel maggio 2002 ed è stato ospitato su SourceForge nel giugno dello
stesso anno. Abbiamo lavorato duramente per rendere il software GIS (che è tradizionalmente un
software proprietario costoso) una valida prospettiva per chiunque avesse disponibilità di un Personal
Computer. QGIS gira attualmente su molte piattaforme Unix (incluso ovviamente Linux!), su Windo-
ws, e OS X. QGIS è sviluppato in Qt (http://www.trolltech.com) e C++. Ciò fa sì che QGIS appaia
reattivo all’uso e piacevole e semplice da usare grazie all’interfaccia grafica (graphical user interface,
GUI).

QGIS si prefigge lo scopo di essere un GIS facile da usare, in grado di fornire funzioni e caratteristiche
di uso comune. L’obiettivo iniziale era di fornire un visualizzatore di dati GIS, ma attualmente QGIS
ha oltrepassato questo punto nel suo sviluppo, ed è usato da molti per il loro lavoro quotidiano nel
campo GIS. QGIS supporta nativamente un considerevole numero di formati raster e vettoriali, il
supporto a nuovi formati può essere facilmente inserito mediante plugin (si veda l’Appendice A per
una lista completa dei formati attualmente supportati).

QGIS è rilasciato con licenza GNU General Public License (GPL). Lo sviluppo di QGIS con questa
licenza implica che si possa ispezionare e modificare il codice sorgente in modo da garantirvi di
avere sempre accesso ad un programma GIS esente da costi di licenza e modificabile liberamente
secondo le vostre esigenze. Dovresti aver ricevuto una copia completa della licenza con la tua copia
di QGIS, puoi comunque trovarla nell’Appendice C.

Tip 1 DOCUMENTAZIONE AGGIORNATA

La versione più recente di questo documento è sempre reperibile all’indirizzo
http://download.osgeo.org/qgis/doc/manual/ o nell’area documentazione del sito di QGIS all’indirizzo
http://qgis.osgeo.org/documentation/

1.1. Caratteristiche

QGIS offre molte funzioni GIS di uso comune sia nativamente che mediante plugin. È possibile offrire
una panoramica iniziale raggruppandole sinteticamente in sei categorie.

Visualizzazione di dati

Possono essere visualizzati e sovrapposti dati vettoriali e raster in diversi formati e proiezioni senza
necessità di conversioni verso un formato comune interno. Tra i formati supportati sono inclusi:

• tabelle PostgreSQL con estensione spaziale usando PostGIS, formati vettoriali supportati dalla
libreria OGR installata, inclusi gli shapefile ESRI e i formati MapInfo, SDTS e GML (vedere
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l’Appendice A.1 per la lista completa),

• formati raster e immagine supportati dalla libreria GDAL (Geospatial Data Abstraction Library)
installata, come GeoTiff, Erdas Img., ArcInfo Ascii Grid, JPEG, PNG (vedere l’Appendice A.2
per la lista completa),

• Database SpatiaLite (vedere Sezione 5.3),

• formati raster GRASS e dati vettoriali da database GRASS (location/mapset),

• dati spaziali forniti da servizi di mappa online conformi agli standard OGC quali Web Map
Service (WMS) o Web Feature Service (WFS)

• dati OpenStreetMap.

Esplorazione dei dati e creazione delle mappe

Possono essere composte mappe ed esplorati interattivamente dati spaziali tramite un interfaccia
grafica amichevole. Tra i molti strumenti utili disponibili nell’interfaccia grafica ci sono:

• riproiezione al volo

• compositore di mappa

• pannello vista panoramica

• segnalibri geospaziali

• identifica/seleziona elementi

• modifica/vedi/cerca attributi

• etichettatura elementi

• cambio della simbologia sia raster che vettoriale

• aggiunta reticolo su un nuovo layer tramite il plugin fTools

• decorazione della mappa con freccia del nord, barra di scala ed etichetta di copyright

• salva e ricarica progetti

Creazione, modifica, gestione ed esportazione di dati

Possono essere creati, modificati, gestiti ed esportati dati vettoriali in molteplici formati. I dati raster
devono essere importati in GRASS per poter essere editati ed esportati in altri formati. QGIS offre le
seguenti funzioni:

• strumenti per digitalizzare formati supportati da OGR e layer vettoriali GRASS
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• creazione e modifica di shapefile e layer vettoriali GRASS

• georeferenziazione di immagini con l’apposito plugin

• strumenti GPS per l’importazione ed esportazione del formato GPX e conversione di altri for-
mati GPS al formato GPX o down/upload dei dati direttamente da unità GPS (su Linux, usb: è
stato aggiunto alla lista dei dispositivi GPS)

• OSM!

• creazione di layer PostGIS da shapefile con il plugin SPIT

• migliorata la gestione di tabelle PostGIS

• gestione di tabelle degli attributi di dati vettoriali con il nuovo plugin Tabella attributi (vedi
Sezione ?? ) o il plugin Gestione Tabelle

• salvare schermate come immagini georeferenziate

• visualizzare e modificare dati OpenStreetMap

Analisi di dati

Possono essere eseguite analisi spaziali di dati PostgreSQL/PostGIS e di altri formati supportati da
OGR per mezzo del plugin python fTools. QGIS offre attualmente strumenti per l’analisi, il campio-
namento, il geoprocessamento, la gestione delle geometrie e del database di dati vettoriali. Possono
inoltre essere usati gli strumenti GRASS integrati, che includono l’intera gamma delle funzioni di
GRASS di oltre 300 moduli (si veda la Sezione 9).

Pubblicazione di mappe su internet

QGIS può essere usato per esportare dati in un mapfile che può essere pubblicato su internet me-
diante un webserver sul quale sia installato UMN MapServer. QGIS può anche essere impiegato
come client WMS o WFS e come server WMS.

Estensione delle funzioni di QGIS per mezzo di plugin

QGIS può essere adattato a particolari esigenze grazie all’architettura estensibile per mezzo di plu-
gin. QGIS fornisce le librerie che possono essere usate per creare i plugin. Possono addirittura
essere creati nuovi programmi in C++ o Python.

1. Aggiunta Layer a testo delimitato (Caricamento e visualizzazione di files di testo delimitato
contenenti coordinate x,y)

2. Cattura delle Coordinate (Cattura delle coordinate del Mouse in differenti Sistemi di Riferimento)

3. Decorazioni (etichetta Diritti d’autore, Freccia nord e Barra di scala)
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4. Diagramma sovrapposto (Piazzamento di diagrammi sopra layers vettoriali)

5. Convertitore Dxf2Shp (Converte dal formato vettoriale DXF al formato vettoriale Shape)

6. Strumenti GPS (Caricamento e importazione dati GPS)

7. GRASS (Integrazione GIS con GRASS)

8. Georeferenziatore GDAL (Aggiunge le informazioni sulla proiezione al raster mediante GDAL)

9. Plugin per l’interpolazione (interpolazione basata sui vertici di un layer vettoriale)

10. Etichettamento (Etichettamento rapido su layers vettoriale)

11. Esportazione verso MapServer (Esporta un progetto QGIS in un file map di Mapserver)

12. Convertitore di Layer OGR (Trasforma layer vettoriali tra vari formati)

13. Plugin OpenStreetMap (Visualizzatore e Editor per dati OpenStreetMap)

14. Supporto per i GeoRaster Oracle

15. Installatore plugin Python (Plugin Installer)

16. Stampa rapida (Stampa una mappa con pochi comandi)

17. Analisi della morfologia terrestre basata su raster

18. SPIT (Importazione Shapefile verso PostgreSQL/PostGIS)

19. Plugin WFS (Aggiunge dei layers WFS nella vista di QGIS)

20. eVIS (Strumento per la visualizzazione di eventi)

21. fTools (Strumenti per l’analisi e la gestione di dati vettoriali)

22. Console Python (Accesso all’ambiente di gestione QGIS)

23. Installatore dei plugin in python

Plugins addizionali in python

QGIS offre un numero crescente di plugin esterni in Python forniti dalla comunità. Questi plugin sono
ospitati sul repository ufficiale PyQGIS e si possono installare facilmente usando il Gestore di Plugin
Python (si veda la Sezione 11).

Novità nella versione 1.4.0

Queste solo le principali aggiunte e miglioramenti:

• Significativo aumento di prestazioni della tabella degli attributi
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• Barra degli strumenti Editing Avanzato

• Configurazione di scorciatoie dalla finestra principale

• Unione di geometrie

• Plugin eVis

• Plugin OSM

• Nuova shell GRASS

• Il Compositore di stampe può esportare in PDF
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1.2. Convenzioni

Questa sezione descrive le convenzioni di rappresentazione grafica usate nel manuale, che si
riportano di seguito:

Convenzioni per l’interfaccia grafica (GUI)

Le convenzioni stilistiche per l’interfaccia grafica hanno lo scopo di imitare l’effettivo aspetto. In
generale, si è evitato di usare immagini o indicazioni che compaiono solo al passaggio del mouse
sopra l’indicazione, in modo che l’utente possa scorrere visivamente l’interfaccia grafica per trovare
la migliore corrispondenza con l’istruzione rappresentata nel manuale.

• Opzioni da menu: Layer > Aggiungi un layer raster

o

Impostazioni > Strumenti > ⊠ Digitalizzazione

• Strumenti: Aggiungi un layer raster

• Pulsante: Salva come default

• Titolo casella di dialogo: Proprietà layer

• Tab: Generale

• Oggetto della toolbox: nviz - Open 3D-View in NVIZ

• Casella di controllo: x Render

• Radio Button: ⊙ Postgis SRID © EPSG ID

• Scelta numerica: Hue 60 N

H

• Scelta di una stringa: Outline style —Solid Line H

• Cerca file: . . .

• Scelta colore: Colore contorno

• Barra scorrimento: Trasparenza 0% ▽
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• Inserimento testo: Nome da mostrare lakes.shp

L’ombra caratterizza un componente della GUI cliccabile.

Convenzioni per il testo o per la tastiera

Il manuale include anche convenzioni relative al testo, all’inserimento da tastiera e alle parti di codice
per indicare diverse entità, come classi o metodi. Esse non hanno alcuna corrispondenza visuale
(nel programma, ndr).

• Collegamenti web: http://qgis.org

• Pressione di tasto singolo: premere
�

�

�

�
p

• Combianzioni di tasti: premere
�

�

�

�Ctrl+B , si intende pressione del tasto B mentre si tiene premuto
il tasto Ctrl.

• Nome di un file: lakes.shp

• Nome di una classe: NewLayer

• Metodo: classFactory

• Server: myhost.de

• Inserimento di testo da parte dell’utente (al prompt dei comandi, ndr): qgis --help

Le porzioni di codice sono indicate con un font a spaziatura fissa:

PROJCS["NAD_1927_Albers",

GEOGCS["GCS_North_American_1927",

Istruzioni specifiche per ogni sistema operativo

Sequenze della GUI e piccole porzioni di testo possono essere formattate in sequenza lineare, ad es.:

Cliccare { File QGIS} > Quit per uscire da QGIS. Questa notazione indica che sui sistemi
operativi Linux, Unix e Windows, bisogna cliccare innanzitutto sull’opzione di menu File quindi su
Quit nel menu a tendina, mentre su Macintosh OSX bisogna cliccare dapprima sull’opzione di menu
QGIS, poi su Quit dal menu a tendina. Grosse porzioni di testo possono essere formattate come
lista:

• fai questo;

• fai quello;

• fai qualcosa d’altro.
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oppure in paragrafi.

Fai questo e questo e questo. Quindi fai questo e questo e questo e questo e questo e questo
e questo e questo e questo.

Fai quello. Poi fai quello e quello e quello e quello e quello e quello e quello e quello e quello e
quello e quello e quello e quello e quello e quello.

Le schermate visibili nella guida sono state create su diversi sistemi operativi, indicati da apposite
icone alla fine della didascalia.
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2. Introduzione al GIS

Un Sistema Informativo Geografico (Geographical Information System, GIS)[1]1 è un insieme di pro-
grammi che permettono di creare, visualizzare, interrogare e analizzare dati geospaziali. I dati geo-
spaziali riportano informazioni inerenti la posizione geografica di un oggetto. Questo spesso implica
l’uso di coordinate geografiche, quali valori di latitudine e longitudine. Dato spaziale è un altro termi-
ne comunemente usato, così come lo sono: dato geografico, dato GIS, mappa, location, coordinate
e geometrie spaziali.

Le applicazioni che usano dati geospaziali eseguono varie funzioni. Quella più conosciuta e facilmen-
te compresa è la produzione di mappe. I programmi per la realizzazione di mappe impiegano i dati
geospaziali e li rappresentano in una forma che sia visibile, tipicamente su uno schermo o stampati
su carta. Si possono presentare mappe statiche (una semplice immagine) o mappe dinamiche che
sono personalizzate dall’utente che ne usufruisce attraverso un’applicazione desktop o una pagina
web.

Molte persone ritengono erroneamente che le applicazioni geospaziali si riducano alla produzione
di mappe, ma l’analisi geospaziale del dato è un’altra primaria funzione di tali programmi. Alcune
tipiche analisi che possono essere condotte sono:

1. distanze tra posizioni geografiche

2. misurazione dell’area (ad. es. metri quadrati) di una certa regione geografica

3. quali elementi geografici si sovrappongono ad altri

4. determinazione dell’entità della sovrapposizione tra elementi

5. il numero di posizioni comprese entro una certa distanza da un’altra

6. e così via...

Ciò può apparire riduttivo, eppure può essere applicato in innumerevoli maniere in disparate discipli-
ne. Il risultato dell’analisi può essere mostrato su una mappa, ma è spesso tabulato in un report a
supporto di decisioni gestionali.

La recente diffusione di servizi basati sulla posizione lascia intravedere l’introduzione di ogni sorta di
ulteriori caratteristiche, ma molte di esse saranno basate sulla combinazione di mappatura e analisi.
Per esempio i cellulari tracciano la loro posizione geografica. Con un programma adatto, il telefono
può dire che tipo di ristoranti possono essere raggiunti a piedi dalla propria posizione entro una
certa distanza. Per quanto questa sia un applicazione recentissima della tecnologia geospaziale, è
essenzialmente basata su analisi geospaziale del dato e presentazione dei risultati.

1Questo capitolo è stato scritto da Tyler Mitchell (http://www.oreillynet.com/pub/wlg/7053) e usato con Licenza
Creative Commons License. Tyler is the author of Web Mapping Illustrated, pubblicato da O’Reilly, 2005.
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2 INTRODUZIONE AL GIS

2.1. Come mai così tante novità?

Bene, in realtà non è vero. Ci sono molti nuovi dispositivi hardware che consentono servizi geo-
spaziali in modalità mobile. Sono disponibili anche molti programmi geospaziali open source, ma
l’esistenza di hardware e software finalizzati all’uso del dato geospaziale non sono per niente una
novità. I ricevitori GPS (Global Positioning System, GPS) sono diventati molto comuni, ma sono usati
in diverse industrie da più di un decennio. In maniera analoga, programmi per la mappatura e l’anali-
si sono stati un preminente mercato commerciale, focalizzato primariamente su industrie dell’ambito
della gestione delle risorse naturali.

Ciò che è nuovo è come le recenti tecnologie hardware e software sono usate e da chi sono usa-
te. Gli utenti tradizionali di applicazioni per la mappatura e l’analisi erano analisti GIS fortemente
specializzati o tecnici della mappatura digitale istruiti ad usare strumenti tipo CAD. Attualmente le
capacità di calcolo dei personal computer e il software open source (Open Source Software, OSS)
hanno consentito ad un esercito di hobbysti, professionisti, sviluppatori web ecc. ecc. di interagire
con il dato geospaziale. La curva di apprendimento si è abbassata. I costi sono diminuiti. La quantità
di tecnologia geospaziale è cresciuta.

Come sono archiviati i dati geospaziali? In estrema sintesi, attualmente ci sono due tipi di dati
geospaziali di uso comune. Ciò in aggiunta al tradizionale dato in forma tabellare che è comunque
diffusamente impiegato dalle applicazioni geospaziali.

2.1.1. Dati raster

Un tipo di dato geospaziale è detto dato raster o semplicemente un raster. Il più noto dato raster
è l’immagine satellitare o la foto aerea. Le ombreggiature altimetriche o i modelli digitali di terreno
(Digital Elevation Model, DEM) sono anch’esse rappresentate come dati raster. Qualunque elemento
di mappa può essere rappresentato come dato raster, ma ci sono delle limitazioni.

Un raster è una griglia regolare fatta di celle o, nel caso di semplici immagini, di pixels. Hanno un
numero fisso di righe e colonne. Ogni cella ha un valore numerico e una certa dimensione geografica
(ad es. 30x30 metri).

Più raster sovrapposti sono utilizzati per rappresentare immagini che utilizzano più di un colore (es:
un raster per ogni set di rosso, verde e blu viene combinato per creare il colore dell’immagine). Anche
le immagini satellitari sono un esempio di dati in bande multiple. Ogni banda è essenzialmente un
livello sovrapposto al precedente dove vengono salvati i valori della lunghezza della luce. Come è
facile immaginare, un raster di grosse dimensioni occupa maggiore spazio su disco. Un raster con
celle piccole può fornire maggior dettaglio ma richiede anche più spazio. L’astuzia sta nel trovare il
giusto equilibrio tra la dimensione della cella ai fini dell’archiviazione e la dimensione della cella ai
fini analitici o di mappatura.
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2.1.2. Dati vettoriali

Anche i dati vettoriali vengono usati nelle applicazioni geospaziali. Nel suo senso più semplice, i
vettori sono un metodo di descrizione di una posizione utilizzando un insieme di coordinate. Ogni
coordinata si riferisce ad una posizione geografica utilizzando un sistema di valori y e x.

Si può pensare a tutto ciò in riferimento ad un piano cartesiano, i diagrammi di scuola che mostravano
un asse x e un asse y. Potreste averli usati per diagrammare decrescenti risparmi per la pensione
o crescenti interessi per il mutuo, ma gli stessi concetti sono alla base dell’analisi e della mappatura
del dato geospaziale.

Ci sono vari modi di rappresentare queste coordinate geografiche secondo lo scopo che ci si è
prefissi. Questo riguarda l’area di studio dei sistemi di proiezione geografica.

I dati vettoriali si presentano in tre forme, di complessità crescente e basate su quella precedente.

1. Punti - Una coppia di coordinate (x y) rappresenta una precisa posizione geografica

2. Linee - Coordinate multiple (x1 y1, x2 y2, x3 y4, ... xn yn) collegate tra loro in un certo ordine.
Equivale a disegnare una linea dal punto (x1 y1) al punto (x2 y2) e così via. Queste parti fra
ogni punto sono considerate segmenti. Hanno una lunghezza ed ad essi si può attribuire una
direzione basata sull’ordine dei punti. Tecnicamente, una linea è data da una singola coppia di
coordinate collegate insieme; una polilinea è costituita da linee multiple collegate insieme.

3. Poligoni - Quando le linee sono collegate tra loro da più di due punti, con l’ultimo punto coin-
cidente con il primo, definiscono un poligono. Triangoli, cerchi, rettangoli ecc. ecc. sono tutti
poligoni. La caratteristica principale di un poligono è che racchiudono un’area.
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3. Come iniziare

Questo capitolo fornisce una veloce panoramica dell’installazione di QGIS, alcuni dati campione
dall’homepage di QGIS e su come avviare una prima semplice sessione in cui vengano visualizzati
layer raster e vettoriali.

3.1. Installazione

L’installazione di QGIS è molto semplice. Pacchetti standard per l’installazione sono disponibili per
MS Windows e Mac OS X. Per le distribuzioni GNU/Linux sono disponibili pacchetti binari (rpm
and deb) o repositories software da aggiungere al gestore di installazione. Informazioni aggiornate
possono essere reperite sul sito web di QGIS http://qgis.osgeo.org/download/.

Installazione da codice sorgente

Se si rende necessario compilare QGIS da sorgente si può fare riferimento alla guida per la compila-
zione disponibile su http://qgis.osgeo.org/documentation/. Le istruzioni per l’installazione sono
anche distribuite con il codice sorgente.

3.2. Dati campione

La guida utente contiene esempi basati sul set di dati campione di QGIS.

L’installer per Windows comprende un’opzione per scaricare il set di dati campione di QGIS. Se
selezionato, i dati verranno scaricati nella vostra cartella My Documents e posizionata in una cartella
denominata GIS Database. Può essere usato Windows Explorer per spostare in questa cartella in
qualunque altra posizione. Qualora non fosse stata selezionata l’opzione di installare il set di dati
campione durante l’installazione iniziale di QGIS è possibile:

• usare dati GIS già posseduti;

• scaricare il set di dati dal sito di QGIS http://qgis.osgeo.org/download; oppure

• disinstallare QGIS e reinstallarlo selezionando l’opzione per lo scaricamento dei dati, solo se la
soluzione precedente non ha successo.

Per GNU/Linux e Mac OSX non sono ancora disponibili pacchetti di installazione del set di dati
campione in formato rpm, deb or dmg. Per usare il set di dati campione scaricare il file qgis_sample_-

data come archivio ZIP o TAR da http://download.osgeo.org/qgis/data/ e decomprimerlo sul
vostro sistema. Il dataset Alaska include tutti i dati GIS usati come esempi e schermate nella guida
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3.3 Sessione di esempio

utente, includendo anche un piccolo database GRASS. La proiezione usata per il set di dati di QGIS
è Alaska Albers Equal Area con unità in piedi. Il codice EPSG di questa proiezione è 2964.

PROJCS["Albers Equal Area",

GEOGCS["NAD27",

DATUM["North_American_Datum_1927",

SPHEROID["Clarke 1866",6378206.4,294.978698213898,

AUTHORITY["EPSG","7008"]],

TOWGS84[-3,142,183,0,0,0,0],

AUTHORITY["EPSG","6267"]],

PRIMEM["Greenwich",0,

AUTHORITY["EPSG","8901"]],

UNIT["degree",0.0174532925199433,

AUTHORITY["EPSG","9108"]],

AUTHORITY["EPSG","4267"]],

PROJECTION["Albers_Conic_Equal_Area"],

PARAMETER["standard_parallel_1",55],

PARAMETER["standard_parallel_2",65],

PARAMETER["latitude_of_center",50],

PARAMETER["longitude_of_center",-154],

PARAMETER["false_easting",0],

PARAMETER["false_northing",0],

UNIT["us_survey_feet",0.3048006096012192]]

Se s’intende usare QGIS come interfaccia per GRASS, sono disponibili delle locations campione (ad
es. Spearfish or South Dakota) sul sito ufficiale di GRASS GIS
http://grass.osgeo.org/download/data.php.

3.3. Sessione di esempio

Ora che si è installato QGIS e si ha a disposizione un set di dati campione, dimostreremo una
breve e semplice sessione di QGIS. Visualizzeremo un layer raster ed uno vettoriale. Useremo
il layer raster dell’uso del suolo qgis_sample_data/raster/landcover.img e il layer vettoriale dei
laghi qgis_sample_data/gml/lakes.gml.

Avvio di QGIS

• Avviate QGIS scrivendo: qgis al prompt dei comandi, oppure se si utilizzano pacchetti binari
precompilati, utilizzando il menu delle applicazioni.
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3 COME INIZIARE

• Avviate QGIS usando il menu Start o l’icona sul desktop, oppure facendo doppo click su un
file di progetto QGIS.

• Doppio click sull’icona nella cartella Applicazioni.

Figura 1: Una sessione di esempio in QGIS

Caricare dati raster e vettoriali dal set di dati campione

1. Cliccate sull’icona Carica layer raster .

2. Individuate la cartella qgis_sample_data/raster/, selezionate il file ERDAS Img

landcover.img e cliccate Apri .

3. Se il file non appare nella lista, controllare se il tipo di file selezionato nel menu in basso della
finestra di dialogo è corretto, in questo caso Immagine ERDAS (*.img, *.IMG)

4. Ora cliccate sull’icona Carica layer vettoriale .
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3.3 Sessione di esempio

5. ⊙ ’File’ deve essere selezionato come tipo di sorgente nel nuovo Carica Layer vettoriale

finestra di dialogo. Ora cliccate Sfoglia per selezionare il layer vettoriale.

6. Individuate la cartella qgis_sample_data/gml/, selezionate GML dal menu tipo file, poi sele-

zionate il file GML lakes.gml e cliccate Apri , poi nella finestra di dialogo Aggiungi Layer

vettoriale cliccate OK .

7. Ingrandite un pò la visuale su un’area a vostra scelta con alcuni laghi.

8. Fate doppio click sul layer lakes nella legenda per aprire la finestra Proprietà del vettoriale .

9. Cliccate sulla scheda Simbologia e selezionate blu come colore di riempimento.

10. Cliccate sulla scheda Etichette e spuntate l’opzione x Mostra etichette per abilitare
l’etichettatura. Scegliete il campo NOME come campo che contiene l’etichetta.

11. Per migliorare la leggibilità dell’etichetta, è possibile aggiungere un buffer bianco che la contie-

ne, cliccando su “Buffer” nella lista sulla sinistra, spuntate x Buffer etichette? e scegliete 3
come dimensione del buffer.

12. Cliccate Applica , controllate se il risultato è buono ed infine premete il tasto OK .

Visto come è facile visualizzare layer raster e vettoriali in QGIS? Proseguiamo alla sezione seguente
per imparare ulteriori funzioni disponibili, caratteristiche e impostazioni e come usarle.
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4. Panoramica sulle caratteristiche

Dopo un primo sguardo e una semplice sessione d’esempio nella Sezione 3, forniamo in questo
capitolo una panoramica maggiormente dettagliata delle caratteristiche di QGIS. Molte delle carat-
teristiche presentate nei successivi capitoli saranno spiegate e descritte nelle apposite sezioni del
manuale.

4.1. Avvio e chiusura di QGIS

Nella sezione 3.3 abbiamo già imparato come avviare QGIS. Ripeteremo questa operazione qui per
mostrare come QGIS fornisca ulteriori opzioni all’avvio da riga di comando.

• Assumendo che QGIS sia installato nel vostro PATH, si può avviare QGIS digitando: qgis al
prompt dei comandi o facendo doppio click sul collegamento all’applicazione (o allo shortcut)
sul desktop o nel menu delle applicazioni.

• Avviare QGIS usando il menu Avvio (Start) o il collegamento sul desktop, o facendo doppio
click su un progetto QGIS precedentemente salvato.

• Fare doppio click sull’icona QGIS nella cartella Applicazioni (Applications). Se si vuole
avviare QGIS in una shell, eseguire /percorso-installatione-eseguibile/Contents/MacOS/Qgis.

Per uscire da QGIS, cliccare sul menu { File QGIS} > Esci, o usate la scorciatoia da tastiera�

�

�

�Ctrl+Q .

4.1.1. Opzioni da linea di comando

QGIS supporta un certo numero di opzioni se avviato da riga di comando. Per avere una lista
delle opzioni possibili, digitare qgis --help al prompt dei comandi. La sintassi d’uso di QGIS è:

qgis --help

Quantum GIS - 1.4.0-Enceladus ’Enceladus’ (exported)

Quantum GIS (QGIS) is a viewer for spatial data sets, including

raster and vector data.

Usage: qgis [options] [FILES]

options:

[--snapshot filename] emit snapshot of loaded datasets to given file

[--width width] width of snapshot to emit

[--height height] height of snapshot to emit

[--lang language] use language for interface text

[--project projectfile] load the given QGIS project
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[--extent xmin,ymin,xmax,ymax] set initial map extent

[--nologo] hide splash screen

[--help] this text

FILES:

Files specified on the command line can include rasters,

vectors, and QGIS project files (.qgs):

1. Rasters - Supported formats include GeoTiff, DEM

and others supported by GDAL

2. Vectors - Supported formats include ESRI Shapefiles

and others supported by OGR and PostgreSQL layers using

the PostGIS extension

Tip 2 ESEMPIO DI UTILIZZO DELLE OPZIONI DA RIGA DI COMANDO

QGIS può essere avviato specificando uno o più files da riga di comando. Per esempio, assunto che ci si trovi
nella directory qgis_sample_data, si può avviare QGIS con un layer vettoriale e un file raster inserendo il
seguente comando: qgis ./raster/landcover.img ./gml/lakes.gml

Opzione da linea di comando --snapshot

L’opzione consente di creare uno snapshot in formato PNG della vista corrente. Questo può essere
utile quando si hanno molti progetti e si vogliono generare schermate dai propri dati.

Il file PNG generato ha una risoluzione di 800x600 pixels. Questa può essere adattata usando
gli argomenti --width e --height da riga di comando. Dopo l’opzione --snapshot può essere
specificato il nome del file con cui si vuole salvare l’immagine.

Opzione da linea di comando --lang

L’interfaccia di QGIS si presenta nella lingua definita dal setting del locale di sistema. Se si desidera
l’interfaccia in un’altra lingua, può essere specificato all’avvio. Ad esempio: --lang=en fa sì che QGIS
si avvii localizzato in inglese. Un elenco delle lingue correntemente supportate è fornito all’indirizzo
http://wiki.qgis.org/qgiswiki/TranslatorsCorner

Opzione da linea di comando --project

È possibile avviare QGIS anche con un file di progetto. Basta semplicemente aggiungere l’opzione da
riga di comando --project seguita dal percorso e dal nome del progetto e QGIS si aprirà caricando
tutti i layer indicati nel file specificato.

Opzione da linea di comando --extent

Per fare sì che QGIS si avvii visualizzando una specifica porzione di mappa, è necessario specificare
i limiti dell’estensione che si intende visualizzare secondo il seguente ordine, con ogni valore separato
da virgole:
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--extent xmin,ymin,xmax,ymax

Opzione da linea di comando --nologo

Questo argomento da riga di comando nasconde lo splash screen quando QGIS viene avviato.

4.2. Interfaccia QGIS

All’avvio di QGIS si visualizza l’interfaccia grafica riprodotta dalla seguente immagine (i numeri da 1
a 6 negli ovali gialli fanno riferimento alle sei principali aree della interfaccia come qui specificato):

Figura 2: Interfaccia grafica di QGIS GUI con dati campione dell’Alaska (KDE)

Nota: L’aspetto delle finestre (barra del titolo, ecc.) può apparire diverso secondo il sistema operativo
e il gestore di finestre adottato.
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4.2 Interfaccia QGIS

L’interfaccia di QGIS è divisa in sei aree:

1. Barra Menu 4. Vista Mappa
2. Barra Strumenti 5. Panoramica
3. Legenda 6. Barra di Stato

Le sei componenti dell’interfaccia di QGIS saranno descritte con maggior dettaglio nelle sezioni
seguenti.

4.2.1. Scorciatoie da tastiera

QGIS provides default keyboard shortcuts for many features. You find them in Section 4.2.2 be-
low. Additionally the menu option Settings > Configure Shortcuts allows to change the default
keyboard shortcuts and to add new keyboard shortcuts to QGIS features.

Figura 3: Define shortcut options (KDE)

Configuration is very simple. Just select a feature from the list and click on Change , Set none

or Set default . Once you have found your configuration, you can save it as XML file and load it to
another QGIS installation.

QGIS 1.4.0 User Guide 19



4 PANORAMICA SULLE CARATTERISTICHE

4.2.2. Barra menu

La barra menu fornisce accesso alle varie caratteristiche di QGIS utilizzando un menu gerarchico
standard. Le voci gerarchicamente più elevate e una sintesi di alcune opzioni di menu sono elen-
cate di seguito, assieme alle icone dello strumento corrispondente così come appaiono nella barra
strumenti e alle scorciatoie da tastiera per richiamarle.2 Sebbene molte voci di menu abbiano uno
strumento corrispondente e viceversa, i menu non sono organizzati esattamente come le barre stru-
menti. La barra strumenti che contiene lo strumento descritto è indicata dopo ogni voce di menu con
l’aspetto di una casella di controllo (checkbox). Per ulteriori informazioni su strumenti e barre degli
strumenti, si veda la Sezione 4.2.3.

Voce di Menu Scorciatoia Riferimento Barra strumenti

• File

Nuovo progetto
�

�

�

�Ctrl+N vedi Sezione 4.5 ⊠ File

Apri progetto
�

�

�

�Ctrl+O vedi Sezione 4.5 ⊠ File
Apri progetti recenti vedi Sezione 4.5

Salva progetto
�

�

�

�Ctrl+S vedi Sezione 4.5 ⊠ File

Salva progetto con nome
�

�

�

�Ctrl+Shift+S vedi Sezione 4.5 ⊠ File

Salva come immagine vedi Sezione 4.6

Nuovo sistema di stampa
�

�

�

�Ctrl+P vedi Sezione 10 ⊠ File

Gestore di stampe vedi Sezione 10 ⊠ File
Print Composers see Section 10

Esci
�

�

�

�Ctrl+Q

• Modifica

Annulla
�

�

�

�Ctrl+Z vedi Sezione 5.5.3 ⊠ Digitalizza

Ripristina
�

�

�

�Ctrl+Shift+Z vedi Sezione 5.5.3 ⊠ Digitalizza

Taglia geometrie
�

�

�

�Ctrl+X vedi Sezione 5.5.3 ⊠ Digitalizza

Copia geometrie
�

�

�

�Ctrl+C vedi Sezione 5.5.3 ⊠ Digitalizza

Incolla geometrie
�

�

�

�Ctrl+V vedi Sezione 5.5.3 ⊠ Digitalizza

Sposta geometrie vedi Sezione 5.5.3 ⊠ Digitalizza

Elimina la selezione vedi Sezione 5.5.3 ⊠ Digitalizza

2Le scorciatoie da tastiera ora possono essere configurate manualmente (le scorciatoie presentate in questa sezione
sono quelle di default), usando lo Strumento Configura nel Menu Impostazioni.
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Simplify Feature vedi Sezione ?? ⊠ Advanced Digitizing

Aggiungi un buco vedi Sezione ?? ⊠ Advanced Digitizing

Aggiungi una parte vedi Sezione ?? ⊠ Advanced Digitizing

Elimina buco vedi Sezione ?? ⊠ Advanced Digitizing

Elimina parte vedi Sezione ?? ⊠ Advanced Digitizing

Modifica la forma vedi Sezione ?? ⊠ Advanced Digitizing

Spezza elemento vedi Sezione ?? ⊠ Advanced Digitizing

Unisci le geometrie selezionate vedi Sezione ?? ⊠ Advanced Digitizing

Node Tool vedi Sezione 5.5.3 ⊠ Digitalizza

Ruota i simboli per i punti vedi Sezione ?? ⊠ Advanced Digitizing

After activating toogle editing mode for a layer, you will find a capture feature icon in

the Edit menu depending on the layer type (point, line or polygon).

Capture Point see Section 5.5.3 ⊠ Digitizing

Capture Line see Section 5.5.3 ⊠ Digitizing

Capture Polygon see Section 5.5.3 ⊠ Digitizing

• Visualizza

Sposta mappa ⊠ Navigazione mappa

Ingrandisci
�

�

�

�Ctrl++ ⊠ Navigazione mappa

Rimpicciolisci
�

�

�

�Ctrl+- ⊠ Navigazione mappa

Seleziona geometrie ⊠ Attributi

Informazioni geometrie
�

�

�

�I ⊠ Attributi

Misura linea
�

�

�

�M ⊠ Attributi

Calcola l’area
�

�

�

�J ⊠ Attributi

Vista massima
�

�

�

�F ⊠ Navigazione mappa

Zoom sul layer ⊠ Navigazione mappa

Zoom sulla selezione
�

�

�

�Ctrl+J ⊠ Navigazione mappa

Ultimo zoom ⊠ Navigazione mappa

Prossimo zoom ⊠ Navigazione mappa

Zoom dimensione corrente
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Suggerimenti mappa ⊠ Attributi

Nuovo segnalibro
�

�

�

�Ctrl+B vedi Sezione 4.8 ⊠ Attributi

Mostra segnalibri
�

�

�

�B vedi Sezione 4.8 ⊠ Attributi

Aggiorna
�

�

�

�Ctrl+R ⊠ Navigazione mappa

• Layer

Nuovo layer vettoriale
�

�

�

�Ctrl+Shift+N vedi Sezione 5.5.4 ⊠ Gestisci layer

Aggiungi layer vettoriale
�

�

�

�Ctrl+Shift+V vedi Sezione 5 ⊠ File

Aggiungi layer raster
�

�

�

�Ctrl+Shift+R vedi Sezione 6 ⊠ File

Aggiungi layer PostGIS
�

�

�

�Ctrl+Shift+D vedi Sezione 5.2 ⊠ File

Aggiungi layer SpatiaLite
�

�

�

�Ctrl+Shift+L vedi Sezione 5.3 ⊠ File

Aggiungi layer WMS
�

�

�

�Ctrl+Shift+W vedi Sezione 7.2 ⊠ File

Apri tabella attributi ⊠ Attributi

Attiva/disattiva modifica ⊠ Digitalizza

Salva come shapefile

Salva selezione come shapefile

Elimina Layer
�

�

�

�Ctrl+D ⊠ Gestisci layer

Proprietà

Aggiungi alla panoramica
�

�

�

�Ctrl+Shift+O ⊠ Gestisci layer

Aggiungi tutto alla panoramica

Rimuovi tutto dalla panoramica

Nascondi tutti i layer
�

�

�

�Ctrl+Shift+H ⊠ Gestisci layer

Mostra tutti i layer
�

�

�

�Ctrl+Shift+S ⊠ Gestisci layer

• Impostazioni

Pannelli
Barre degli strumenti

Attiva/Disattiva schermo intero

Proprietà progetto
�

�

�

�P vedi Sezione 4.5

CRS personalizzato vedi Sezione 8.4

Gestore di stili

Configura scorciatoie

Opzioni vedi Sezione 4.7
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• Plugins - (Ulteriori voci di menu vengono aggiunte quando si installano e caricano nuovi
plugin.)

Gestione Plugins vedi Sezione 11.1 ⊠ Plugin

Python Console

• Aiuto

Aiuto contenuti
�

�

�

�F1 ⊠ Aiuto

QGIS Home Page
�

�

�

�Ctrl+H

Controlla versione QGIS

Informazioni

Nota: Gli elementi della barra menu elencati di seguito sono quelli di default nel gestore finestre
di KDE. In GNOME il menu Impostazioni non è presente e i suoi elementi devono essere cercati qui:

Project Properties ⊠ File menu

Options ⊠ Edit

Custom CRS ⊠ Edit

Panels ⊠ View

Toolbars ⊠ View
Toggle Fullscreen Mode ⊠ View

4.2.3. Barre degli strumenti

Le barre degli strumenti forniscono accesso alla maggior parte delle medesime funzioni presenti nei
menu, oltre a funzioni addizionali per interagire con la mappa. Ogni oggetto della barra strumenti ha
disponibile un aiuto a comparsa. Lasciando il cursore del mouse sopra l’icona verrà visualizzata una
breve descrizione della funzione fornita da quello strumento.

Ogni barra può essere spostata secondo le preferenze personali. Inoltre ognuna di esse può essere
disattivata dal menu contestuale ottenibile cliccando con il tasto destro sulla barra degli strumenti.

Tip 3 RIPRISTINARE BARRE DEGLI STRUMENTI

Se avete accidentalmente disattivato tutte le barre strumenti, possono essere ripristinate dalla voce di menu
Impostazioni > Barre degli strumenti .
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4.2.4. Legenda

L’area di legenda è usata per impostare la visibilità e l’ordine di sovrapposizione dei layer: i layer in
cima alla legenda coprono nella mappa quelli sottostanti. La casella di controllo in ogni legenda può
essere usata per attivare/disattivare la visibilità di un layer.

È possibile raggruppare layer nella legenda aggiungendo un gruppo e trascinando i layer nel gruppo.
Per fare ciò cliccare con il tasto destro nell’area di legenda, scegliere Aggiungi gruppo . Apparirà

una nuova cartella nella quale possono essere trascinati i layer che si intendono raggruppare. È
quindi possibile attivare/disattivare la visibilità di tutti i layer nel gruppo con un solo click. Per estrarre
un layer dal gruppo, muovere il puntatore del mouse sul simbolo del layer, cliccare con il tasto destro
e scegliere Crea all’oggetto in cima . Per rinominare il gruppo, fare click con il tasto destro sulla

cartella e scegliere Rinomina dal menu contestuale.

Il contenuto del menu contestuale varia a seconda che si faccia click col tasto destro su un layer
raster o vettoriale. Per i layer vettoriali di GRASS la voce di menu Attiva/disattiva modifica non è
abilitata. Si veda la sezione 9.7 per informazioni su come editare layer vettoriali GRASS.

• Menu relativo ai raster attivabile con il tasto destro del mouse

– Zoom all’estensione del layer

– Zoom alla scala migliore (100%)

– Aggiungi alla panoramica

– Rimuovi

– Proprietà

– Rinomina

– Aggiungi gruppo

– Espandi tutto

– Comprimi tutto

– Mostra gruppi

• Menu relativo ai vettoriali attivabile con il tasto destro del mouse

– Zoom all’estensione del layer

– Aggiungi alla panoramica
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– Rimuovi

– Apri tabella attributi

– Attiva/disattiva modifica (non disponibile per layer GRASS)

– Salva come shapefile

– Salva selezione come shapefile

– Proprietà

– Rinomina

– Aggiungi gruppo

– Espandi tutto

– Comprimi tutto

• Menu relativo ai gruppi di layer attivabile con il tasto destro del mo use

– Rimuovi

– Rinomina

– Aggiungi gruppo

– Espandi tutto

– Comprimi tutto

– Mostra gruppi

Se diversi vettori hanno lo stesso tipo di geometria e gli stessi attributi le loro proprietà di visualizza-
zione possono essere raggruppate. Questo significa che se la proprietà di visualizzazione di un layer
è cambiata automaticamente gli altri prenderanno lo stesso tipo di visualizzazione. Per raggruppare
la simbologia scegli la voce Mostra gruppi dal menu contestuale dei Gruppi di layer e sarà pos-
sibile trascinare i file da un file di gruppo ad un un altro. Se questo verrà fatto la simbologia sarà
raggruppata. Nota che QGIS permette di spostare i file di gruppo solo se i due layer sono compatibili
(stesso geometria e stessi attributi).
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4.2.5. Il visualizzatore di mappa

Questa è l’area in cui le mappe vengono visualizzate. La mappa visualizzata in questa finestra sarà
il risultato dei layer vettoriali e raster che avete scelto di caricare (vedere le sezioni che seguono
per ulteriori informazioni su come caricare i layer). La zona di visualizzazione della mappa può
essere modificata (spostando la messa a fuoco dell’esposizione della mappa ad un’altra regione) ed
è possibile effettuare operazioni di zoom in ed out (+ e -). Varie altre operazioni sono descritte nella
sezione relativa alla barra dei menu. La vista nell’area di mappa e la legenda sono strettamente
legate l’una all’altra: le mappe che vengono visualizzate riflettono i cambiamenti che fate nella zona
della legenda.

Tip 4 ZOOMARE RAPIDAMENTE CON LA ROTELLA DEL MOUSE

Può essere usata la rotella del mouse per le operazioni di zoom. Posizionando il puntatore nell’area di
visualizzazione delle mappe si aumenta lo zoom girando la rotella verso lo schermo, lo si riduce girandola
verso di sé. La posizione del puntatore costituisce il centro per l’ingrandimento. Il comportamento della

funzione di zoom con la rotella del mouse può essere regolata dalla scheda Strumenti di mappa sotto il

menu Impostazioni > Opzioni .

Tip 5 MUOVERE LA MAPPA CON I TASTI FRECCIA E LA BARRA SPAZIATRICE

È possibile usare i tasti freccia per muovere la mappa. Posizionando il puntatore del mouse nell’area di
visualizzazione delle mappe, ci si muove verso Est con la freccia destra, verso Ovest con quella sinistra,
verso Nord con la freccia Sù e verso Sud con la freccia Giù. Si può spostare la mappa anche tenendo
premuta la barra spaziatrice e muovendo il mouse.

4.2.6. Panoramica della mappa

Il pannello di panoramica della mappa fornisce una vista completa dei layer aggiunti ad essa. Può
esssere selezionato nel menu Impostazioni . > Pannelli . All’interno della panoramica c’è un rettan-
golo che mostra l’estensione corrente della mappa. Ciò permette di determinare rapidamente quale
area della mappa state attualmente osservando. Si noti che le etichette non sono visualizzate nella
panoramica della mappa anche se i layer hanno la funzione di visualizzazione delle etichette attiva
labeling.

Può essere aggiunto un singolo layer alla panoramica facendo click col tasto destro su di esso nella

legenda e scegliendo poi x Aggiungi alla panoramica . Possono anche essere aggiunti o rimossi
tutti i layer nella panoramica usando lo strumento Panoramica nella barra degli strumenti.

Cliccando e trascinando nella panoramica il rettangolo rosso che mostra l’estensione corrente della
vostra visuale, la mappa visualizzata si sposta di conseguenza.
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4.2.7. Barra di stato

La barra di stato mostra la posizione del cursore attuale nella mappa nelle coordinate specificate (es.
metri o gradi decimali). Nella barra di stato a sinistra del visore delle coordinate è presente un piccolo
pulsante che consente di passare dalla visione delle coordinate al movimento del puntatore a quella
dell’estensione della vista quando si effettua lo zoom.

Una barra di avanzamento nella barra di stato mostra il progredire della visualizzazione di ogni layer
nella vista mappa. In alcuni casi, come quando vengono raccolte informazioni statistiche sul layer
raster, questa barra è utilizzata per mostrare lo stato di tali processi, in genere molto lunghi.

Se è disponibile un nuovo plugin o un aggiornamento ad un plugin installato, nella barra di stato
apparirà un avviso. Sulla destra della barra di stato è presente una casella di controllo (checkbox)
che può essere usata per disattivare temporaneamente la visualizzazione dei layer nella vista (vedi
Sezione 4.3 più avanti). All’estrema destra della barra di stato è presente l’icona di un proiettore.
Cliccando su di essa si apre la finestra con le proprietà della proiezione del progetto corrente.

Tip 6 CALCOLARE LA SCALA CORRETTA DELLA MAPPA

Quando si avvia QGIS, l’unità di default sono i gradi, il che fa si che QGIS interpreti ogni coordinata del layer
in gradi. Per avere il corretto valore della scala, è possibile sia cambiare manualmente l’unità di misura a
metri nella scheda Generale sotto il menu Impostazioni > Proprietà progetto oppure può essere scelto
un Sistema di Riferimento per le Coordinate (Coordinate Reference System, CRS), cliccando sull’icona

Stato CRS nell’angolo in basso a destra della barra di stato. In quest’ultimo caso, le unità della
mappa sono impostate a quelle che specifica la proiezione scelta, ad es. +units=m.

4.3. Visualizzazione

Come impostazione di default QGIS ricarica nella vista tutti i layer visibili ogni qualvolta la vista debba
essere aggiornata. Gli eventi che richiedono l’aggiornamento della vista includono:

• Aggiunta di un layer

• Spostamento, ingrandimento o riduzione

• Ridimensionamento della finestra di QGIS

• Cambiamento della visibilità di uno o più layer

QGIS consente di controllare il processo di resa a video in diverse maniere.
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4.3.1. Visualizzazione in funzione della scala

La visualizzazione in funzione della scala consente di specificare la scala minima e massima
rispettivamente al di sotto e al di sopra della quale un layer è visibile. Per impostare la vi-
sualizzazione in funzione della scala, aprire la finestra di dialogo Proprietà facendo dop-

pio click sul layer nella legenda. Nella scheda Generale , spuntare la casella di controllo

x Utilizzare una scala in relazione al rendering e impostare i valori per la scala minima e massima.

I valori di scala possono essere determinati usando prima lo zoom sul layer per il quale si vuole
impostare l’opzione e prendendo successivamente nota del valore di scala visualizzato nella barra di
stato di QGIS.

4.3.2. Controllo della resa a video della mappa

La resa a video mappa può essere controllata nei seguenti modi:

a) Sospensione della resa a video

Per sospendere la resa a video, cliccare sulla casella di controllo x Disegna in basso a destra

della barra di stato. Quando la casella x Disegna non è selezionata, QGIS non ridisegna la vista
quando si verifica uno degli eventi precedentemente descritti alla Sezione 4.3. Casi in cui si potrebbe
voler sospendere la visualizzazione a video includono:

• Aggiunta di molti layer e applicazione di uno stile visuale prima della resa

• Aggiunta di uno o più layer di grosse dimensioni e impostazione di una scala prima della resa

• Aggiunta di uno o più layer di grossa dimensione e zoom ad un’area specifica prima della resa

• Combinazioni delle precedenti

Selezionando la casella di controllo x Disegna abilita la resa a video e causa l’immediata
rivisualizzazione della vista mappa.

b) Regolazione dell’opzione per controllare la visibilità dei layer quando s ono aggiunti

Può essere scelta l’opzione di caricare i nuovi layer senza che essi vengano immediatamente resi a
video. Ciò significa che quando si aggiungerà un layer al progetto la casella di controllo per la visibilità
nella legenda sarà disabilitata di default. Per impostare questa opzione, scegliere l’opzione di menu
Impostazioni > Opzioni e cliccate sulla scheda Disegno . Deselezionare la casella di controllo
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x Per impostazione predefinita i nuovi layer aggiunti alla mappa vengono visualizzati subito . Ogni
layer aggiunto alla mappa sarà quindi spento (invisibile) di default.

c) Aggiornamento della mappa durante la visualizzazione

Può essere impostata un’opzione per aggiornare la mappa man mano che gli elementi del layer ven-
gono letti. Di default, QGIS non traccia alcun elemento a video fino a che l’intero layer non sia stato
letto. Per aggiornare la visualizzazione man mano che gli elementi vengono letti dall’archivio, selezio-

nare la voce di menu Impostazioni > Opzioni e cliccare sulla scheda Disegno tab. Impostare il
numero di elementi che si desidera vengano letti prima che lo schermo venga aggiornato. Un valore
pari a 0 disabilita l’aggiornamento durante la tracciatura degli oggetti (impostazione predefinita). Un
valore troppo basso diminuisce le prestazioni in quanto la mappa viene continuamente aggiornata
man mano che gli elementi del layer vengono letti. Il valore di prova suggerito per iniziare è 500.

d) Modificare la qualità della resa a video

Vi sono 3 opzioni per modificare la qualità della resa a video. Dal menu Impostazioni > Opzioni

cliccare sulla scheda Disegno e selezionare o deselezionare le seguenti caselle di controllo.

• x Rendi le linee meno dettagliate in favore di migliori prestazioni nel disegno

• x Risolvi problemi con poligoni riempiti non correttamente

4.4. Misurazioni

È possibile effettuare misure unicamente nei sistemi di coordinate piani (es. UTM). Se la mappa
caricata è definita in un sistema di coordinate geografiche (es. latitudine/longitudine), il risultato della
misura di linee o di aree saranno errati. Per misurare è quindi necessario impostare correttamente il
sistema di coordinate della mappa (si veda la Sezione 8).

4.4.1. Misurare lunghezze e aree

QGIS è in grado di fornire la misura di distanza reale tra due punti in funzione di un definito el-
lissoide. Ciò può essere configurato dall’opzione di menu Impostazioni > Opzioni , cliccando sulla

scheda Strumenti mappa e scegliendo l’ellissoide appropriato. Qui sarà possibile inolre definire a
rubberband color e l’unità di misura preferita (metri o piedi). Lo strumento consentirà allora di cliccare
punti sulla mappa. La misura di ogni segmento verrà mostrata nella finestra dello strumento insieme
alla misura totale. Per terminare la funzione misura cliccare con il tasto destro del mouse.

QGIS 1.4.0 User Guide 29



4 PANORAMICA SULLE CARATTERISTICHE

Questo strumento consente la misura di aree, la finestra mostrerà unicamente l’area totale mi-
surata.
In aggiunta, lo strumento di misura farà lo snap sul layer selezionato al momento, nel caso il layer
abbia definita la sua tollezanza di snap. (Vedi Sezione ?? ). Se dunque si vuole misurare esattamente
lungo una linea o un poligono, è necessario prima definire la sua tolleranza di snap, poi selezionae il
layer. In questo modo, quando vengono usati gli strumenti di misura, ogni click del mouse (all’interno
della tolleranza definita) si aggancerà a quel layer.

Figura 4: Strumento di misura in azione

(a) Misura linee (b) Misura aree

4.5. Progetti

Lo stato della sessione QGIS è considerata un progetto. È possibile lavorare su un progetto alla
volta. Le impostazioni possono essere settate per ogni singolo progetto oppure come default per tutti
i nuovi progetti (si veda la Sezione 4.7). Lo stato della sessione corrente può essere salvato in un

progetto usando la voce di menu File > Salva progetto o File > Salva progetto con nome .

Per caricare progetti salvati usare File > Apri progetto o File > Apri progetti recenti . Se si

vuole eliminare la sessione corrente e ricominciare da zero, scegliere File > Nuovo progetto .
Ognuna di queste voci di menu chiederà se si vuole salvare la sessione corrente se sono stati
effettuati cambiamenti dall’ultima volta in cui essa è stata aperta o salvata.

Le informazioni salvate nel file di progetto includono:

• Layers aggiunti

• Proprietà dei layer, inclusa la loro rappresentazione grafica

• Proiezione usata per la vista

• Ultima estensione della vista (scala e inquadramento)
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Il file di progetto è salvato in formato XML, così che sia possibile editarlo esternamente a QGIS con
qualunque editor se se conosce la sintassi. Il formato del file di progetto è stato modificato parecchie
volte rispetto a quello delle precedenti versioni di QGIS, di conseguenza file di progetto salvati con
precedenti versioni di QGIS potrebbero non funzionare più correttamente. Si può essere avvertiti
preventivamente di ciò selezionando dalla scheda Generale nel menu Impostazioni > Opzioni

la casella di controllo

x Promt to save project changes when required

x Avvisa quando un file di progetto viene salvato con una vecchia versione di QGIS .

Proprietà progetto

Nella finestra delle proprietà del progetto (sotto File > Proprietà progetto o Impostazioni

> Proprietà progetto possono essere impostate opzioni specifiche del progetto. Queste includono:

• Nella tabella Generale il titolo del progetto, unità, e l’opzione per salvare i percorsi relativi ai
layer. Qui possono essere impostate anche opzioni per l’editing topologico e per lo snapping.

• La tabella CRS Sistema di proiezione delle coordinate permette di scegliere il sistema di pro-
iezione delle coordinate e di abilitare la riproiezione al volo dei layer vettoriali quando vengono
visualizzati layer con differenti CRS.

• Con la terza tabella Layer interrogabili è possibile impostare (o disabilitare) quali layer rispon-
deranno allo strumento di interrogazione. (Vedere il paragrafo Strumenti mappa nella sezione
4.7 per abilitare l’interrogazione di layer multipli.)

4.6. Output

Ci sono diversi modi di generare file di output dalla sessione QGIS. Il primo è stato descritto alla
Sezione 4.5 e consiste nel salvataggio su file di progetto. Altri modi di produrre file di output sono ad
esempio:

• L’opzione di menu Salva come immagine apre una finestra del file browser nella quale
indicare nome, percorso ed estensione del formato immagine (PNG or JPG).

• L’opzione di menu Compositore stampe apre una finestra nella quale è possibile comporre
un layout per stampare la vista mappa corrente (vedi Sezione 10).
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4.7. Opzioni dell’interfaccia grafica (GUI)

Alcune opzioni di base per QGIS possono essere impostate dalla finestra Opzioni dialog.

Selezionare la voce di menu Impostazioni > Opzioni . Le schede nelle quali possono essere
regolate le opzioni sono:

Generale

• x Suggerisci di salvare i cambiamenti di progetto se necessario

• x Avvisa quando un file di progetto viene salvato con una vecchia versione di QGIS

• Scelta del colore per evidenziare la selezione e lo sfondo della vista mappa

• Cambio del tema delle icone (scelta tra default, classica, gis e nkids)

• x Rendi maiuscoli i nomi dei layer nella legenda

• x Visualizza i nomi degli attributi della classificazione della legenda

• x Nascondi lo splash screen all’avvio

• x Apri i risultati di un’interrogazione in una finestra separata (è necessario riavviare QGIS)

• x Apri la tabella attributi in una finestra separata

• x Aggiungi un layer PostGIS con un doppio click e seleziona la modalità estesa

Disegno

• x Per impostazione predefinita i nuovi layer aggiunti alla mappa vengono visualizzati subito

• Definizione del numero di geometrie da disegnare prima di aggiornare lo schermo.

• x Rendi le linee meno dettagliate in favore di migliori prestazioni di disegno

• x Risolvi problemi con i poligoni riempiti non correttamente

Strumenti mappa

• L’impostazione Modalità determina quali layer saranno mostrati attraverso lo strumento Identifi-
ca geometrie. Passando a Su giù invece di Layer in uso gli attibuti per tutti i layer seleziona-
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bili (Si veda la sezione Proprietà progetto in: 4.5 per impostare quali layer siano selezionabili)
saranno visibili tramite lo strumento Identifica geometrie.

• Definizione del raggio di ricerca per identificare gli oggetti e visualizzare le relative informazioni
sulla mappa in percentuale della larghezza della mappa

• Definizione dell’ellissoide da impiegare per il calcolo delle distanze

• Definizione del colore della traccia (colore elastico) nello strumento misura

• Definizione delle unità di misura preferite (metri o piedi)

• Definizione del comportamento della rotellina del mouse (Zoom, Zoom e centramento, Zoom al
cursore del mouse, Niente)

• Definizione del fattore di zoom quando si aziona la rotellina del mouse

Sovrapposizione

• Definizione dell’algoritmo di piazzamento per le etichette (scelta tra punto centrale (standard),
catena, catena tabu popmusic, tabu popmusic e catena popmusic)

Digitalizzazione

• Definizione del colore e della larghezza della traccia quando si digitalizza

• Definizione della modalità di aggancio predefinita (al vertice, al segmento o entrambe)

• Definizione della tolleranza (distanza massima) per attivare lo snapping in unità del layer

• Definizione del raggio di ricerca per la cattura e modifica di vertici in unità del layer

• x Mostra i marcatori solo per le geometrie selezionate

• Definizione dello stile (croce, cerchio semitrasparente o nessuno) e della dimensione per il
marcatoredei vertici

• x Chiusura della finestra di pop-up degli attributi dopo la creazione di ogni geometria

CRS

• x Richiesta per CRS

• x CRS predefinito utilizzato dal progetto

• x Verrà utilizzato il seguente CRS globale predefinito visualizzato qui sotto
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• Selezioni globali predefinite

Lingua

• x Sovrascrivi lingua in uso

• Informazioni sulla lingua correntemente impostata nel sistema

Proxy

• x Utilizza un proxy per l’accesso web , definizione di host, porta, utente e password.

• Definizione del Tipo proxy secondo le esigenze

– Default Proxy : Il proxy è determinato sulla base delle impostazioni in uso del proxy
dell’applicazione

– Socks5Proxy : Proxy generico per ogni tipo di connessione. Supporta TCP, UDP,
associazione a una porta (connessione in entrata) e autenticazione.

– HttpProxy : Realizzato usando il comando CONNECT, supporta solamente connessioni
TCP in uscita; supporta l’autenticatione.

– HttpCachingProxy : Realizzato usando normali comandi HTTP, è utile solamente nel
contesto di richieste HTTP.

– FtpCachingProxy : Realizzato usando un proxy FTP, è utile solamente nel contesto di
richieste FTP.

Si possono escludere alcune URL aggiungendole nella casella di testo al di sotto delle impostazioni

del proxy (vedere fig. 5) premendo il pulsante Aggiungi . In seguito fare doppio click nel campo
URL appena creato e inserire l’URL che si desidera escludere dall’utilizzo del proxy. Ovviamente il
pulsante Rimouvi elimina l’elemento selezionato.

Per informazioni più dettagliate sulle diverse impostazioni del proxy, si pre-
ga di fare riferimento al manuale della documentazione delle librerie QT su
http://doc.trolltech.com/4.5/qnetworkproxy.html#ProxyType-enum.

Tip 7 UTILIZZO DEI PROXY

L’utilizzo dei proxy può a volte essere complicato. E’ utile testare i tipi di proxy succitati e controllare il loro
funzionamento nel vostro caso specifico.

Queste opzioni possono essere modificate in funzione delle specifiche esigenze. Alcuni cambiamenti
potrebbero rendere necessario riavviare QGIS prima che divengano attivi.
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4.8 Segnalibri geospaziali

Figura 5: Impostazioni del proxy in QGIS

• Le impostazioni sono salvate in un file di testo: $HOME/.config/QuantumGIS/qgis.conf

• Le impostazioni vengono collocate in: $HOME/Library/Preferences/org.qgis.qgis.plist

• Le impostazioni vengono inserite nel registro di sistema alla voce:

\\HKEY\CURRENT\USER\Software\QuantumGIS\qgis

4.8. Segnalibri geospaziali

I segnalibri geospaziali consentono di memorizzare una posizione geografica alla quale ritornare in
un secondo momento.

4.8.1. Creazione di un segnalibro

Per creare un segnalibro:

1. Usare lo zoom o muovere la mappa all’estensione d’interesse.

2. Selezionare la voce di menu Visualizza > Nuovo segnalibro o premere
�

�

�

�Ctrl-B .
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3. Inserire un nome descrittivo per il segnalibro (fino a 255 caratteri).

4. Cliccare su OK per aggiungere il segnalibro o Cancel per uscire senza aggiungere il
segnalibro.

Si noti che è possibile avere più di un segnalibro con lo stesso nome.

4.8.2. Uso e gestione dei segnalibri

Per usare o gestire i segnalibri, selezionare la voce di menu Visualizza > Mostra segnalibri . La

finestra Segnalibri geospaziali consente di usare lo zoom a un segnalibro o di eliminarne uno.
Non è possibile editare il nome o le coordinate di un segnalibro.

4.8.3. Zoom a un segnalibro

Dalla finestra Segnalibri geospaziali dialog, selezionare il segnalibro desidera cliccando su di

esso, quindi cliccare su Zoom a . Si può usare lo zoom su un segnalibro anche facendo doppio
click su di esso.

4.8.4. Cancellare un segnalibro

Per cancellare un segnalibro dalla finestra Segnalibri geospaziali , cliccare su di esso e poi sul

pulsante Elimina . Confermare la scelta cliccando su OK o annullare l’eliminazione cliccando su

Cancel .
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QGIS supporta un gran numero di formati vettoriali, compresi quelli supportati dalla libreria inclusa
OGR, come gli shapefile ESRI, , il formato di interscambio MapInfo MIF e il formato nativo MapInfo
TAB (native format). Una lista dei formati vettoriali supportati da OGR si trova nell’Appendice A.1.

QGIS supporta anche layer PostGIS immagazzinati in un database PostgreSQL usando il plugin di
accesso a PostgreSQL. Il supporto per altri formati (ad es. testo delimitato) è fornito da ulteriori plugin
specifici.

Questa sezione descrive come lavorare con due formati di uso comune: Shapefile ESRI e layer Post-
GIS. Molti degli strumenti disponibili in QGIS funzionano allo stesso modo con le differenti sorgenti di
dati vettoriali (ad es. l’identificazione, la selezione, la visualizzazione delle etichette ed altre funzioni).

La sezione 9 illustra come lavorare con i dati di GRASS.

5.1. Shapefile ESRI

Il formato di file usato come default in QGIS è lo shapefile ESRI. Il supporto al formato è fornito dalla
libreria OGR Simple Feature Library (http://www.gdal.org/ogr/) . Uno shapefile consiste di un
minimo di tre file:

• .shp file contente le geometrie.

• .dbf file contenente gli attributi in formato dBase.

• .shx file d’indice.

Idealmente dovrebbe essere presente un altro file con estensione .prj, che contiene le in-
formazioni sulla proiezione dello shapefile. Ci possono essere ulteriori file che compon-
gono il dataset in formato shape. Per uno sguardo più ravvicinato al formato shapefile
si raccomanda di prendere visione delle specifiche tecniche del formato disponibili sul sito
http://www.esri.com/library/whitepapers/pdfs/shapefile.pdf. .

5.1.1. Caricare uno shapefile

Per caricare uno shapefile avviare QGIS e cliccare sul pulsante Aggiungi layer vettoriale

o semplicemente digitare
�

�

�

�V . Lo stesso strumento può essere usato per caricare qualunque dei
formati supportati dalla libreria OGR.
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5 LAVORARE CON I DATI VETTORIALI

Cliccando sullo strumento si apre una finestra di dialogo standard (si veda la Figura 6) che consente
di cercare nel filesystem lo shapefile o qualunque altro dato vettoriale si intenda caricare. La casella

di selezione Files of type . . . H consente di preselezionare alcuni formati supportati da OGR.

Se lo si desidera, può essere inoltre selezionata la codifica (encoding) da utilizzare per le porzioni
testuali della tabella dello shapefile.

Figura 6: Finestra di dialogo Apri un layer vettoriale supportato da OGR

Selezionando uno shapefile dalla lista e cliccando su Open esso viene caricato in QGIS. La figura
7 mostra come appare l’interfaccia di QGIS dopo aver caricato il file alaska.shp.

Tip 8 COLORI DEL LAYER

Quando un layer viene aggiunto alla mappa, gli viene assegnato un colore a caso. Aggiungendo più layer in
una sola volta, ad ognuno di essi viene assegnato un colore differente.

Una volta caricato, si può usare lo zoom nella mappa usando gli strumenti di navigazione. Per
cambiare la rappresentazione di un layer, aprire la finestra Proprietà facendo doppio click sul
nome del layer e quindi sulla scheda Simbologia o cliccando con il tasto destro sul nome del layer
nella legenda e scegliendo Proprietà dal menu contestuale. Si veda la Sezione 5.4.2 per ulteriori
informazioni su come settare la simbologia dei layer vettoriali.
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5.1 Shapefile ESRI

Figura 7: QGIS con lo shapefile Alaska caricato

5.1.2. Ottimizzare le prestazioni

Per migliorare le prestazioni di disegno di uno shapefile, può essere creato un indice spaziale. Un
indice spaziale migliorerà la velocità di disegno quando si usano le funzioni di zoom e di spostamento.
Gli indici spaziali usati da QGIS hanno estensione .qix.

Per creare un indice, seguire queste indicazioni:

• Caricare uno shapefile.

• Aprire la finestra di dialogo Proprietà facendo doppio click sul nome dello shapefile nella

legenda o cliccando su di esso con il tasto destro e scegliendo la voce Proprietà dal menu
contestuale.
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• Nella scheda Generale cliccare sul pulsante Crea indice spaziale .

5.1.3. Caricare un layer MapInfo

Per caricare un layer MapInfo, cliccare nella barra strumenti sul pulsante

Aggiungi layer vettoriale o digitare
�

�

�

�V , cambiare il filtro sul tipo di file nel menu a tendina a

Files of Type [OGR] MapInfo (*.mif *.tab *.MIF *.TAB) H e selezionare il layer che si intende

caricare.

5.1.4. Caricare una copertura ArcInfo

Per caricare una copertura ArcInfo si usa lo stesso metodo precedentemente visto per shapefile e

layer MapInfo. Cliccare nella barra strumenti sul pulsante Aggiungi layer vettoriale o digitare
�

�

�

�V , scorrere il filesystem per individuare la cartella contenente la copertura che si vuole caricare e
selezionare uno dei seguenti file (se presenti nella propria copertura):

• .lab - per caricare un layer etichette (etichette di poligoni o di punti).

• .cnt - per caricare un layer contenente i centroidi dei poligoni

• .arc - per caricare un layer arc (linee).

• .pal - per caricare un layer di poligoni.

5.2. Layer PostGIS

I layer sono immagazzinati in un database PostgreSQL. I vantaggi nell’uso di PostGIS stanno nelle
capacità fornite di creazione dell’indice spaziale, di filtraggio e di interrogazione. Usando PostGIS,
le funzioni vettoriali come la selezione e l’identificazione in QGIS lavorano con maggiore precisione
che con i layer OGR.

Per usare layer PostGIS bisogna:

• Creare una connessione in QGIS con il database PostgreSQL (se non è già definita).

• Connettersi al database.

• Selezionare i layer da aggiungere alla mappa.

QGIS 1.4.0 User Guide 40



5.2 Layer PostGIS

• Fornire eventualmente una query SQL di tipo where per definire quali elementi del layer
caricare.

• Caricare il layer.

5.2.1. Creare una connessione

La prima volta in cui viene usata una fonte dati PostGIS, bisogna creare una connessio-
ne al database PostgreSQL che contiene i dati. Cliccare nella barra strumenti sul pulsante

Aggiungi layer PostGIS , oppure selezionare l’opzione Aggiungi layer PostGIS... dal menu

Layer o digitare
�

�

�

�D . Si aprirà la finestra di dialogo Aggiungi tabella(e) PostGIS . Per accede-

re al gestore della connessione , cliccare sul tasto Nuovo per far comparire la finestra di dialogo

Creare una nuova connessione PostGIS . I parametri richiesti per la connessione sono mostrati
nella tabella 1.

Tabella 1: Parametri di connessione al geodatabase PostGIS

Name Nome della connessione. Può essere uguale a quello del Database.
Host Nome del server che ospita il database. Deve essere un host con indirizzo

raggiungibile, lo stesso che potrebbe essere usato per aprire una connes-
sione telnet o per fare il ping all’host. Se il database è sullo stesso computer
sul quale è installato QGIS, inserire semplicemente localhost.

Database Nome del database.
Porta Numero della porta sulla quale il database PostgreSQL è in ascoloto. La

porta di default è 5432.
Username Nome dell’utente che accede al database.
Password Password usata dall’Username per collegarsi al database.

Come opzione, possono essere attivate le seguenti caselle di controllo:

• x Salva password

• x Cercare solamente nella tabella geometry_columns

• x Cerca solamente nello schema public

Quando tutti i parametri sono impostati, la connessione può essere testata cliccando sul pulsante
Prova connessione .
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Tip 9 DEFINIZIONE E SICUREZZA DELLE IMPOSTAZIONI UTENTE IN QGIS

Le impostazioni personalizzate di QGIS sono salvate in modo diverso in base al sistema operativo. , le

impostazioni sono salvate nella cartella home dell’utente nel file .qt/qgisrc. , le impostazioni sono
salvate nel registro di sistema. Secondo il sistema operativo, il salvataggio delle password in QGIS può
essere più o meno a rischio.

5.2.2. Caricare un layer PostGIS

Una volta definite una o più connessioni, possono essere caricati layer dal database Postgre-
SQL. Ovviamente questo richiede avere dati in PostgreSQL. Si veda la Sezione 5.2.4 per informazioni
sul come importare dati nel database.

Per caricare layer da PostGIS, seguire i seguenti passaggi:

• Se la finestra di dialogo Aggiungi tabella(e) PostGIS non è già aperta, cliccare nella barra

strumenti sul pulsante Aggiungi layer PostGIS .

• Scegliere la connessione dal menu a tendina e cliccare su Connetti .

• Individuare il layer che si vuole aggiungere nella lista fra quelli disponibili.

• Selezionarlo cliccando sul nome. È possibile selezionare più layer tenendo premuto il tasto�

�

�

�shift mentre si seleziona. Si veda la Sezione 5.6 per informazioni su come usare il costruttore
di query PostgreSQL per definire una selezione al momento del caricamento.

• Cliccare sul tasto Aggiungere per aggiungere il livello alla mappa.

Tip 10 LAYER POSTGIS
Di solito un layer PostGIS è definito da un record nella tabella geometry_columns. Dalla versione 1.3.0 in
avanti, QGIS può caricare layer che non hanno tale record nella tabella geometry_columns. Ciò vale sia per
le tabelle che per le viste. La definizione si una vista spaziale fornisce un mezzo molto potente per
visualizzare i dati. Fare riferimento al manuale PostgreSQL per informazioni su come creare le viste.

5.2.3. Alcuni dettagli sui layer PostgreSQL

Questa sezione contiene alcuni dettagli su come QGIS accede ai layer PostgreSQL. La maggior par-
te delle volte QGIS dovrebbe semplicemente fornire una lista di tabelle del database che possono
essere caricate, e caricarle su richiesta. Tuttavia, se avete difficoltà a caricare una tabella di Postgre-
SQL in QGIS, le informazioni qui sotto possono aiutare a capire tutti i messaggi di QGIS ed a dare
un’indicazione su come cambiare la definizione di tabella o di vista di PostgreSQL per permettere a
QGIS di caricarla.
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QGIS richiede che i layer di PostgreSQL contengano una colonna che possa essere usata come
chiave unica per il layer. Per le tabelle questo significa che esse devono contenere una chiave
primaria o presentino una colonna con un vincolo unico su essa. Se una tabella manca di questi
elementi, verrà usata la colonna oid. QGIS richiede inoltre che questa colonna sia di tipo int4 (un
numero intero del formato 4 byte). Le prestazioni saranno migliorate se la colonna è indicizzata
(notare che le chiavi primarie sono automaticamente indicizzate in PostgreSQL).

Se il layer di PostgreSQL è una vista, esistono gli stessi requisiti, ma le viste non hanno chiavi
primarie o colonne con i vincoli unici su di loro. In questo caso QGIS proverà a trovare una colonna
nella vista che provenga da una colonna della tabella appropriata. Se non ne viene trovata alcuna,
QGIS non caricherà il layer. Se questo accade, la soluzione è di alterare la vista in modo che includa
una colonna adatta (un tipo di int4 e una chiave primaria o un vincolo unico, spostato e preferibilmente
indicizzato).

5.2.4. Importazione di dati in PostgreSQL

shp2pgsql

I dati possono essere importati in PostgreSQL in diverse maniere. PostGIS include un programma
di utilità chiamato shp2pgsql che può essere usato per importare shapefile in un database PostGIS.
Per esempio, per importare lo shapefile chiamato lakes.shp nel database PostgreSQL chiamato
gis_data, usare il comando seguente:

shp2pgsql -s 2964 lakes.shp lakes_new | psql gis_data

Questo comando crea un nuovo layer chiamato lakes_new nel database gis_data. Il nuovo layer
avrà uno spatial reference identifier (SRID) di 2964. Si veda la Sezione 8 per ulteriori informazioni
sui sistemi di spatial reference systems e le proiezioni.

Tip 11 ESPORTARE DATI DA POSTGIS
Come è presente lo strumento per l’importazione shp2pgsql c’è anche lo strumento per l’esportazione di dati
PostGIS come shapefile: pgsql2shp. Esso è incluso nella versione di PostGIS installata.

SPIT Plugin

QGIS include un plugin denominato SPIT (Shapefile to PostGIS Import Tool). SPIT può essere
usato per caricare più shapefile in una volta sola e include il supporto per gli schemi. Per usare
SPIT, aprire il QGIS Plugin Manager dal menu Plugins , selezionare la casella di controllo vicina a

x SPIT e cliccate su OK . L’icona di SPIT verrà aggiunta alla barra degli strumenti plugin.
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Per importare uno shapefile, cliccare sull’icona n ella barra degli strumenti per aprire la fi-

nestra di dialogo SPIT . Selezionare il database PostGIS al quale si desidera connettersi e clic-

care su Connetti . Ora è possibile aggiungere uno o più file alla coda cliccando su Aggiungi .

Per processare i file selezionati, cliccare su OK . L’avanzamento dell’importazione ed eventuali
errori/avvertimenti saranno mostrati mentre ciascuno shapefile viene elaborato.

Tip 12 IMPORTARE SHAPEFILE CONTENENTI PAROLE RISERVATE IN POSTGRESQL
Se alla coda d’importazione uno shapefile contiene campi con parole riservate per il database PostgreSQL,
comparirà una finestra di dialogo che darà informazioni sullo stato di ogni campo. È necessario editare i nomi
dei campi contenenti tali parole (ed è possibile eventualmente editare anche il nome degli altri campi) prima
dell’importazione, altrimenti il processo di importazione non andrà a buon fine.

ogr2ogr

Oltre a shp2pgsql e SPIT c’è un altro strumento per inserire geodati in PostGIS: ogr2ogr. Esso fa
parte della versione di GDAL installata. Per importare uno shapefile in PostGIS con ogr2ogr, digitare
questo comando:

ogr2ogr -f "PostgreSQL" PG:"dbname=postgis host=myhost.de user=postgres \

password=topsecret" alaska.shp

L’espressione importerà lo shapefile alaska.shp nel database PostGIS postgis usando l’utente
postgres e la password topsecret sull’host myhost.de.

Notare che OGR deve essere compilato con il supporto a PostgreSQL per poter effettuare tale ope-
razione. La presenza del supporto a PostgreSQL-PostGIS può essere verificate digitando da riga di
comando:

ogrinfo --formats | grep -i post

Se si volesse usare il comando interno di PostgreSQL COPY al posto del metodo predefinito INSERT

INTO bisogna settare le variabili d’ambiente come segue (su piattaforme e ):

export PG_USE_COPY=YES

ogr2ogr non crea indici spaziali come shp2pgsl. Bisogna crearli manualmente usando il comando
SQL CREATE INDEX dopo l’importazione come passaggio aggiuntivo (come descritto nella prossima
sezione 5.2.5).
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5.2.5. Migliorare le prestazioni

Richiamare dati geografici da un database PostgreSQL può richiedere molto tempo, specialmente
se il server dei dati si trova in rete. È possibile migliorare le prestazioni di resa a video di layer
PostgreSQL assicurandosi di creare un indice spaziale su ogni layer nel database. PostGIS supporta
la creazione di un indice GiST (indice dell’albero generalizzato di ricerca, Generalized Search Tree)
per velocizzare le ricerche spaziali di dati.

La sintassi per la creazione di un indice GiST è: 3

CREATE INDEX [indexname] ON [tablename]

USING GIST ( [geometryfield] GIST_GEOMETRY_OPS );

Si noti che per tabelle molto grandi, la creazione dell’indice può richiedere parecchio tempo.
Non appena l’indice è stato creato, bisognerebbe effettuare una VACUUM ANALYZE. Si veda la
documentazione di PostGIS [4] per ulteriori informazioni.

Ciò che segue è un esempio di come creare un indice GiST:

gsherman@madison:~/current$ psql gis_data

Welcome to psql 8.3.0, the PostgreSQL interactive terminal.

Type: \copyright for distribution terms

\h for help with SQL commands

\? for help with psql commands

\g or terminate with semicolon to execute query

\q to quit

gis_data=# CREATE INDEX sidx_alaska_lakes ON alaska_lakes

gis_data-# USING GIST (the_geom GIST_GEOMETRY_OPS);

CREATE INDEX

gis_data=# VACUUM ANALYZE alaska_lakes;

VACUUM

gis_data=# \q

gsherman@madison:~/current$

5.2.6. Layer vettoriali che attraversano 180 ◦ di longitudine

Many GIS packages don’t wrap vector maps, with a geographic reference system (lat/lon), crossing
the 180◦ longitude line. As result, if we open such map in QGIS, we will see two far, distinct locations,

3le informazioni sull’indice GiST sono tratte dalla documentazione PostGIS disponibile su
http://postgis.refractions.net
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that should show near each other. In Figure 8 the tiny point on the far left of the map canvas (Chatham
Islands), should be within the grid, right of New Zealand main islands.

Figura 8: Map in lat/lon crossing the 180◦ longitude line

A workaround is to transform the longitude values using PostGIS and the ST_Shift_Longitude 4

function. This function reads every point/vertex in every component of every feature in a geometry,
and if the longitude coordinate is < 0◦ adds 360◦ to it. The result would be a 0◦ - 360◦ version of the
data to be plotted in a 180◦ centric map.

Figura 9: Map crossing 180◦ longitude applying the ST_Shift_Longitude function

Utilizzo

• Import data to PostGIS (5.2.4) using for example the PostGIS Manager plugin or the SPIT plugin

• Use the PostGIS command line interface to issue the following command (this is an example
where TABLE is the actual name of your PostGIS table)
gis_data=# update TABLE set the_geom=ST_shift_longitude(the_geom);

4http://postgis.refractions.net/documentation/manual-1.4/ST_Shift_Longitude.html
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• If everything went right you should receive a confirmation about the number of features that
were updated, then you’ll be able to load the map and see the difference (Figure 9)

5.3. Layer SpatiaLite

The first time you load data from a Spatialite database, begin by clicking on the

Add SpatiaLite Layer toolbar button or by selecting the Add SpatiaLite Layer... option from the

Layer menu or by typing
�

�

�

�L . This will bring up a window, which will allow you to either connect to
a Spatialite database already known to QGIS, which you can choose from the dropdown menu or to
define a new connection to a new database. To define a new connection, click on New and use the
file browser to point to your SpatiaLite database, which is a file with a .sqlite extension.

5.4. Proprietà dei layer vettoriali

La finestra di dialogo Proprietà del vettoriale fornisce informazioni sul layer, sulla sua rappresen-
tazione grafica (simbologia) e opzioni per la visualizzazione di etichette sugli elementi che lo com-
pongono. Se il layer vettoriale è stato caricato da un archivio dati PostgreSQL/PostGIS, è possbile
modificare anche l’espressione SQL che lo ha generato - sia a mano editando l’espressione SQL
nella scheda Generale o richiamando la finestra di dialogo Costruttore di query dalla sche-

da Generale . Per accedere alla finestra di dialogo Proprietà del vettoriale , fare doppio click sul

layer nella legenda o click con il tasto destro sul layer e selezionare Proprietà dal menu contestuale.
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Figura 10: Finestra delle proprietà di un vettoriale

5.4.1. Scheda Generale

La scheda Generale è sostanzialmente simile a quella dei raster. Essa consente di cambiare il
nome del file mostrato, impostare la visualizzazione in base alla scala, creare un indice spaziale
(solo per i formati supportati da OGR e per layer PostGIS) e vedere o cambiare la proiezione dello
specifico layer vettoriale.

Il pulsante Creatore di query consente di selezionare un sottoinsieme di elementi nel layer -
ma questo pulsante è attualmente disponibile unicamente quando viene aperta la tabella attributi
cliccando sul pulsante Avanzate ... .

5.4.2. Scheda simbologia

QGIS supporta diverse modalità di rappresentazione per controllare come gli elementi dei layer
vettoriali vengono mostrati. Attualmente sono disponibili le seguenti modalità:
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Simbolo singolo - lo stesso stile è applicato a tutti gli elementi del vettore

Simbolo graduato - lo stile applicato ai diversi elementi dipende dal valore di un campo particolare
nella tabella associata.

Colore continuo - gli elementi del layer sono mostrati con una gradazione di colori compresa entro
due estremi specificati in base ai valori numerici di uno specifico campo.

Valore univoco - gli oggetti sono classificati in base ai valori unici di uno specifico campo, ad ogni
valore viene assegnata una simbologia differente.

Per modificare la simbologia di un layer, fare semplicemente doppio click sulla relativa voce di legenda
per fare apparire la finestra di dialogo Proprietà del vettoriale .

Figura 11: Opzioni per la simbologia dei layer

(a) Simbolo singolo (b) Simbolo graduato

(c) Colore continuo (d) Valore unico
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Opzioni per lo stile

In questa finestra di dialogo è possibile scegliere lo stile di rappresentazione del layer vettoriale.
Secondo l’opzione di visualizzazione scelta tra quelle descritte precedentemente si ha la possibilità
di classificare anche gli elementi della mappa.

Le seguenti opzioni dovrebbero essere disponibili per pressoché tutte le simbologie:

Stile esterno - tipo di tratteggio del contorno degli elementi. Si può anche impostare l’opzione -
Nessuna penna per escludere la rappresentazione del contorno.

Colore esterno - colore del contorno degli elementi

Dimensione stile esterno - larghezza della linea di contorno

Colore di riempimento - colore di riempimento degli elementi.

Stile di riempimento - stile per il riempimento. Oltre ai retini forniti è possibile sce-

gliere Stile di riempimento ? Texture H e cliccare su . . . per selezionare un retino

personalizzato. Attualmente sono supportati i formati *.jpeg, *.xpm, and *.png.

Una volta impostato lo stile del layer esso può essere salvato in un fil separato (con esten-
sione *.qml). Per fare ciò, cliccare sul pulsante Salva stile . . . . Ovviamente il pulsante

Caricamento stile . . . carica un file di stile precedentemente salvato.

Se si desidera usare sempre un particolare stile quando il layer viene caricato, cliccare su
Salva come predefinito per rendere predefinito lo stile impostato. Inoltre, se si effettuano allo stile

modifiche delle quali non si è soddisfatti, cliccare su Ripristina stile predefinito per ritornare allo
stile predefinito precedentemente impostato.

Applicare la trasparenza ad un vettore

QGIS 1.4.0 fornisce la possibilità di settare la trasparenza per ogni layer vettoriale. Ciò può essere

fatto settando l’apposita barra Trasparenza 0% ▽ nella scheda Symbologia (si veda
la fig. 10). Ciò può essere molto utile per la visualizzazione di più layer vettoriali sovrapposti.

5.4.3. New Generation Symbology

In QGIS 1.4.0 a new symbology was integrated in parallel with the symbology described above. This
new generation symbology provides a variety of improvements and new features and will replace the
current symbology in one of the upcoming releases. To switch to the new symbolgy you currently

have to click on the new symbology button in the General tab of the Layer Properties dialog.
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Understanding the new generation symbology

There are three types of symbols: marker symbols (for points), line symbols and fill symbols (for
polygons). Symbols can consist of one or more symbol layers. It is possible to define the color of a
symbol and this color is then defined for all symbol layers. Some layers may have the color locked -
for those the color can not be altered. This is useful when you define the color of a multilayer symbol.
Similarly, it is possible to define the width for line symbols, as well as size and angle for marker
symbols.

Available symbol layer types

• Simple marker : Rendering with one of hardcoded markers.

• Simple line : Usual rendering of a line (with specified width, color and pen style)

• Simple fill : Usual rendering of a polygon (with defined fill color, fill pattern and outline)

• SVG marker : Rendering with a SVG picture

• Marker line : A line rendered by repeating a marker symbol

Color ramps

Color ramps are used to define a range of colors that can be used during the creation of renderers.
The symbol’s color will be set from the color ramp. There are two types of color ramps:

• Gradient : Linear gradient from one color to some other.

• random : Randomly generated colors from a specified area of color space

Styles

A style groups a set of various symbols and color ramps. You can define your prefered or frequently
used symbols, and can use it without having to recreate it everytime. Style items (symbols and color
ramps) have always a name by which they can be queried from the style. There is one default style
in QGIS (modifiable) and the user can add further styles.

Renderers

The renderer is responsible for drawing a feature together with the correct symbol. There are th-
ree types of renderers: single symbol, categorized (called unique color in the old symbology), and
graduated. There is no continuous color renderer, because it is in fact only a special case of the
graduated renderer. The categorized and graduated renderer can be created by specifying a symbol
and a color ramp - they will set the colors for symbols appropriately.
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5.4.4. Working with the New Generation Symbology

First you have to enable the new generation symbology clicking on the new symbology button in

the General tab of the Layer Properties dialog. The new dialog allows to choose one of the
three renderers: single symbol, categorized and graduated. Depending on the chosen renderer, the
symbology tab provides different settings and options, that will be described in the following sections.

Single Symbol Renderer

The Single Symbol Renderer is used to render all features of the layer using a single user-defined
symbol. The properties, that can be adjusted in the Symbology tab, depend partially on the type of
the layer, but all types share the following structure. In the top left part of the tab, there is a preview
of the current symbol to be rendered. In the bottom part of the tab, there is a list of symbols already
defined for the current style, prepared to be used via selecting them from the list. The current symbol

can be modified using the Properties button, which opens a Symbol Properties dialog, or the

Set Color button, which opens an ordinary Color dialog. After having done any needed changes,

the symbol can be added to the list of current style symbols (using the Add to style button) and then
easily be used in the future.

Figura 12: New Single Symbolizing options

(a) Single symbol point properties (b) Single symbol line properties (c) Single symbol area properties

Categorized Renderer

The Categorized Renderer is used to render all features from a layer, using a single user-defined
symbol, which color reflects the value of a selected feature’s attribute. The Symbology tab allows you
to select:

• The attribute (using the Column listbox)

• The symbol (using the Symbol Properties dialog)

• The colors (using the Color Ramp listbox)
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For convenience, the list in the bottom part of the tab lists the values of all currently selected attributes
together, including the symbols that will be rendered.

The example in figure 13 shows the category rendering dialog used for the rivers layer of the qgis
sample dataset.

Figura 13: New Categorized Symbolizing options

Graduated rendering

The Graduated Renderer is used to render all the features from a layer, using a single user-defined
symbol, whose color reflects the classification of a selected feature’s attribute to a class.

Analogue to the categorized rendered, the symbology tab allows you to select:

• The attribute (using the Column listbox)

• The symbol (using the Symbol Properties button)

• The colors (using the Color Ramp list)

Additionally, you can specify the number of classes and also the mode how to classify features inside
the classes (using the Mode list). The listbox in the bottom part of the symbology tab lists the classes
together with their ranges, labels and symbols that will be rendered.

The example in figure 14 shows the category rendering dialog for the rivers layer of the qgis sample
dataset.
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Figura 14: New Graduated Symbolizing options

Symbol Properties

The symbol properties dialog allows the user to specify different properties of the symbol to be ren-
dered. In the top left part of the dialog, you find a preview of the current symbol as it will be displayed
in the map canvas. Below the preview is the list of symbol layers. To start the symbol properties
dialog, click the Properties button in the General tab of the Layer Properties dialog.

The control panels allow adding or removing layers, changing the position of layers, or locking layers
for color changes. In the right part of the dialog, there are shown the settings applicable to the single
symbol layer selected in the symbol layer list. The most important is the ’Symbol Layer Type’ combo
box, which allows you to choose the layer type. The available options are SimpleLine, SvgMarker
and SimpleFill.

Depending on the chosen value, these settings are available in the right part of the dialog:

• SimpleLine : Color, Pen width, Pen style, Offset, Join style and Cap style;

• SvgMarker : Size, Angle, Offset X, Offset Y and SVG Image

• SimpleFill : Color, Border color, Fill style.

Example: A picture showing a line symbol composed from three simple lines with different pen widths.
Example: Symbol properties for a point layer Example: Symbol properties filling pattern for a polygon
layer
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Figura 15: Defining symbol properties

(a) Line composed from three simple
lines

(b) Symbol properties for point layer (c) Filling pattern for a polygon

5.4.5. Style Manager to manage symbols and color ramps

The Style Manger is a small helper application, that lists symbols and color ramps available in a style.
It also allows you to add and/or remove items. To launch the Style Manager, click on Settings >

Style Manager in the mai menu.

Figura 16: Style Manager to manage symbols and color ramps
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5.4.6. Scheda Etichette

La scheda Etichette consente di abilitare la visualizzazione delle etichette associate agli elementi
del layer e controlla una serie di opzioni legate al posizionamento, allo stile e ad altre caratteristiche
delle etichette.

Come esempio apporremo le etichette allo shapefile lakes del dataset_esempio_di_qgis:

1. Caricare lo shapefile alaska.shp e il file GML lakes.gml in QGIS.

2. Usare lo zoom su un’area a scelta contenente alcuni laghi.

3. Rendere attivo il layer lakes cliccando su di esso nella legenda.

4. Aprire la finestra di dialogo Proprietà del vettoriale .

5. Cliccare sulla scheda Etichette .

6. Selezionare la casella di controllo x Mostra etichette per abilitarne la visualizzaizone.

7. Scegliere il campo della tabella contenente le etichette da apporre. In questo esempio si userà

il Campo contenente etichetta NAMES H .

8. Inserire una etichetta di default per gli elementi del layer lakes che non hanno nome. Que-
sta etichetta verrà quindi usata ogni volta che QGIS dovrà etichettare un lago al quale non
corrisponda un valore nel campo NAMES.

9. Cliccare su Apply .

Adesso sono visualizzate le etichette. Il loro aspetto non è probabilmente gradevole, potrebbero
essere troppo grandi e posizionate male in relazione al simbolo dei laghi.

Cliccare allora su Carattere e Colore per impostare il tipo di carattere e il colore. È possibile
anche cambiare l’angolo e la posizione delle etichette testuali.

Per modificare la posizione relativa del testo rispetto agli elementi:

1. Cliccare sulla scheda Etichette .

2. Cambiare la posizione selezionando una delle opzioni disponibili nel gruppo Posizionamento .
Nel caso preso in esame, scegliere l’opzione ⊙ Destra.

3. la voce Unità della dimensione del carattere consente di selezionare tra ⊙ Punti o ⊙ Unità
mappa.

4. Cliccare su Apply per visualizzare i cambiamenti senza chiudere la finestra di dialogo.
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Ora l’aspetto sarà migliore, ma le etichette appaiono ancora troppo vicine all’indicatore della loro
posizione. Per sistemare il problema è possibile utilizzare l’opzione della voce Posizione . Può qui
essere impostato uno scostamento nelle direzioni X e Y. Aggiungendo uno spostamento in X pari a
5 le etichette verrano scostate dall’indicatore della loro posizione e rese più leggibili. Ovviamente più
è grande l’indicatore o il carattere, maggiore sarà lo scostamento da applicare.

Aggiungiamo infine un buffer sulle etichette cliccando sulla voce buffer . In questo modo verrà
aggiunto uno sfondo attorno alle lettere per farle risaltare maggiormente. Per mettere un buffer alle
etichette dei laghi procedere come di seguito:

1. Cliccare sulla voce Buffer .

2. Abilitare la casella di controllo x Buffer sulle etichette? .

3. Scegliere una dimensione (spessore) del buffer.

4. Scegliere un colore per il buffer cliccando sul pulsante Colore . È inoltre possibile assegnare
una trasparenza in percentuale al buffer.

5. Cliccare su Apply per vedere giudicare i cambiamenti.

Modificare eventualmente i cambiamenti fino a quando non si è soddisfatti del risultato, cliccando su
Apply dopo ogni modifica.

In genere un buffer di 1 punto fornisce risultati esteticamente gradevoli. Si noti che è anche possibile
specificare la dimensione del buffer in unità della mappa se ciò rende più agevole l’impostazione.

Le rimanenti voci della scheda Etichette consentono di controllare l’aspetto delle etichette usando,

se adeguatamente preparati, gli attributi del layer. Le voci che iniziano con Definizione consentono
di settare tutti i parametri delle etichette facendo riferimento a campi della tabella del layer.

Si noti che la scheda Etichette fornisce una Anteprima nella quale viene mostrata l’etichetta
predefinita.

5.4.7. Attributes Tab

Within the Attributes tab the attributes of the selected dataset can be manipulated. The but-

tons New Column and Delete Column can be used, when the dataset is

editing mode . At the moment only columns from PostGIS layers can be removed and added. The

OGR library supports to add new columns, but not to remove them, if you have a GDAL version >=
1.6 installed.
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edit widget

Figura 17: Dialog to select an edit widget for an attribute column

Within the Attributes tab you also find an edit widget column. This column can be used to define
values or a range of values that are allowed to be added to the specific attribute table column. If

you click on the edit widget button, a dialog opens, where you can define different widgets. These
widgets are:

• Line edit: an edit field which allows to enter simple text (or restrict to numbers for numeric
attributes).

• Classification: Displays a combo box with the values used for classification, if you have chosen
’unique value’ as legend type in the symbology tab of the properties dialog.

• Range: Allows to set numeric values from a specific range. The edit widget can be either a
slider or a spin box.

• Unique value: The user can select one of the values already used in the attribute table. If
editable is activated, a line edit is shown with autocompletion support, otherwise a combo box
is used.

• File name: Simplifies the selection by adding a file chooser dialog.
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• Value map: a combo box with predefined items. The value is stored in the attribute, the descrip-
tion is shown in the comboo box. You can define values manually or load them from a layer or
a csv file.

• Enumeration: Opens a combo box with values that can be used within the columns type. This
is currently only supported by the postgres provider.

• Immutable: The immutable attribute column is read-only. The user is not able to modify the
content.

5.4.8. General Tab

The General tab is essentially like that of the raster dialog. It allows you to change the display
name, set scale dependent rendering options, create a spatial index of the vector file (only for OGR
supported formats and PostGIS) and view or change the projection of the specific vetor layer.

The Query Builder button allows you to create a subset of the features in the layer - but this but-
ton currently only is available when you open the attribute table and select the ... button next to
Advanced search.

5.4.9. Metadata Tab

The Metadata tab contains general information about the layer, including specifics about the ty-
pe and location, number of features, feature type, and the editing capabilities. The Extents section,
providing layer extent information, and the Layer Spatial Reference System section, providing infor-
mation about the CRS of the layer. This is a quick way to get information about the layer, but is not
yet editable.

5.4.10. Scheda Azioni

QGIS offre la possibilità di effettuare azioni sulla base degli attributi associati ai singoli elementi del
layer vettoriale. Questo permette di effettuare un elevato numero di azioni, per esempio, lanciare un
programma con argomenti costruiti tramite gli attributi delle geometrie o passando i parametri ad uno
strumento di web reporting.

Definire delle azioni è utile quando si voglia lanciare un’applicazione esterna o la visualizzazione di
una pagina web sulla base di uno o più valori associati al layer vettoriale. Ad esempio si può lanciare
una ricerca web basata sul valore di un attributo. Questo concetto è spiegato nel seguente paragrafo.
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Definire le azioni

Le azioni legate agli attributi sono definite dalla finestra di dialogo Proprietà del vettoriale . Per

impostare un’azione, aprire la finestra di dialogo Proprietà del vettoriale e cliccare sulla scheda

Azioni . Fornire una descrizione per l’azione nel campo Nome. L’azione in sé deve contenere il
nome o il percorso di una applicazione che verrà eseguita quando l’azione viene richiamata. L’azione
può venire fatta dipendere da uno o più campi della tabella attributi. Quando essa è richiamata
ogni stringa testuale che inizia con % seguita dal nome di un campo della tabella attributi verrà
rimpiazzata dal valore di quel campo. I caratteri speciali %% saranno rimpiazzati dal valore del campo
nell’elemento selezionato con lo strumento Identifica geometrie disponibile nella barra strumenti o
dalla tabella attributi (si veda il seguente Usare le azioni). Le virgolette () possono essere usate per
raggruppare il testo in un singolo argomento da passare al programma, allo script o al comando che
si intende eseguire Le virgolette saranno ignorate se precedute dalla barra inversa.

Se sono presente nomi di campo che possono essere interpretati come sottostringhe di altri nomi di
campo (ad es. col1 e col10) è necessario indicare, racchiudendo il nome di campo (e il carattere
%) tra parentesi quadre (ad es. [%col10]). Ciò impedirà che il nome di campo %col10 possa essere
confuso con %col1 con uno 0 alla fine. Le virgolette saranno rimosse da QGIS man mano che
vengono inseriti i valori del campo al posto dell’espressione. Se si vuole che i campi sostituiti vengano
racchiusi entro parentesi quadre, aggiungere una seconda coppia di parentesi quadre in questo
modo: [[%col10]].

La finestra di dialogo Risultati individuati che compare quando si usa lo strumento Identifica
geometrie ha una voce (Derivato) che contiene informazioni che sono dipendenti dal tipo di layer in-
terrogato. Si può accedere ai valori di questa voce similmente a come possibile per i valori di campo
della tabella attributi anteponendo al nome di campo disponibile alla voce (Derivato) l’espressione
(Derivato).. Per esempio un layer puntuale ha due sottovoci X e Y e il valore di essi può essere
usato nell’azione con l’espressione %(Derivato).X e %(Derivato).Y. Gli attributi derivti sono dispo-

nibili solo nella finestra Risultati individuati aperta dallo strumento Identifica geometrie e

non nella finestra Tabella attributo .

Due esempi di azioni sono di seguito indicati:

• konqueror http://www.google.com/search?q=%nam

• konqueror http://www.google.com/search?q=%%

Nel primo esempio, il browser konqueror viene richiamato con un URL da aprire. L’URL crea una
ricerca Google sul valore del campo nam nel layer vettoriale. Si noti che il programma o lo script
richiamato dall’azione deve essere nel path impostato come variabile d’ambiente oppure bisogna
fornire il percorso completo all’eseguibile. Per sicurezza, è possibile riscrivere il primo esempio come:
/opt/kde3/bin/konqueror http://www.google.com/search?q=%nam. In questo modo si sarà sicuri
che l’applicazione konqueror sarà eseguita quando si richiama l’azione.

QGIS 1.4.0 User Guide 60



5.4 Proprietà dei layer vettoriali

Nel secondo esempio viene usata la notazione %% che non richiede l’indicazione di un particolare
campo. Quando si richiama l’azione, il %% sarà rimpiazzato dal valore selezionato con lo strumento

Identifica geometrie o nella tabella attributi.

Uso delle azioni

Le azioni posso essere richiamate sia dalla finestra Risultati individuati che da quella della
Tabella attributo . (Si ricorda che queste finestre possono essere aperte rispettivamente cliccando

sullo strumento Identifica geometrie o Apri tabella attributi .) Per eseguire l’azione, fa-

re click con il tasto destro sul record e scegliere azione dal menu a comparsa. Le azioni sono indicate
nel menu a comparsa dal nome assegnatogli in fase di definizione dell’azione. Cliccare sull’azione
che si vuole eseguire.

Se si esegue un’azione che usa la notazione %%, cliccare con il tasto destro sul valore di cam-
po che si desidera passare all’azione nella finestra di dialogo Risultati individuati o in quella
Tabella attributo .

In questo altro esempio viene illustrato come estrarre dati da un layer vettoriale per inserirli in un file

usando la shell di sistema bash e il comando echo (dunque funzionerà solo su e forse su ). Il
layer in questione ha i seguenti campi nella tabella attributi: nome della specietaxon_name, latitudine
lat e longitudine long. Si vorrebbe eseguire una selezione spaziale delle specie (taxon) presenti a
determinate posizioni esportando i risultati in un file di testo per le posizioni selezionate (evidenziate
di default in giallo nella vista mappa di QGIS). L’azione in grado di assolvere lo scopo è la seguente:

bash -c "echo \"%taxon_name %lat %long\" >> /tmp/species_localities.txt"

Selezionando alcune posizioni, l’esecuzione dell’azione precedente su ognuna di esse genera un file
in uscita che avrà l’aspetto seguente:

Acacia mearnsii -34.0800000000 150.0800000000

Acacia mearnsii -34.9000000000 150.1200000000

Acacia mearnsii -35.2200000000 149.9300000000

Acacia mearnsii -32.2700000000 150.4100000000

Come esercizio si può creare un’azione che generi una ricerca su Google sul layer lakes. Innan-
zitutto è necessario determinare la sintassi da impiegare nell’URL per eseguire una ricerca basa-
ta su una parola chiave. L’espressione si ricava facilmente eseguendo una ricerca dalla pagina
di Google, la pagina dei risultati avrà un indirizzo, visibile nella barra indirizzi del browser, del tipo:
http://google.com/search?q=qgis, in cui qgis è la parola ricercata. Forniti di questa informazione,
si può procedere nel seguente modo:
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1. Assicurarsi che il layer lakes sia caricato.

2. Aprire la finestra di dialogo Proprietà del vettoriale facendo doppio click sul layer o cliccando

su di esso nella legenda con il tasto destro e scegliendo Proprietà dal menu contestuale.

3. Cliccare sulla scheda Azioni .

4. Inserire un nome descrittivo per l’azione, ad esempio Ricerca su Google.

5. Fornire il nome di un programma esterno da eseguire nell’azione. In questo caso useremo
il browser Firefox. Se il programma non si trova in uno dei percorsi di sistema definiti dalla
variabile d’ambiente PATH, bisogna specificare il percorso completo all’eseguibile.

6. Far seguire il nome del programma esterno dall’URL usato per la ricerca su Google senza
includere la parola ricercata, ovvero: http://google.com/search?q=

7. A questo punto il testo nel campo Azioni dovrebbe apparire così:
firefox http://google.com/search?q=

8. Cliccare sul menu a tendina contenente i nomi dei campi della tabella associata al layer lakes,

posizionato immediatamente a sinistra del pulsante Inserisci campo .

9. Dall’elenco apparso scegliere NAMES H e cliccare su Inserisci campo .

10. Il testo dell’azione dovrebbe ora apparire come segue:
firefox http://google.com/search?q=%NAMES

11. Per completare l’azione cliccare sul pulsante Inserisci azione .

Questo completa la definizione dell’azione che è così pronta per essere usata. La formulazione finale
dell’azione dovrebbe apparire così:

firefox http://google.com/search?q=%NAMES

A questo punto l’azione è pronta per essere usata. Chiudere la finestra Proprietà del vettoriale
e usare lo zoom su un’area a scelta. Assicurarsi che il layer lakes sia attivo ed identifichiamo con
l’apposito strumento un lago. Nella finestra risultante dovrebbe essere visibile l’azione:

QGIS 1.4.0 User Guide 62

http://google.com/search?q=
http://google.com/search?q=
http://google.com/search?q=%NAMES
http://google.com/search?q=%NAMES


5.4 Proprietà dei layer vettoriali

Figura 18: Selezione di un elemento e scelta dell’azione

Quando si clicca sull’azione, viene lanciato Firefox all’URL http://www.google.com/search?q=Tustumena.
È anche possibile aggiungere ulteriori campi all’azione, inserendo un “+” alla fine della stringa che

definisce l’azione, selezionando quindi un altro campo e cliccando sul pulsante Inserisci campo .
Nell’esempio seguito finora semplicemente non c’è alcun altro campo sul quale avrebbe senso fare
una ricerca.

È possibile definire più di un’azione per ogni layer, ognuna di esse verrà mostrata nella finestra
Risultati individuati . Si possono anche eseguire azioni dalla tabella attributi cliccando con il tasto

destro su una riga selezionata e scegliendo dal menu contestuale l’azione desiderata.

Si possono immaginare molti tipi di azione. Ad esempio se un layer di punti rappresenta le posizioni
alle quali sono state scattate foto o alle quali corrispondono immagini e il nome dei file di tali foto o
immagini, è possibile creare un’azione per lanciare un visualizzatore che mostri l’immagine. Le azioni
possono essere uate anche per lanciare report sul web per uno o più campi della tabella attributo,
definendole allo stesso modo definito nell’esempio per la ricerca con Google.

5.4.11. Scheda Attributi

Nella scheda Attributi è possibile modificare lo schema degli attributi del layer selezionato. I pul-

santi Nuova colonna ed Elimina colonna vengono attivati quando il layer è in modalità modifica,

ovvero quando viene premuto il pulsante Alterna la modalità di modifica . Al momento possono
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essere editate solo colonne appartenenti a layer PostGIS, in quanto questa funzione non è ancora
supportata dalla libreria OGR.

modifica widget

Nella scheda Attributi sono presenti anche le colonna modifica widget e valori. Esse possono
essere usate per definire un valore o un campo di valori che possono essere aggiunti alla specifica
colonna della tabella attributi. Sono usati per produrre diversi widgets di modifica nella finestra degli
attributi. Questi widgets sono:

• modifica linea: un campo di modifica che consente di inserire un linea di testo semplice (o
esclusivamente numeri se l’attributo è di tipo numerico).

• valori univoci: una lista di singoli valori da assegnare all’attributo proveniente da elementi
preesistenti viene prodotta e presentata in una combo box per la selezione.

• valori univoci (modificabile): una combinazione di ‘modifica linea’ e ‘valori univoci’. Il campo
modifica consente di modificare i valori preesistenti o di inserirne di nuovi.

• valore mappa: una combobox nella quale è possibile scegliere da un insieme di valori specificati
nella colonna valori della scheda Attributi . I valori possibili sono delimitati da un punto e

virgola (ad es. high;medium;low). È anche possibile preporre un’etichetta ad ogni valore, la
quale sarà delimitata dal segno dell’uguale (ad es. high=1;medium=2;low=3). L’etichetta è
mostrata nella combobox al posto del valore.

• classificazione: if a unique value renderer is selected for the layer, the values used for the
classes are presented for selection in a combobox.

• intervallo (modificabile): un campo di modifica che consente di restringere i valori numerici entro
un certo intervallo. L’intervallo viene specificato inserendo i valori massimi e minimi delimitati
da un punto e virgola (ad es.0;360) nella colonna valori della scheda Attributi .

• intervallo (cursore): un cursore scorrevole che consente la selezione di un valore entro un
predefinito intervallo e con una certo passo. L’intervallo è definito da un valore minimo, massimo
e dall’ampiezza del passo (ad es. 0;360;10) nella colonna valori della scheda Attributi .

• nome file: la linea di editazione del widget presenta anche un pulsante. Premendo il pulsante
si può caricare un file usando la finestra di dialogo per l’esplorazione delle risorse.

5.5. Modifica

QGIS fornisce capacità basilari di editazione delle geometrie vettoriali. Prima di procedere si evi-
denzia che a questo stadio il supporto per la modifica è ancora preliminare. Prima di eseguire una
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qualunque operazione di modifica, quindi, fare sempre una copia di backup dei dati che si intendono
modificare.

Nota - la procedura per la modifica di layer GRASS è differente, si veda la Sezione 9.7 per dettagli.

Tip 13 CONCURRENT EDITS

This version of QGIS does not track if somebody else is editing a feature at the same time as you. The last
person to save their edits wins.

5.5.1. Settare la tolleranza dello snapping e il raggio di ricerca degli ele menti

Prima di editare vertici, è molto importante sia impostare il livello di snapping che il valore del raggio
di ricerca che ci consentano una modifica ottimale delle geometrie del layer vettoriale.

Tolleranza sullo snapping

La tolleranza sullo snapping è la distanza entro la quale QGIS cerca il più vicino vertice e/o segmento
al quale si cerca di agganciarsi quando si crea un nuovo vertice o si sposta un vertice esistente. Se
non si è entro la tolleranza di snapping, QGIS lascerà il vertice creato o spostato nella posizione in
cui si rilascia il pulsante del mouse invece di agganciarlo ad un vertice e/o segmento esistente.

1. Una prima impostazione della tolleranza sullo snapping può essere impostata a livello
dell’intero progetto scegliendo la voce di menu Impostazioni > Opzioni Alla scheda

Digitalizzazione è possibile impostare la modalità di snap predefinita tra snap al vertice,
al segmento o entrambe. Si può anche definire una tolleranza sullo snap e un raggio di ri-
cerca per la modifica di un vertice, in unità del layer. Nel set di dati Alaska, le unità sono
in piedi (feet). L’impostazione ottimale può variare, ma in genere 300 piedi può essere una
impostazione ragionevole per lavorare alla scala 1:10.000.

2. È anche possibile impostare una tolleranza sullo snapping basata sul singolo layer scegliendo la

voce di menu Impostazioni > Proprietà progetto. . . . Nella scheda Generale , alla sezio-

ne Digitalizzazione si può cliccare sul pulsante Opzioni di snap. . . per abilitare e impostare
la tolleranza per ogni singolo layer del progetto (si veda la Figura 19).
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Figura 19: Modifica delle opzioni di snapping per singoli layer

Raggio di ricerca

Il raggio di ricerca è la distanza che QGIS usa per cercare il più vicino vertice che si sta cercando
di spostare quando si clicca nella mappa. Se non si è entro il raggio di ricerca, QGIS e mostrerà
un avvertimento in merito in una finestra pop-up. La tolleranza sullo snap e il raggio di ricerca sono
impostati in unità di mappa e potrebbe essere necessario fare diversi tentativi per trovare l’impo-
stazione migliore. Se si specifica una tolleranza troppo alta, QGIS potrebbe agganciare il vertice
sbagliato, specialmente se si ha a che fare con molti vertici vicini all’area in cui si sta effettuando la
modifica. Impostando invece un raggio di ricerca troppo piccolo impedirà invece a QGIS di trovare
alcuna geometria da spostare.

Il raggio di ricerca per la modifica di vertici può essere definita in unità del layer dalla scheda
Digitalizzazione sotto il menu Impostazioni -> Opzioni , sotto lo stesso percorso dal quale

è possibile impostare la tolleranza sullo snapping a livello di progetto.

5.5.2. Modifiche topologiche

Oltre alle opzioni di snap a livello di singolo layer la scheda Generale sotto la voce di menu

Impostazioni -> Proprietà progetto. . . fornisce anche alcune funzionalità per la topologia. Alla

voce Digitalizzazione è possibile selezionare l’opzione x Abilita la modifica topologica e/o attivare

l’opzione x Vieta le intersezioni per i nuovi poligoni .
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Abilitare la modifica topologica

L’opzione x Abilita la modifica topologica serve a mantenere limiti comuni tra poligoni adiacenti
durante l’editazione. QGIS individua un limite condiviso in un insieme di poligoni e tutto ciò che si
deve fare è spostare il vertice una volta sola, QGIS si occuperà di aggiornare anche il limite del
poligono adiacente.

Impedire le intersezioni per i nuovi poligoni

La seconda opzione x VIeta intersezioni per i nuovi poligoni impedisce la sovrapposizione di poli-
goni adiacenti, rendendone più spedita la digitalizzazione. Se si ha già un poligono, è possibile con
questa opzione abilitata digitalizzare il secondo in modo che entrambi si intersechino, QGIS taglierà
automaticamente il secondo sul limite comune con il vantaggio che l’utente non deve digitalizzare
tutti i vertici coincidenti.

5.5.3. Modifica di un layer esistente

Di default i layer sono caricati in QGIS in modalità solo lettura al fine di evitare modifiche involontarie.
Comunque è sempre possibile modificare i layer se è consentito dalla libreria (ovvero se ad es. OGR
supporta lo specifico formato in lettura/scrittura) e se il dato medesimo è anche scrivibile (ovvero i
file non sono in modalità sola lettura).

Le funzioni di modifica di layer sono più versatili quando sono applicate a dati immagazzinati in
database PostgreSQL/PostGIS.

Tip 14 INTEGRITÀ DEL DATO

È buona norma fare un back-up del dato originale prima di procedere alla modifica. Per quando siano stati
fatti molti sforzi da parte dei programmatori di QGIS per preservare l’integrità del dato, non vi è alcuna
garanzia che ciò avvenga.

Tip 15 MODIFICA DI ATTRIBUTI

Attualmente solo ai layer PostGIS possono essere aggiunte o eliminate colonne attributi da questa finestra.
Nelle versioni di QGIS future saranno supportate altre fonti di dati, in quanto questa caratteristica è stata
recentemente introdotta nelle librerie GDAL/OGR > 1.6.0

Tip 16 SALVATAGGIO AD INTERVALLI REGOLARI

Si ricordi di cambiare lo stato dello strumento Abilita/disabilita modifica ad intervalli regolari, in modo
da consentire il salvataggio delle modifiche recenti e per verificare che le stesse siano accettate dalla
sorgente di dati.

Ogni sessione di modifica può essere inizializzata dall’opzione Attiva/disattiva modifica , che
può essere attivata e disattivata cliccando con il tasto destro sul nome del layer nella legen-
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Tip 17 MODIFICHE CONCORRENTI

Questa versione di QGIS non effettua alcuna verifica sulla possibilità che più utenti stiano effettuando
contemporaneamente modifiche sullo stesso layer, è quindi l’ultimo utente che effettua il salvataggio ad
apportare le modifiche definitive.

Tip 18 INGRANDIRE PRIMA DELLA MODIFICA

Prima di modificare un layer, bisognerebbe effettuare un ingrandimento all’area di interesse, in modo da
evitare che in modalità modifica tutti i marker dei vertici visibili vengano resi a video per l’intero layer.

da e scegliendo dal menu contestuale oppure dalla barra strumenti cliccando sul pulsante

Attiva/disattiva modifica . Quando il layer è in modalità modifica, i vertici verranno contrassegnati dai
markers impostati (croci o cerchi semitrasparenti) e ulteriori pulsanti verranno resi disponibili nella
barra degli strumenti di modifica.

Zoom con la rotella del mouse

Mentre si digitalizza è possibile usare la rotella del mouse per ingrandire e ridurre la mappa, posizio-
nando il cursore nell’area di mappa e girando la rotellina verso di sé per ridurre e verso lo schermo
per ingrandire. La posizione del puntatore del mouse determinerà centro dell’area da ingrandire. È

possibile personalizzare il comportamento della rotella del mouse nella scheda Strumenti mappa

alla voce di munù Impostazioni > Opzioni .

Spostare la vista mappa con i tasti freccia

È possibile spostare la vista mappa mentre si digitalizza aiutandosi con i tasti freccia, posizionando
il puntatore del mouse nella vista e cliccando sulla freccia destra per spostarsi verso est, sinistra per
spostarsi verso ovest, su per spostarsi verso nord e giù per andare verso sud.

È anche possibile tenere premuta la barra spaziatrice mentre si sposta il mouse per spostare la vista
mappa e usare i tasti PgUp e PgDown per aumentare o ridurre l’ingrandimento senza interrompere
la sessione di digitalizzazione.

Sono disponibili le seguenti funzioni di modifica:

• Aggiunta elementi: Inserisci punti , Inserisci linee and Inserisci poligoni

• Inserisci anello

• Inserisci isola
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Tip 19 MARKER DEI VERTICI

La versione di QGIS attuale supporta due tipi di marker per i vertici (in modalità modifica): un cerchio

semitrasparente o una croce. Per cambiare lo stile del marker, scegliere la voce Opzioni dal menu

Impostazioni , cliccare sulla scheda Digitalizzazione e selezionare la voce appropriata.

• Dividi geometria

• Sposta geometria

• Sposta vertice

• Aggiungi vertice

• Elimina vertice

• Elimina selezione

• Taglia geometrie

• Copia geometrie

• Incolla geometrie

Aggiungere elementi

Prima di iniziare ad aggiungere elementi ad un layer, usare gli strumenti Sposta mappa

Ingrandisci Rimpicciolisci per visualizzare l’area di mappa nella quale si desidera apporre

modifiche.

A questo punto si possono usare gli strumenti Inserisci punti , Inserisci linee o

Inserisci poligoni per porre il puntatore di QGIS in modalità digitalizzazione.

Per ogni elemento, bisogna dapprima digitalizzarne la geometria e successivamente inserirne gli
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attributi.

Per digitalizzare la geometria, cliccare con il tasto sinistro sull’area di mappa per creare il primo punto
del nuovo elemento.

Per linee e poligoni, continuare a cliccare con il tasto sinistro per ogni ulteriore vertice che si de-
sidera inserire. Quando è terminato l’inserimento dei vertici o dei punti, cliccare con il tasto de-
stro in qualunque punto della mappa per confermare di aver terminato l’inserimento della geometria
dell’elemento.

Apparirà quindi la finestra degli attributi che consentirà di inserire le informazioni per l’elemento
appena creato. La Figura 20 mostra l’inserimento degli attributi per un fiume fittizio creato in Alaska.

Figura 20: Finestra di inserimento degli attributi per un elemento di nuova digitalizzazione

Tip 20 TIPOLOGIE DI ATTRIBUTO

Almeno per gli shapefile la modifica del tipo di attributo è validata durante l’inserimento. A causa di ciò, non è
ovviamente possibile inserire un numero in una colonna testuale quando compare la finestra
Inserire i valori dell’attributo o viceversa. Se ciò fosse necessario, si dovrebbero modificare gli attributi in

un secondo momento per mezzo della finestra Tabella attributo .

Spostare elementi

Si possono spostare elementi scegliendo dalla barra lo strumento Sposta geometria .

Dividere elementi

Si possono dividere elementi scegliendo dalla barra lo strumento Dividi geometria .
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Modificare i vertici di un elemento

Sia per i layer PostgreSQL/PostGIS che per gli shapefile, i vertici di un elemento possono essere
modificati.

I vertici possono essere modificati direttamente senza che si debba selezionare l’elemento del quale
si voglia modificare la geometria. In alcuni casi, più elementi possono condividere dei vertici, in questi
casi valgono le seguenti regole quando si clicca con il mouse vicino ad un elemento del layer:

• Linee - La linea più vicina al cursore è scelta come elemento da modificare. Di conseguenza
(per spostare e cancellare vertici) viene selezionato per la modifica il vertice più vicino su quella
linea.

• Polygoni - Se il mouse è all’interno di un poligono, esso è l’elemento da modificare; altrimenti
viene usato il più vicino poligono. Di conseguenza (per spostare e cancellare vertici) viene
selezionato per la modifica il vertice più vicino su quel poligono.

Ricordarsi di impostare l’opzione sotto Impostazioni > Opzioni > Digitalizzazione alla casella

Raggio di ricerca per la modifica di un vertice in unità layer 10 N

H ad un valore superiore a zero,

altrimenti QGIS non sarà in grado di determinare quale elemento deve essere modificato.

Aggiungere vertici ad un elemento

Si possono aggiungere ulteriori vertici ad un elemento del layer scegliendo dalla barra lo strumento

Aggiungi vertice .

Si noti che è privo di senso aggiungere ulteriori vertici ad un elemento puntuale!

In questa versione di QGIS i vertici possono essere aggiunti sono ad un segmento di elementi lineari
esistenti. Se si desidera estendere una linea oltre le sue estremità, è necessario spostare dapprima
il vertice finale e quindi aggiungere un nuovo vertice nel punto in cui questo si trovava.

Spostare i vertici di un elemento

Si possono spostare vertici scegliendo dalla barra lo strumento Sposta vertice .

Cancellare vertici di un elemento

Si possono cancellare vertici scegliendo dalla barra lo strumento Elimina vertice .

Si noti che è privo di senso cancellare un vertice da un elemento puntuale, poiché questo
equivarrebbe a cancellare l’elemento!
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Similmente una linea costituita da un solo vertice o un poligono costituito da due vertici non hanno
molto senso e potrebbero avere comportamenti imprevisti nell’uso di altre funzioni di QGIS (ad es.
con gli strumenti di analisi) e di conseguenza bisogna evitare modifiche che portino a creare tali
geometrie.

Attenzione: Un vertice è contrassegnato per l’eliminazione non appena si clicca con il mouse vicino
ad un elemento selezionabile. Per annullare, sarà necessario disabilitare la modalità di modifica
senza salvare i cambiamenti. (Ovviamente questo comporterà anche la perdita delle altre modifiche
non salvate.)

Inserisci anello (buco)

So possono digitalizzare nuovi poligoni all’interno di poligoni esistenti al fine di creare un buco al-

l’interno di questi ultimi scegliendo dalla barra lo strumento Inserisci anello . In questo modo
solo l’area compresa tra i margini del poligono interno e di quello esterno verrà evidenziata come un
poligono ad anello.

Inserisci isola, ovvero creazione/modifica di un multipoligono

Si possono creare e modificare multipoligoni (insieme di elementi poligonali geometricamente indi-
pendenti ovvero non condividenti alcun vertice o limite visti come entità unica quando si seleziona
anche uno solo dei singoli elementi) aggiungendo ulteriori isole ad un singolo poligono o ad un mul-

tipoligono esistenti scegliendo dalla barra lo strumento Inserirsci isola . La nuova isola del
multipoligono deve essere esterna al poligono che si intende rendere multipoligono o agli elementi
già facenti parte di un multipoligono esistente che si intende modificare.

Tagliare, copiare ed incollare elementi

Gli elementi selezionati possono essere tagliati, copiati ed incollati tra layer dello stesso progetto di
QGIS a patto che anche nel layer di destinazione sia stata abilitata la modalità di modifica tramite

l’opzione Attiva/disattiva modifica .

Gli elementi possono essere anche incollati in applicazioni esterne come testi: gli elementi verrano
rappresentati nel formato CSV con le informazioni della geometria espresse nel formato testo OGC
Well-Known Text (WKT).

Tuttavia in questa versione di QGIS elementi di testo formattato creati con applicazioni esterne non
possono essere incollate in un layer dentro QGIS.

Le funzioni di copia/incolla possono essere utili quando si vogliano modificare più layer copiando le
modifiche effettuate in uno di questi negli altri. Supponendo ad esempio di voler lavorare su un layer
contenente un paio di laghi, diventa molto più agevole creare un nuovo layer vuoto nel quale incollare
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gli elementi dei quali necessitiamo invece di lavorare sul layer big_lakes contenente 5000 elementi.

Dovremo quindi effettuare le seguenti operazioni:

1. Caricare il layer dal quale vogliamo copiare gli elementi (layer sorgente)

2. Caricare o creare il layer nel quale vogliamo incollare gli elementi copiati(layer di destinazione)

3. Impostare entrambi i layer in modalità modifica

4. Rendere attivo il layer sorgente cliccando sul relativo nome nella legenda

5. Attivare lo strumento Seleziona geometrie per selezionare gli elementi dal layer

sorgente

6. Cliccare sullo strumento Copia geometrie

7. Rendere attivo il layer di destinazione cliccando sul relativo nome nella legenda

8. Attivare lo strumento Incolla geometrie

9. Terminare le modifiche e salvare

Se il layer sorgente e quello di destinazione hanno un diverso schema (nomi e tipi dei campi) della
tabella attributi QGIS popola, (se presenti) i campi comuni e ignora il resto. Se non è importante che
vengano copiati anche gli attributi nel layer di destinazione, si può non prestare attenzione a come
viene definito lo schema della tabella attributi, altrimenti è necessario definirlo in modo che quello del
layer sorgente e di destinazione combacino.

Tip 21 CONGRUENZA DEGLI ELEMENTI INCOLLATI

Se il layer sorgente e quello di destinazione usano lo stesso sistema di proiezione, gli elementi incollati
saranno assolutamente identici a quelli del layer di origine. Nel caso in cui invece la proiezione del layer di
destinazione sia differente QGIS non garantisce che la geometria sia identica a causa del pur ridotto errore di
arrotondamento introdotto nel passaggio da un sistema di proiezione all’altro.

Cancellare elementi selezionati

Se si vuole eliminare un intero poligono, è possibile farlo selezionando dapprima l’elemento che in-

tendiamo cancellare con lo strumento Seleziona geometrie . È possibile anche selezionare

contemporaneamente più poligoni da cancellare in una volta sola. Una volta definita la selezione,

usare lo strumento Elimina selezione per cancellare la selezione. Non è possibile annul-
lare l’eliminazione, tuttavia è sempre possibile annullare l’eliminazione (ma anche altre eventuali
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modifiche effettuate dall’ultimo salvataggio!) terminando la modalità di modifica senza salvare le
modifiche.

Anche lo strumento Taglia geometrie può essere usato per eliminare elementi, che vengono

in questo caso spostati un un blocco appunti spaziale. In questo modo è però possibile annullare

l’operazione incollando nuovamente gli elementi tagliati con lo strumento Incolla geometrie
fornendo in ultima analisi almeno un livello di annullamento.

Tutti gli strumenti taglia, copia e incolla lavorano sugli elementi attualmente selezionati, consentendo
quindi di lavorare su più di un elemento alla volta.

Tip 22 SUPPORTO ALLA CANCELLAZIONE DI ELEMENTI

Quando si modificano shapefile, la cancellazione di elementi funziona solo se QGIS è compilato contro una
versione di GDAL pari a 1.3.2 o superiore, come accade per le versioni compilate per OS X and Windows
disponibili sul sito.

Modalità di snap

QGIS consente di agganciare i vertici digitalizzati ad altri vertici dello stesso layer. Per impostare la

tolleranza di aggancio, andare alla voce di menu Impostazioni > Opzioni -> Digitalizzazione . Si
noti che la tolleranza di aggancio è in unità di mappa.

Salvare i layer modificati

Quando un layer è in modalità modifica, tutti i cambiamenti rimangono nella memoria di QGIS e
quindi non sono immediatamente applicati e salvati nei dati su disco. Quando viene disabilitata la
modalità di modifica (o si termina la sessione di QGIS mentre questa non è stata finalizzata), viene
chiesto se si desidera salvare o scartare le modifiche.

Se le modifiche non possono essere salvate (ad es. perché il disco di destinazione è pieno o gli attri-
buti contengono valori esterni agli estremi ammissibili), lo stato della memoria di QGIS è preservato,
consentendo dunque di correggere gli errori e riprovare il salvataggio.

5.5.4. Creare un nuovo layer

Per creare un nuovo layer da modificare, scegliere l’opzione Nuovo layer vettoriale dal me-

nu Layer . Verrà quindi aperta la finestra Nuovo layer vettoriale come mostrato in Figure 21.
Scegliere qui il tipo di geometria che si intende inserire nel layer (punto, linea o poligono).

Si noti che QGIS non supporta la creazione di elementi 2.5D (ad es. elementi con coordinate XYZ)
o il conteggio degli elementi. Ad oggi inoltre possono essere creati solo shapefile. Il supporto per la
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Figura 21: Finestra di creazione di un nuovo layer vettoriale

creazione di layer OGR o PostgreSQL sarà inserito in future versioni di QGIS.

La creazione di layer di GRASS è supportata dal plugin GRASS. Si faccia riferimento alla Sezione
9.6 per ulteriori informazioni sulla creazione di layer vettoriali GRASS.

Per completare la creazione del nuovo layer, si definisca lo schema degli attributi specificando il

nome e tipo della colonna da inserire nella tabella e cliccando sul pulsante Aggiungi attributo .

Sono supportati solo attributi di tipo Tipo real H , Tipo Intero H , and Tipo Stringa H . Una

volta definito lo schema, cliccare su OK e assegnare un nome allo shapefile. QGIS aggiungerà
automaticamente l’estensione .shp al nome indicato. Una volta creato il layer, esso sarà aggiunto
alla mappa e potrà essere modificato nello stesso modo descritto alla precedente Sezione 5.5.3.
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5.6. Generatore di query (query builder)

Il generatore di query consente di definire (tramite il linguaggio Structured Query Language, SQL)
un sottoinsieme di una tabella e mostrarlo come layer in QGIS. Può essere usato pper tutti i formati
OGR, i file di GRASS ed i layer di PostGIS. Per esemio, se si ha il file towns che contiene un campo
population nella tabella attributi indicante il numero di residenti è possibile selezionare solo le città
più grandi inserendo l’espressione population > 100000 nella casella SQL del costruttore di query.
La Figura 22 mostra un esempio per il costruttore di query popolato con dati provenienti da layer
PostGIS immagazzinati nel database PostgreSQL.

Figura 22: La finestra del costruttore di query

La finestra del costruttore di query elenca i campi del database nella casella sulla sinistra. Un cam-

pione dei dati selezionabili con l’espressione impostata è visibile cliccando sul pulsante Campione

. In questo modo vengono richiamati i primi 25 valori distinti dai campi del database. Per avere una
lista completa di tutti i valori di un campo, cliccare sul pulsante All . Per aggiungere un campo o

un valore selezionato alla query, fare doppio-click su di esso. È possibile usare i vari pulsanti per
costruire le interrogazioni oppure digitare direttamente il testo dell’interrogazione nella casella SQL.
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Per provare una query cliccare sul pulsante Prova . Se l’espressione è correta, verrà restituito un
conteggio dei record che verranno inclusi nella selezione. Quando l’espressione dell’interrogazione
è soddisfacente, cliccare sul pulsante OK . Nella casella SQL verrà mostrato il testo della richiesta.

Tip 23 CAMBIARE LA DEFINIZIONE DI UN LAYER

Si può cambiare la definizione SQL di un layer caricato da PostGIS anche dopo che questo è stato caricato,
aprendo la finestra Proprietà del vettoriale facendo doppio click sul nome del layer nella legenda e

cliccando sul pulsante Query Builder nella scheda Generale . Si veda la Sezione 5.4 per ulteriori
informazioni.

5.7. Selezione mediante interrogazione

Con QGIS è possibile selezionare elementi per mezzo di un’interfaccia simile a quella del generatore
di query usata in 5.6. Nella sezione precedente il generatore di query è stato usato unicamente per
mostrare gli elementi di un layer che soddisfacevano i filtri imposti in un layer virtuale sottoinsieme di
quello originale. Lo scopo della selezione mediante interrogazione è invece quello di evidenziare gli
elementi di un layer caricato che soddisfano particolare criteri. La selezione con query può essere
usata con tutte le sorgenti di dati vettoriali supportate.

Per effettuare una selezione mediante interrogazione su un layer caricato, cliccare sul pulsante

Apri tabella attributi e cliccare nella finestra sul pulsante Advanzate... in basso a destra. In questo

modo viene avviato il generatore di query che consente di definire un sottoinsieme degli elementi e
mostrarli come descritto alla Sezione 5.6.
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6. Lavorare con i dati raster

Questa Sezione descrive come visualizzare ed impostare le proprietà dei dati raster. I formati raster
attualmente supportati in QGIS includono:

• Arc/Info Binary Grid

• Arc/Info ASCII Grid

• GRASS Raster

• GeoTIFF

• JPEG

• Spatial Data Transfer Standard Grids (con alcune limitazioni)

• USGS ASCII DEM

• Erdas Imagine

Considerato che il supporto ai raster in QGIS è fornito dalla libreria GDAL, oltre a quelli elencati
è possibile che sia possibile caricare anche altri formati supportati da GDAL - nel dubbio è comu-
nuque possibile provare ad aprire il file in QGIS per verificare l’esito. Ulteriori dettagli sono forniti
all’Appendice A.2 o all’indirizzo http://www.gdal.org/formats_list.html. Per caricare dati raster
di GRASS, fare riferimento alla Sezione 9.2.

6.1. Cosa sono i dati raster?

I dati raster nei GIS sono matrici di celle discrete che rappresentano le caratteristiche della superficie
terrestre o dell’ambiente al di sopra o al di sotto di essa. Ogni cella nella matrice raster presenta
lo stesso formato e le celle sono solitamente rettangolari (in QGIS saranno sempre rettangolari).
Esempi tipici di dati raster sono quelli provenienti dal telerilevamento come le fotografie aeree o
immagini proveniente dal satellite e dati modellistici quali matrici dell’altitudine.

Diversamente dai dati vettoriali, i dati raster di solito non hanno associato un database contenente i
dati descrittivi di ogni cella.

I dati raster, infine, sono geocodificati in base alla risoluzione del pixel e alle coordinate x/y di un
angolo del raster che ne consente un corretto posizionamento nella vista mappa.

QGIS utilizza le informazioni di georeferenziazione incorporate nel layer raster (ad es. GeoTiff) o in
un apposito world file per visualizzare correttamente i dati.

QGIS 1.4.0 User Guide 78

http://www.gdal.org/formats_list.html


6.2 Caricamento dati raster in QGIS

6.2. Caricamento dati raster in QGIS

I layer raster possono essere caricati sia selezionando nella barra lo strumento

Aggiungi layer raster o scegliendo la voce di menu Layer > Aggiungi layer raster . È

possibile caricare più di un layer alla volta tenendo premuto il tasto
�

�

�

�Control o
�

�

�

�Shift
mentre si effettua la selezione multipla con il mouse sui layer nella finestra di dialogo
Apre unraster supportato da GDAL .

Quando il layer è caricato è possibile cliccare nella legenda sul relativo nome con il tasto destro per
selezionare ed attivare opzioni specifiche o per aprire la finestra per l’impostazione delle proprietà
del layer raster.

Menu contestuale per layer raster

• Zoom all’estensione del layer

• Zoom alla scala migliore (100%)

• Aggiungi alla panoramica

• Rimuovi

• Proprietà

• Rinomina

• Aggiungi gruppo

• Espandi tutto

• Comprimi tutto

• Mostra gruppi

6.3. Finestra delle proprietà raster

Per visualizzare ed impostare le proprietà di un layer raster, fare doppio click sul nome del raster
nella legenda o cliccare su di esso con il tasto destro e scegliere Proprietà dal menu contestuale:

La figura 23 mostra la finestra Proprietà raster . Ci sono diverse schede nella finestra:

• Simbologia
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• Trasparenza

• Mappa colore

• Generale

• Metadata

• Piramidali

• Istogramma

Figura 23: Finestra delle proprietà dei layer raster
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6.3.1. Scheda Simbologia

QGIS può rendere a video i raster in due modi:

• Banda singola grigia - viene campionata una sola banda dell’immagine e resa in gradazioni di
grigio o in pseudocolore.

• Tre bande di colore - vengono rese a video tre bande dell’immagine ognuna rappresentante le
componenti rosso, verde o blu che saranno composte per creare un’immagine a colori.

È possibile invertire i colori in modo che i colori chiari divengano scuri e viceversa selezionando la

casella di controllo x Inverti mappa colore .

Resa in banda singola

Selezionando questa opzione vengono offerte due possibilità tra le quali scegliere. Innanzitutto se il
layer è multibanda è possibile scegliere quale banda si desidera venga impiegata per la resa a video.

La seconda opzione offre una selezione di tabelle colori preimpostate per la resa a video.

Le scelte possibili disponibili nel menu a tendina sono Mappa colore Scala di grigi H ,

impostazione di default. Altre scelte possibili sono

• Pseudo colore

• Freak Out

• Mappa colore

Quando viene selezionata l’opzione Mappa colore Mappa colore H , viene abilitata la scheda

Mappa colore . Si vedano ulteriori informazioni al capitolo 6.3.3.

Per immagini in pseudocolore in QGIS è possibile limitare i dati visualizzati per mostrare soltanto le
celle i cui valori ricadono all’interno di una deviazione standard definita. Ciò può essere utile quando
nella griglia raster si hanno una o due celle con valori anormalmente alti che hanno un impatto
negativo sulla resa a video del raster.

Resa in tre bande

Questa opzione offre un considerevole numero di possibilità di modifica dell’aspetto del raster. Ad
esempio è possibile cambiare il normale ordine RGB delle bande e/o applicare una scala di colori in
base ai valori min/max del raster.
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Tip 24 VEDERE UNA SINGOLA BANDA DI UN RASTER MULTIBANDA

Il modo corretto di visualizzare ad es. la sola banda rossa di un’immagine multibanda non è quello di
impostare le bande verde e blu a Non impostato, ma di impostare il tipo di immagine come scala di grigi e
quindi scegliere il rosso come banda da usare per il grigio.

6.3.2. Scheda Trasparenza

Questa scheda consente di impostare in QGIS un diverso grado di trasparenza per ogni layer raster.
Per settare una Trasparenza globale, impostare il cursore a scorrimento al livello di trasparenza
desiderato in maniera tale da consentire la visualizzazione degli eventuali layer sottostanti. L’uso di
questa impostazione può essere molto utile nei casi in cui si desideri sovrapporre ad es. ad una
mappa delle ombreggiature del rilievo (shaded relief-map) assieme a una mappa raster contenente
delle classificazioni, così da dare un aspetto tridimensionale a quest’ultima.

La sezione Nessun valore consente invece di definire la trasparenza per un certo valore del raster,
che sarà quindi letto come un campo privo di dati del tipo NODATA. Di conseguenza in corrispon-
denza di tutte le celle del raster contenenti quel valore non verrà reso a video niente, determinando
quindi una trasparenza per il valore specificato.

È possibile definire la trasparenza in maniera ancora più dettagliata e personalizzata nelle Sezione
Opzioni di trasparenza personalizzate, nella quale è possibile impostare il grado di trasparenza per
ogni valore del raster. Ad esempio se si volesse utilizzare quest’ultima sezione per visualizzare
l’acqua del raster di esempio landcover.tif con una trasparenza del 20%, bisognerà seguire la
seguente procedura:

1. Caricare il raster landcover

2. Aprire la finestra di dialogo Proprietà facendo doppio click sul nome del file nella legenda o

cliccando su di esso con il tasto destro e scegliendo Proprietà dal menu contestuale

3. Selezionare la scheda Trasparenza

4. Cliccare sul pulsante Aggiungi un valore manualmente . Nella lista pixel apparirà una

nuova riga

5. Inserire il valore del raster per il quale si desidera modificare la trasparenza (si supponga 0 per
questo esempio) e si imposti la trasparenza al 20%

6. Cliccare sul pulsante Applica e guardare la mappa

È possibile ripetere i passaggi 4 e 5 per impostare ulteriori valori ai quali si desideri applicare una
trasparenza personalizzata.
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Appare quindi semplice impostare la trasparenza personalizzata, ma può risultare una procedura
laboriosa specie se si hanno molti valori da impostare. È quindi possibile salvare la lista delle im-

postazioni di trasparenza cliccando sul pulsante Esporta in file per non ripetere la procedu-

ra. Il pulsante Importa da file infatti carica il file salvato e applica le impostazioni al raster

selezionato.

6.3.3. Scheda Mappa colore

La scheda Mappa colore viene abilitata solo quando si imposta la resa a video del raster come

Banda singola grigia nella scheda Simbologia (si veda il capitolo 6.3.1).

Sono disponibili tre modalità di interpolazione del colore:

• Discrete

• Lineare

• Esatto

Il pulsante Aggiungi oggetto aggiunge un colore all’elenco. Facendo doppio click sul valore com-
parso nella colonna Value (di default 0.0) è possibile specificare il valore specifico del raster per il
quale si vuole modificare il colore. Facendo doppio click sulla casella colorata nella colonna Color
appare infatti la finestra Select color nella quale è possibile definire il colore da applicare alle
celle raster corrispondenti al valore che si sta editando. In alternativa è possibile cliccare sul pul-

sante Carica mappa colore dalla banda , con il quale viene caricata, se viene trovata o se

disponibile, la tabella dalla banda.

Il blocco Genera nuova mappa colore consente di creare nuove mappe colore per categoria secondo
i parametri impostati. È sufficiente impostare il numero di classi (valori) per i quali si intende impo-

stare il colore nella sezione Numero di oggetti 15 N

H e cliccare poi su Classifica . Attualmente è

possibile effettuare una classificazione solo in modalità Modo di classificazione Equal Interval H .

6.3.4. Scheda Generale

La scheda Generale visualizza le informazioni di base sui raster selezionati, incluso il percorso
dal quale il layer è caricato e il nome (modificabile a piacere) con il quale esso sarà visualizzato in
legenda. Viene inoltre mostrata una miniatura del layer, la legenda dei simboli e la gamma di colori
(se disponibili).
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È qui possibile attivare la funzione che setta la visibilità del layer in base alla scala della mappa,
attivando l’apposita casella di controllo ed impostando l’intervallo di scale entro il quale si vuole che
il layer venga reso a video.

Viene inoltre fornita l’indicazione del sistema di riferimento spaziale impostato per il layer raster in
formato stringa PROJ.4. Esso è modificabile cliccando sul pulsante Cambia .

6.3.5. Scheda Metadata

La scheda Metadata mostra una serie di informazioni sul layer raster, come ad es. le statistiche
riguardanti ogni banda. Le statistiche sono disponibili in questa scheda solo dopo averle raccolte

cliccando sulla scheda Istogramma e aver cliccato sul pulsante Aggiorna in basso a destra (si
veda il capitolo 6.3.7.

Si tratta quindi di una scheda meramente informativa nella quale non è possibile modificare alcun
valore.

6.3.6. Scheda Piramidali

I layer raster ad alta risoluzione possono rallentare notevolmente l’esplorazione della mappa in QGIS.
Creando copie a minor risoluzione dei dati (piramidali), le prestazioni possono essere incrementate,
poiché QGIS seleziona la risoluzione più appropriata in relazione al livello di zoom.

Per creare i piramidali è innanzitutto necessario avere i permessi in scrittura sulla cartella contenente
il dato originale nel quale verranno salvate le copie a varia risoluzione.
Sono disponibili i seguenti metodi di ricampionamento:

• Media

• Il più vicino possibile (metodo Nearest Neighbour)

Quando viene attivata la casella di controllo x Crea piramidale interno se possibile QGIS cerca di
far sì che, se il formato lo supporta, i vari layer di risoluzione siano immagazzinati nella stesso file
raster piuttosto che in copie multiple separate.

Si evidenzia che la costruzione dei piramidali può alterare il dato originale in maniera irreversibile,
quindi si raccomanda di fare una copia di backup del raster di partenza prima di eseguire l’operazione.
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6.3.7. Scheda Istogramma

La scheda Istogramma consente di visualizzare la distribuzione delle bande di colore nel layer

raster. Innanzitutto è necessario generare le statistiche del raster cliccando sul pulsante Aggiorna .

È possibile selezionare quale banda mostrare nel diagramma selezionandola nella lista sulla sinistra
della scheda (è possibile effettuare una selezione multipla cliccando su più voci). Possono essere
visualizzati due tipi di diagrammi:

• Diagramma a colonna

• Diagramma a linea

Può essere definito in Conteggio colonna il numero di colonne da usare nel grafico (rappre-
sentante il numero di intervalli in cui vengono raggruppati i dati) e decidere se si deside-

ra abilitare x Permetti approssimazione e/o mostrare valori fuori scala abilitando la casella

x Fuori intervallo OK? . Una volta visualizzato il grafico, verranno popolati i campi sulle statistiche

per banda nella scheda Metadata .

Tip 25 OTTENERE LE STATISTICHE DEL RASTER

Per ottenere le statistiche di un layer, impostarne la rappresentazione in pseudocolore e cliccare su
Applica . L’operazione può richiedere molto tempo in funzione della quantità di dati contenuti nel raster,

delle impostazioni di analisi settate e delle capacità di calcolo della macchina usata, attendere quindi
pazientemente che QGIS termini tale analisi.
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7. Lavorare con i dati OGC

QGIS supporta sorgenti di dati WMS e WFS. Il supporto WMS è nativo, quello per WFS è fornito
tramite plugin.

7.1. Cosa sono i dati OGC

L’Open Geospatial Consortium (OGC), è un’organizzazione internazionale che raggruppa più di
300 organizzazioni commerciali, governative, nonprofit e di ricerca. I suoi membri sviluppano e
implementano standard per contenuti e servizi geospaziali, analisi GIS e scambio dati.

Dal Consorzio è stato quindi elaborato un numero crescente di specifiche per i modelli di dati per
garantire bisogni specifici riguardanti l’interoperabilità nell’ambito della tecnologia geospaziale, inclusi
i GIS. Ulteriori informazioni all’indirizzo http://www.opengeospatial.org/.

Importanti specifiche OGC sono:

• WMS - Web Map Service

• WFS - Web Feature Service

• WCS - Web Coverage Service

• CAT - Web Catalog Service

• SFS - Simple Features for SQL

• GML - Geography Markup Language

Ad oggi i servizi OGC-sono sempre più di uso comune per scambiare dati geografici fra differenti
implementazioni GIS. QGIS ora può gestire tre delle specifiche esposte sopra tra cui SFS (tramite il
supporto a PostgreSQL/PostGIS, vedi Sezione 5.2); e WFS e WMS come client.

7.2. Client WMS

7.2.1. Panoramica sul servizio WMS

QGIS può agire come client WMS, nel rispetto delle specifiche 1.1, 1.1.1 e 1.3. È stato
particolarmente testato nei confronti di server accessibili pubblicamente quali DEMIS e JPL OnEarth.

I server WMS rispondono alle richieste da parte dei client (ad es. QGIS) di una mappa raster di una
determinata estensione, con un determinato insieme di layer, simboli e trasparenze. Il server WMS
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quindi consulta le sue risorse (locali o remote), genera il raster e lo invia al client in formato raster,
per QGIS tipicamente come immagini JPEG o PNG.

WMS è un servizio REST (Representational State Transfer) piuttosto che un servizio web completo.
Come tale, si può prendere la URL (indirizzo del server con specifiche) generata da QGIS e usarla
in un browser web per ottenere la stessa immagine che QGIS usa internamente. Questo può essere
utile per identificare le cause di eventuali problemi, dato che esistono vari tipi di server WMS e
ciascuno ha la sua propria interpretazione degli standard WMS.

I layer WMS possono essere aggiunti molto semplicemente, una volta disponibile l’indirizzo (URL) per
accedere al server WMS, una connessione adatta e posto che il server usi l’HTTP come meccanismo
di trasferimento dati.

7.2.2. Scegliere un server WMS

La prima volta in cui si vuole utilizzare un servizio WMS, non sono presenti server predefiniti.

Si può avviare lo strumento cliccando sul pulsante Aggiungi layer WMS nella barra stru-

menti, oppure dalla voce di menu Layer > Aggiungi layer WMS... . Si aprirà la finestra di dia-

logo Aggiungi layer dal server . È possibile aggiungere alcuni server cliccando sul pulsante

Aggiungi server predefiniti . Verranno quindi aggiunti almeno tre server WMS, incluso il server del-

la NASA (JPL). Per definire un nuovo server WMS nella sezione Connessioni server , cliccare su

Nuovo ed inserire i parametri di connessione al server WMS desiderato, seguendo le indicazioni
della tabella 2:

Tabella 2: Parametri connessione WMS

Nome nome per la connessione che consenta di individuarlo nella lista dei server
WMS nel menu a tendina.

URL indirizzo URL del server che fornisce i dati. Deve essere un indiriz-
zo raggiungibile, nello stesso formato che verrebbe usato per aprire una
connessione telnet o pingare un host.

È possibile, se necessario, impostare nelle opzioni i parametri del proxy per ricevere i servi-
zi WMS da internet. Selezionare la voce di menu Impostazioni > Opzioni e cliccare sulla

scheda Proxy , nella quale è possibile inserire le impostazioni abilitando la casella di controllo

x Utilizza un proxy per l’accesso web .

Una volta creata la connessione al server WMS, essa sarà memorizzata e disponibile per le
successive sessioni di QGIS.
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Tip 26 A PROPOSITO DI INDIRIZZI DEI SERVER WMS
Quando si inserisce l’indirizzo URL del server assicurarsi di usare l’indirizzo di base. Ad esempio non bisogna
inserire frammenti tipo request=GetCapabilities o version=1.0.0 nell’indirizzo.

La tabella 3 mostra alcuni esempi di indirizzi di server WMS con i quali iniziare. Questi links sono
stati controllati l’ultima volta nel Dicembre 2006, ma potrebbero essere stati modificati nel frattempo:

Tabella 3: Esempi di indirizzi di server WMS pubblici

Name URL
Atlas of Canada http://atlas.gc.ca/cgi-bin/atlaswms_en?
DEMIS http://www2.demis.nl/wms/wms.asp?wms=WorldMap&
Geoscience Australia http://www.ga.gov.au/bin/getmap.pl?dataset=national
NASA JPL OnEarth http://wms.jpl.nasa.gov/wms.cgi?
QGIS Users http://qgis.org/cgi-bin/mapserv?map=/var/www/maps/main.map&

Un elenco esaustivo di server WMS è reperibile all’indirizzo http://wms-sites.com.

7.2.3. Caricare layer WMS

Una volta compilati correttamente i campi, si può premere sul pulsante Connetti per ottenere le
capacità del server. Tra queste sono inclusi i formati immagine, i layer disponibili e i sistemi di
proiezione forniti dal server. Considerato che si tratta di operazioni in rete, la velocità nella risposta
dipenderà dalla qualità della connessione verso il server WMS. Mentre si scaricano i dati dal server,
l’avanzamento dell’operazione viene visualizzato nella porzione inferiore sinistra della finestra.

Lo schermo dovrebbe rassomigliare alla Figura 24, che mostra la risposta fornita dal server WMS
NASA JPL OnEarth.

Codifica immagine

La sezione Codifica immagine elenca i formati supportati sia dal client che dal server. La scelta
dipenderà dalla risoluzione che necessita allo scopo prefisso.

Tip 27 CODIFICA IMMAGINE

Solitamente un server WMS offrirà la scelta tra le codifiche JPEG e PNG. Mentre la compressione JPEG
comporta una perdita di qualità, quella PNG riproduce fedelmente il dato di origine. Usare JPEG se non
interessa avere una certa perdita di qualità dell’immagine, riducendo d’altro canto il tempo per il download dei
dati di 5 volte rispetto al formato PNG. Usare invece PNG se si vuole una rappresentazione precisa del dato
originale e non ci si preoccupa del tempo necessario per il trasferimento dei dati.
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Figura 24: Finestra per l’aggiunta di un server WMS, nella quale vengono mostrati i layer disponibili

Layers

La sezione Layer elenca i layer disponibili dal server WMS selezionato. Si vedrà che alcuni layer
sono espandibili, il che comporta che possono venir mostrati in diversi stili di immagine.

Possono essere selezionati diversi layer alla volta, ma un solo stile di immagine per ognuno di essi.
Quando si effettua una selezione multipla, i layer vengono richiesti al server e trasmessi a QGIS in
un solo blocco.

Tip 28 ORDINE DEI LAYER WMS
In questa versione di QGIS, i layer WMS caricati sono sovrapposti in base all’ordine in cui sono elencati nella
sezione Layer, dall’alto verso il basso. Se si desidera sovrapporre i layer nel senso opposto occorre

selezionare una seconda volta Aggiungi layer WMS , scegliere nuovamente lo stesso server e

selezionare il secondo gruppo di layer che si desidera sovrapporre al primo.

Trasparenza

In questa versione di QGIS la trasparenza è impostata per essere sempre attiva, se disponibile.

Tip 29 TRASPARENZA DEI LAYER WMS
La possibilità di rendere trasparenti i layer WMS dipenda dalla codifica tramite la quale sono stati caricati:
PNG e GIF gestiscono la trasparenza mentre il JPEG no.
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Sistema di proiezione delle coordinate (Coordinate Reference Syst em)

Un sistema di proiezione delle coordinate (Coordinate Reference System, CRS) è il termine OGC
per una proiezione in QGIS.

Ogni layer WMS può essere restituito in molteplici CRS, in funzione delle capacità del server. Si noti
che il numero di sistemi di riferimento tra cui scegliere viene indicato nella dicitura Coordinate Sistema

di Riferimento (x disponibili) quando si seleziona/deseleziona un livello nella sezione Layer .

Per scegliere uno dei CRS disponibili, cliccare su Cambia... per fare apparire una finestra simile a
quella della Figura 27 alla Sezione 8.3. La differenza principale rispetto alla versione WMS mostrata
nello schermo è che saranno mostrati solo i CRS supportati dal server al quale ci si sta effettivamente
connettendo.

Tip 30 LE PROIEZIONI WMS
Per ottenere i migliori risultati, aggiungere per primo al progetto il layer WMS, in modo che il sistema di
riferimento dell’intero progetto sia lo stesso attribuito al layer WMS. Si potrà quindi usare la proiezione al volo
(si veda la Sezione 8.2) per adattare qualunque altro layer vettoriale successivamente aggiunto. In questa
versione di QGIS, aggiungere layer WMS successivamente ad altri con un CRS diverso rispetto a quello del
progetto, può causare errori.

7.2.4. Uso dello strumento di identificazione

Una volta aggiunto un server WMS, e se uno dei layer disponibili è interrogabile, è possibile usare lo

strumento Informazioni geometrie per selezionare un pixel sulla mappa, determinando una

interrogazione verso il server WMS per ogni selezione.

I risultati dell’interrogazione vengono restituiti come testo semplice la cui formattazione dipenderà
dalle impostazioni del server WMS.

7.2.5. Visualizzazione delle proprietà del server

Una volta aggiunto un server WMS, è possibile visualizzarne le le proprietà cliccando con il tasto

destro sul suo nome nella legenda e selezionando Proprietà .

Scheda Metadata

La scheda Metadata mostra parecchie informazioni sul server WMS, generalmente raccolte
dall’affermazione Capabilities ritornata dal server all’apposita richiesta.

Molte definizioni possono essere dedotte leggendo gli standard WMS [5], [6], alcune definizioni utili
sono le seguenti:
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• Proprietà server

– Versione WMS - La versione WMS supportata dal server.

– Formati immagine - Elenco dei tipi MIME che il server può fornire per disegnare la map-
pa. QGIS supporta qualunque formato sia supportato dalle librerie Qt contro le quali è
compilato, che sono solitamente almeno image/png e image/jpeg.

– Interroga formati - L’elenco dei tipi MIME con i quali il server può fornire risposta quando
si usa lo strumento Identifica geometrie. Attualmente QGIS supporta il tipo text-plain.

• Proprietà layer

– Selezionato - Indica se il layer era selezionato quando il server è stato aggiunto al
progetto.

– Visibilità - Indica se il layer sia stato impostato come visibile in legenda. (funzione non
ancora utilizzata in questa versione di QGIS.)

– Può interrogare - Indica se il layer fornisca o meno informazioni se si usa lo strumento
Identifica geometrie.

– Può essere trasparente - Indica se il layer può essere o meno reso trasparente a video.
Questa versione di QGIS farà sempre uso della trasparenza se questa voce visualizza Sì
e se il formato immagine la supporta.

– Può ingrandire - Indica se questo layer possa o meno essere ingrandito dal server. Que-
sta versione di QGIS suppone che tutti i layer WMS abbiano questa opzione settata su Sì.
Layers carenti in questa impostazione possono essere resi a video in modo anomalo.

– Conteggio a cascata - I server WMS possono fungere da proxy per altri server WMS dai
quali ottengono i dati raster per un certo layer. La voce mostra quindi quante richieste per
questo layer vengono inoltrate ai nodi per ottenere un risultato.

– Larghezza fissa , Altezza fissa - Indica se lo layer abbia o meno una dimensione del pixel
fissata alla sorgente. Questa versione di QGIS assume che tutti i layer WMS abbiano
vuota questa voce. Layers con impostazioni diverse possono essere resi a video in modo
anomalo.

– Perimentro WGS 84 - Estensione del layer in coordinate WGS84. Alcuni server WMS
non settano questo parametro correttamente (ad es. usano coordinate UTM inve-
ce di WGS84). In questo caso sembrerà che la vista iniziale del layer sia ad uno
zoom molto ridotto. Bisognerebbe informare di questi errori il webmaster del server
WMS, il quale li dovrebbe identificare come elementi WMS XML LatLonBoundingBox,
EX_GeographicBoundingBox o CRS:84 BoundingBox.

– Disponibile in CRS - Sistemi di proiezione nel quale il layer può essere rappresentato dal
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server WMS, elencati nel formato nativo WMS.

– Disponibile in stile - Stili visuali applicabili al layer dal server WMS.

7.2.6. Limitazioni del client WMS

Non tutte le possibili funzionalità WMS sono state incluse in questa versione di QGIS. Le eccezioni
più rilevanti sono:

Modificare le impostazioni del layer WMS

Una volta completata la procedura mostrata dalla finestra Aggiungi layer WMS , non è più

possibile modificarne i parametri.

Una possibile soluzione è quella di eliminare il layer completamente e ricaricarlo reimpostando i
parametri.

Server WMS che richiedono un’autenticazione

Sono accessibili solo server pubblici. Non è infatti possibile impostare user name e password per
l’autentificazione al server WMS.

Tip 31 ACCESSO A LAYER OGC CON PASSWORD

Se fosse necessario accedere a layer protetti con password, è possibile usare InteProxy come proxy
trasparente, che supporta molti metodi di autenticazione. Ulteriori informazioni sono fornite dal manuale di
InteProxy al sito web http://inteproxy.wald.intevation.org.

7.3. Client WFS

In QGIS, un layer WFS si comporta come un qualsiasi altro layer vettoriale. È possibile identificare
e selezionare elementi e visualizzare la tabella attributi. L’unica eccezione è che al momento non
è supportata la modifica del layer. Per avviare il plugin the WFS bisogna andare alla voce di me-

nu Plugins > Gestione Plugins... , attivare la casella di controllo x plugin WFS e cliccare su

OK .

Apparirà nella barra una nuova icona per lo strumento Aggiungi layer WFS vicino all’icona

WMS. Cliccando su di essa si aprirà la finestra di dialogo. La procedura per l’aggiunta di un layer
WFS si svolge in maniera molto simile a quella vista per i WMS. La differenza sta nel fatto che non vi
sono server predefiniti, di conseguenza è necessario aggiungere manualmente quelli noti.
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7.3.1. Caricare un layer WFS

Come esempio è possibile caricare il server WFS DM Solutions e mostrare un layer. L’indirizzo da
inserire è:

http://www2.dmsolutions.ca/cgi-bin/mswfs_gmap?VERSION=1.0.0&SERVICE=

wfs&REQUEST=GetCapabilities

1. Assicurarsi che il plugin WFS sia caricato; in caso contrario aprire il QGIS Plugin Manager e
caricarlo

2. Cliccare sullo strumento Aggiungi layer WFS nella barra strumenti plugin

3. Cliccare su Nuovo

4. Inserire Nome DM Solutions come nome

5. Inserire l’indirizzo precedentemente indicato

6. Cliccare su OK

7. Selezionare Connessioni server DM Solutions H dal menu a tendina

8. Cliccare su Connetti

9. Attendere la ricezione dell’elenco dei layer

10. Cliccare sul layer Canadian Land

11. Cliccare su OK per aggiungere il layer alla mappa

12. Attendere pazientemente che gli elementi del layer appaiano nella vista mappa dopo lo
scaricamento dal server

Si noti che l’avanzamento della ricezione dei dati viene visualizzato nella parte inferiore sinistra della
finestra principale di QGIS. Quando il layer è caricato, è possibile identificare e selezionare alcuni
elementi e visualizzare la tabella attributi.

Tenere a mente che il plugin funziona al meglio con server WFS basati su UMN MapServer. Sono
ancora possibili comportamenti anomali e blocchi del plugin, ma ci saranno miglioramenti in future
versioni.
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Figura 25: Aggiunta di un layer WFS

Tip 32 TROVARE SERVER WMS E WFS

È possibile trovare ulteriori server WMS e WFS usando Google o altro motore di ricerca preferito. Ci sono
anche diversi elenchi di URL pubblici, alcuni dei quali aggiornati e altri non più mantenuti.
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QGIS consente all’utente di definire un CRS (Coordinate Reference System) globale o per ogni
singolo progetto per i layer privi di un CRS predefinito. Consente inoltre di definire sistemi di coor-
dinate personalizzati e supporta la riproiezione al volo (on-the-fly, OTF) dei layer vettoriali. Tutte
queste caratteristiche permettono all’utente di visualizzare contemporaneamente layer con diversi
CRS correttamente sovrapposti.

8.1. Panoramica del supporto alle proiezioni

QGIS supporta all’incirca 2.700 CRS noti. Le definizioni di ognuno di questi CRS sono immagazzina-
te in un database SQLite che viene installato con QGIS. Normalmente non è necessario manipolare
il database direttamente, in effetti tale operazione può causare il malfunzionamento del supporto al-
la proiezione. I CRS personalizzati sono salvati in un database utente. Si veda la sezione 8.4 per
informazioni sulla gestione dei CRS personalizzati.

I CRS disponibili in QGIS sono basati su quelli definiti da EPSG e sono largamente ispirati alle tabelle
spatial_references di PostGIS versione 1.x. Gli identificatori EPSG sono presenti nel database e
possono essere usati per richiamare e definire i CRS in QGIS.

Per usare la proiezione al volo (OTF), i dati devono contenere informazioni sul proprio sistema di
coordinate oppure bisogna definire un CRS per il layer, per il progetto oppure globale. Per layer
PostGIS QGIS usa l’identificatore dello spatial reference specificato quando il layer è stato creato.
Per i dati supportati da OGR, QGIS fa affidamento sulla presenza di un file con formato caratteristico
che definisce il CRS. Per gli shapefile, questo significa avere l’indicazione del CRS in formato Well
Known Text (WKT). Il file della proiezione ha lo stesso nome dello shapefile ma ha estensione prj.
Per esempio uno shapefile chiamato alaska.shp avrà un corrispondente file di proiezione chiamato
alaska.prj.

8.2. Specificare una proiezione

QGIS non imposta più il CRS della mappa al sistema di coordinate per primo layer caricato. Quando
si avvia una sessione QGIS con layer privi di CRS, è necessario controllare e definire il CRS di questi
layer. Questo può essere fatto globalmente o per ogni progetto nella scheda CRS sotto la voce di

menu Impostazioni > Opzioni (Si veda la Figura 26).

• x Richiesta per CRS

• x CRS predefinito utilizzato dal progetto
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• x Verrà utilizzato il seguente CRS globale predefinito visualizzato qui sotto

In QGIS il CRS globale predefinito è proj=longlat +ellps=WGS84 +datum=WGS84 +no_defs ma può
essere cambiato, la nuova impostazione verrà salvata per le successive sessioni.

Figura 26: Scheda CRS nella finestra opzioni di QGIS

Per definire il CRS di un layer privo di tale informazione, si può anche agire nella scheda Generale
della finestra delle proprietà raster (6.3.4) e delle proprietà vettore (5.4.8). Se il CRS è già stato
definito, verrà mostrato come nella figura 10.

8.3. Definire la proiezione al volo (OTF)

In QGIS la proiezione al volo (OTF) non è abilitata di default, tale funzione è attualmen-
te supportata solo per layer vettoriali. Per usare la proiezione OTF, bisogna aprire la fi-

nestra di dialogo Proprietà progetto , selezionare un CRS e attivare la casella di control-

lo x Abilita la modifica al volo della trasformazione CRS . Ci sono due modi per aprire questa
finestra:
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1. Selezionare Proprietà progetto dal menu Impostazioni .

2. Cliccare sull’icona Stato CRS nell’angolo destro della barra di stato.

Se è già stato caricato un layer, e si vuole abilitare la proiezione OTF, è buona norma aprire la scheda
Sistema di coordinate di riferimento spaziale (CRS) della finestra di dialogo Proprietà progetto

e individuare nell’elenco il CRS attualmente impostato, quindi attivare la casella di controllo

x Abilita la modifica al volo della trasformazione CRS . Ogni layer caricato successivamente sarà
quindi riproiettato al volo nel CRS definito.

La sched Sistema di coordinate di riferimento spaziale (CRS) della finestra Proprietà progetto
contiene quattro importanti componenti come individuate nella Figura 27 e di seguito descritte.

1. Abilita la modifica al volo della trasformazione CRS - questa casella di controllo è usata per
abilitare o disabilitare la proiezione OTF. Quando è deselezionata, ogni layer è tracciato usando
le coordinate lette dal dato sorgente. Se abilitata, le coordinate di ogni layer sono riproiettate
verso il sistema di coordinate definito per la mappa.

2. Coordinate del Sistema di Riferimento - è la lista di tutti i CRS supportati da QGIS, inclusi i
sitemi di coordinate geografiche, piane e quelli personalizzati. Per usare un CRS, selezionarlo
dalla lista espandendo la voce appropriata. Il CRS attivo è preselezionato.

3. Stringa Proj4 - è la stringa CRS usata dal motore per le proiezioni the Proj4. È un testo in sola
lettura a solo scopo informativo.

4. Trova - se si conosce l’identificatore EPSG o il nome del CRS che si vuole impostare, può
essere usata questa area di ricerca per trovarlo nell’elenco inserendo l’identificatore e cliccando
su Trova .

Tip 33 FINESTRA DELLE PROPRIETÀ DELLA PROIEZIONE

Se si apre la finestra Proprietà progetto dal menu Impostazioni , bisogna cliccare sulla scheda

Sistema di coordinate di riferimento spaziale (CRS) per vedere le impostazioni del CRS. Aprendo la

finestra dall’icona Stato CRS verrà portata invece immediatamente in primo piano la scheda

Sistema di coordinate di riferimento spaziale (CRS) .

8.4. Proiezione definita dall’utente

Se in QGIS non si trova la proiezione di cui si necessita, è possibile definire un CRS personalizzato.
Per fare ciò, selezionare CRS personalizzato dal menu Impostazioni . I CRS personalizzati sono
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Figura 27: Finestra di dialogo per l’impostazione della proiezione

salvati nel database utente di QGIS. Oltre ai CRS personalizzati, questo database contiene anche i
segnalibri geospaziali e altri dati personalizzati.

La definizione di un CRS personalizzato in QGIS richiede una buona comprensione delle librerie
Proj.4. Per iniziare, fare riferimento al documento Cartographic Projection Procedures for the UNIX
Environment - A User’s Manual by Gerald I. Evenden, U.S. Geological Survey Open-File Report 90-
284, 1990 (disponibile all’indirizzo ftp://ftp.remotesensing.org/proj/OF90-284.pdf). Questo
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8.4 Proiezione definita dall’utente

Figura 28: Finestra del CRS personalizzato

manuale descrive l’uso di proj.4 e delle relative utilità da riga di comando. I parametri cartografici
usati da proj.4 sono descritti nel manuale utente e sono identici a quelli usati da QGIS.

La finestra Definizione Sistema Riferimento Spaziale Personalizzato richiede solo due
parametri per definire un CRS personalizzato:

1. un nome descrittivo e

2. i parametri cartografici in formato PROJ.4.
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Per creare un nuovo CRS, cliccare il pulsante Nuovo e inserire il nome descrittivo e i parametri

CRS. Successivamente salvare il CRS cliccando sul pulsante Salva .

Si noti che la voce Parametri deve iniziare con un blocco +proj=, per rappresentare il nuovo CRS.

È possibile testare i parametri CRS per vedere se danno risultati validi cliccando sul pulsante
Calcola nella sezione Prova dopo aver incollato i parametri CRS personalizzati nel campo Pa-

rameters. Inserire valori di latitudine e longitudine WGS 84 nei campi Nord e Est rispettivamente.
Cliccare su Calcola e confrontare i risultati con i valori noti nel sistema CRS personalizzato.
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9. Integrazione con GRASS GIS

Il plugin GRASS consente l’accesso ai dati e alle funzioni di GRASS GIS [3], inclusa la visualizza-
zione di layer raster e vettoriali, la digitalizzazione di layer vettoriali, la modifica degli attributi e la
creazione di nuovi vettori, e l’analisi di dati GRASS 2D e 3D tramite più di 300 moduli GRASS.

In questa Sezione verranno forniti un’introduzione sulle funzionalità del plugin e qualche esempio
sulla gestione e l’utilizzo di dati GRASS. Quando viene abilitato il plugin GRASS come descritto alla
Sezione 9.1, nella barra sono disponibili i seguenti strumenti:

• Apri mapset

• Nuovo mapset

• Chiudi mapset

• Aggiungi vettoriale GRASS

• Aggiungi raster GRASS

• Crea nuovo vettoriale GRASS

• Modifica vettoriale GRASS

• Apri strumenti GRASS

• Visualizza GRASS regione attuale

• Modifica region GRASS attuale

9.1. Avviare il plugin GRASS

Per usare le funzioni GRASS e/o visualizzare layer raster e vettoriali in formato GRASS in QGIS,
bisogna prima selezionare e caricare il plugin GRASS con il QGIS Plugin Manager. Cliccare quindi
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sul menu Plugins > Gestione plugin , selezionare GRASS e cliccare OK .

Ora è possibile caricare layer raster e vettoriali da una LOCATION GRASS esistente (si veda la Sezione
9.2). È anche possibile creare una nuova LOCATION GRASS in QGIS (si veda la Sezione 9.3.1) e
importarci dati raster e vettoriali (si veda la Sezione 9.4) per ulteriori analisi con gli strumenti GRASS
(si veda la Sezione 9.9).

9.2. Caricare layer raster e vettoriali GRASS

Con il plugin GRASS, possono essere caricati layer raster o vettoriali usando il pulsante appropriato
nella barra strumenti. Come esempio si consideri il set di dati Alaska (si veda la Sezione 3.2).
Esso include un piccolo LOCATION GRASS campione contenente tre layer vettoriali e una mappa di
altitudine raster.

1. Creare una nuova cartella grassdata, nella quale scaricare il set di dati Alaska denomi-
nato qgis_sample_data.zip dall’indirizzo web http://download.osgeo.org/qgis/data/ e
decomprimere il file nella cartella grassdata.

2. Avviare QGIS.

3. Se non è già stato fatto in precedenti sessioni di QGIS, caricare il plugin GRASS cliccando
su Plugins > Gestione Plugin e selezionare GRASS . La barra GRASS apparirà nella barra
strumenti.

4. Nella barra strumenti GRASS, cliccare sull’icona Apri mapset per aprire la finestra
Seleziona Mapset.

5. Alla voce Gisdbase inserire l’indirizzo completo o navigare fino alla cartella grassdata appena
creata.

6. Dovrebbe ora essere possibile selezionare la LOCATION alaska e il MAPSET demo.

7. Cliccare su OK . Si noti che ora alcuni degli strumenti precedentemente disabilitati sono
divenuti attivi.

8. Cliccare su Aggiungi raster GRASS , scegliere la mappa denominata gtopo30 e cliccare

su OK . Verrà visualizzato il layer delle elevazioni del terreno.

9. Cliccare su Aggiungi vettoriale GRASS , selezionare la mappa denominata alaska e

cliccare su OK . Il confine dell’Alaska verrà sovrapposto alla mappa gtopo30 map. Ora
è possibile adattare le proprietà del layer come descritto al capitolo 5.4, ovvero cambiare la
trasparenza, il colore di riempimento e del contorno dell’elemento.
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10. Caricare anche gli altri due layer vettoriali denominati rivers e airports e modificarne le
proprietà.

Come dimostrato è quindi molto semplice caricare dati raster e vettoriali in formato GRASS
in QGIS. Si veda la sezione seguente per sapere come editare dati GRASS e creare nuove
LOCATION. Ulteriori LOCATIONs campione di GRASS sono disponibili sul siti di GRASS all’indirizzo
http://grass.osgeo.org/download/data.php.

Tip 34 CARICARE DATI GRASS
Se si presentano problemi nel caricare dati o QGIS termina inaspettatamente, assicurarsi di aver caricato il
plugin GRASS correttamente come descritto alla Sezione 9.1.

9.3. LOCATION e MAPSET in GRASS

GRASS organizza i propri in cartelle alle quali si fa riferimento con la denominazione GISDBASE.
Queste cartelle, spesso chiamate grassdata, devono essere create prima di iniziare a lavorare con
il plugin GRASS in QGIS. In queste directory, i dati GRASS sono organizzati per progetti inseriti in
sottocartelle chiamate LOCATION. Ogni LOCATION è definita da un sistema di coordinate, da un sistema
di proiezione e dall’estensione geografica. La LOCATION può avere a sua volta molte sottocartelle
MAPSETs usate per suddividere il progetto in diversi argomenti, sottoregioni o spazi di lavoro per i
diversi membri del team che vi sta lavorando (Neteler & Mitasova 2008 [2]). Per analizzare layer
raster e vettoriali con i moduli GRASS, bisogna importarli in una LOCATION GRASS. 5

9.3.1. Creare una nuova LOCATION GRASS

Per questo e per tutti i successivi esempi riguardanti GRASS GIS verrà usata la LOCATION alaska

campione, che è proiettata nel sistema Albers Equal Area con unità di misura in metri, creata dal set
di dati campione di QGIS. Sarà utile scaricare ed installare il set di dati sul proprio computer 3.2).

1. Avviare QGIS e assicurarsi che il plugin GRASS sia caricato

2. Visualizzare lo shapefile alaska.shp (si veda la Sezione 5.1.1) dal set di dati alaska 3.2.

3. Nella barra strumenti GRASS, cliccare sull’icona Nuovo mapset per avviare la

procedura guidata.

5Questo non è proprio vero - con i moduli GRASS r.external e v.external è possibile creare collegamenti in sola
lettura ai dati GDAL/OGR supportati senza che sia necessario effettuare l’importazione. Tuttavia siccome questa non è la
modalità predefinita per i principianti questa funzione non verrà descritta.
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Figura 29: Organizzazzione dei dati GRASS nella LOCATION campione alaska (adattato da Neteler &
Mitasova 2008 [2])

4. Selezionare la cartella contenente il database GRASS (GISDBASE) denominata grassdata

o crearne una nuova in cui ospitare la nuova LOCATION usando il gestore di file installato sul
proprio computer. Cliccare su Next .

5. Per creare un nuovo MAPSET in una LOCATION esistente (si veda la Sezione 9.3.2) o per creare
una nuova LOCATION, selezionare l’opzione ⊙ Crea nuova location (si veda la Figura 30).

6. Inserire il nome della LOCATION - nell’esempio abbiamo usato alaska, e cliccare su Next

7. Definire la proiezione cliccando sull’opzione ⊙ Proiezione per abilitare l’elenco delle proiezioni

8. Scegliere la proiezione Albers Equal Area Alaska (feet). Siccome ne conosciamo l’identificativo
EPSG che è 2964, inserirlo nella casella di ricerca. (Nota: se si vuole ripetere il processo
per un’altra LOCATION e non si è memorizzato l’identificativo EPSG della proiezione, cliccare

sull’icona Stato CRS nella parte destra inferiore della barra di stato (si veda la sezione
8.3)).

9. Cliccare su Trova per selezionare la proiezione

10. Cliccare su Next
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Figura 30: Creazione di una nuova LOCATION GRASS o di un nuovo MAPSET in QGIS

11. Per definire l’estensione della regione di default, bisogna inserire i limiti della LOCATION

verso nord, sud, est e ovest. Nel nostro esempio cliccare semplicemente sul pulsante
Imposta estensione attuale di QGIS , per applicare l’estensione del layer caricato alaska.shp

come estensione di default della region GRASS.

12. Cliccare su Next

13. Abbiamo anche bisogno di definire un MAPSET interno alla location LOCATION. Il nome è a scelta,
nell’esempio abbiamo usato demo. 6

14. Controllare il riassunto per assicurarsi che le impostazioni siano corrette e cliccare su Finish

15. La nuova LOCATION alaska e i MAPSETs demo e PERMANENT vengono creati. Il set di lavoro
impostato per il lavoro corrente è il MAPSET demo.

16. Si noti che alcuni strumenti della barra di GRASS precedentemente disabilitati sono ora attivi.

6Quando si crea una nuova LOCATION, GRASS crea automaticamente un MAPSET speciale chiamato PERMANENT desi-
gnato a contenere i dati di base del progetto, l’estensione spaziale di default e la definizione del sistema di coordinate
(Neteler & Mitasova 2008 [2]).
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Per quanto possa essere apparsa lunga, questa procedura costituisce un modo veloce per creare
una LOCATION. La LOCATION alaska è ora pronta per l’importazione dei dati (si veda la Sezione 9.4).
È anche possibile usare dati raster e vettoriali esistenti nella LOCATION alaska campione in formato
GRASS inclusi nel dataset alaska di QGIS 3.2 e procedere alla Sezione 9.5.

9.3.2. Aggiungere un nuovo MAPSET

Ogni utente ha accesso in scrittura solo ai MAPSET GRASS che ha creato. Ciò implica che oltre ad
accedere ai propri MAPSET, l’utente può anche leggere i dati contenuti nei MAPSETs creati da altri, ma
può modificare o rimuovere solo i dati nei suoi MAPSET. Tutti i MAPSETs includono un file denominato
WIND nel quale sono immagazzinati i valori di coordinate dei limiti della regione impostata e la risolu-
zione spaziale impostata per i raster (Neteler & Mitasova 2008 [2], si veda la Sezione 9.8). Per creare
un nuovo MAPSET:

1. Avviare QGIS e assicurarsi che il plugin GRASS sia abilitato

2. Nella barra strumenti GRASS, cliccare sull’icona Apri mapset per aprire la procedura

guidata di creazione del MAPSET.

3. Selezionare la cartella GRASS (GISDBASE) grassdata con il nome LOCATION alaska, nel
quale si vuole aggiungere un ulteriore MAPSET, che chiameremo test.

4. Cliccare su Next .

5. Con questa procedura possiamo creare un nuovo MAPSET all’interno di una LOCATION esistente i
creare anche una nuova LOCATION contemporaneamente. Cliccare sull’opzione ⊙ Selezionare
location (si veda la Figura 30) e cliccare su Next .

6. Inserire il nome test per il nuovo MAPSET. Più sotto nella finestra è visibile una lista di MAPSETs
esistenti e i relativi proprietari.

7. Cliccare su Next , controllare che il riassunto per assicurarsi che le impostazioni siano corrette

e cliccare Finish .

9.4. Importare dati nelle LOCATION GRASS

Questa Sezione fornisce un esempio su come importare dati raster e vettoriali nella LOCATION

GRASS alaska fornita dal set di dati QGIS alaska. Verrà usata la mappa raster dell’uso del suolo
landcover.img e il vettoriale poligonale denominato lakes.gml dal set di dati medesimo 3.2.

1. Avviare QGIS e assicurarsi che il plugin GRASS sia caricato.
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2. Nella barra strumenti GRASS, cliccare sull’icona Open MAPSET per avviare la finestra

di selezione MAPSET.

3. Selezionare come GRASS database la cartella grassdata nel set di dati QGIS alaska, come
LOCATION alaska, come MAPSET demo e cliccare su OK .

4. Cliccare ora sullo strumento Apri strumenti GRASS . Apparirà la finestra degli strumenti

di GRASS (si veda la Sezione 9.9).

5. Per importare la mappa raster landcover.img, cliccare sul modulo r.in.gdal nella scheda
Albero moduli . Questo modulo GRASS consente l’importazione di file supportati da GDAL

nella LOCATION GRASS. Apparirà la finestra di dialogo del modulo r.in.gdal.

6. navigare alla cartella raster nel set di dati QGIS alaska e selezionare il file landcover.img.

7. Come nome del raster in uscita inserire landcover_grass e cliccare su Esegui . Nella

scheda Output è possibile verificare l’avanzamento del comando GRASS r.in.gdal -o

input=/path/to/landcover.img output=landcover_grass.

8. Quando compare la dicitura Operazione conclusa con successo cliccare sul pulsante
Visualizza output . Il layer raster landcover_grass è ora importato in GRASS e verrà

visualizzato nella vista mappa di QGIS.

9. Per importare il vettoriale in formato shape lakes.gml, cliccae sul module v.in.ogr nella sche-
da Albero moduli . Qesto modulo GRASS consente di importare i formati vettoriali supportati
da OGR in una LOCATION GRASS. Apparirà la finestra di dialogo v.in.ogr.

10. Navigare alla cartella gml nel set di dati QGIS alaska e selezionare il file lakes.gml come file
OGR.

11. Come nome della mappa vettoriale in uscita inserire lakes_grass e cliccare su esegui .

In questo esempio è possibile trascurare le altre opzioni. Nella scheda Output è pos-
sibile verificare l’avanzamento del comando GRASS v.in.ogr -o dsn=/path/to/lakes.shp

output=lakes_grass.

12. Quando compare la dicitura Operazione conclusa con successo cliccare su
Visualizza output . Il layer vettoriale lakes_grass è ora importato in grass e verrà

visualizzato nella vista mappa di QGIS.
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9.5. Il modello di dato vettoriale in GRASS

Prima di digitalizzare dati in GRASS è importante capirne la struttura del dato vettoriale. In generale,
GRASS usa un modello di dato vettoriale topologico. Questo significa che le aree non sono rappre-
sentate con poligoni chiusi singoli, ma da uno o più contorni (boundaries). Un contorno (boundary)
tra due aree adiacenti è digitalizzato una sola volta, e condiviso da entrambe le aree. Perché un’a-
rea sia topologicamente corretta, i contorni devono essere collegati senza soluzione di continuità.
Un’area è identificata (etichettata, labeled) dal centroide dell’area stessa.

Oltre a contorni e centroidi, una mappa vettoriale può contenere anche punti e linee. Tutti questi
elementi possono essere mischiati in un singolo layer vettoriale e saranno rappresentati in cosiddetti
layer differenti in una singola mappa vettoriale di GRASS. Quindi in GRASS con layer non s’intende
una mappa raster o vettoriale bensì un livello all’interno di un dato vettoriale. Questa è una distinzione
molto importante da tenere presente. 7

È possibile salvare più layer in un set di dati vettoriale. Per esempio campi, foreste e laghi possono
essere salvati in un vettoriale. Foreste e laghi adiacenti possono condividere lo stesso contorno, ma
avranno tabelle degli attributi distinte. È anche possibile assegnare attributi ai contorni. Ad esempio
se il contorno tra un lago ed una foresta è una strada, può avere una diversa tabella degli attributi.

Il layer di un elemento è definito dal layer in GRASS. Al layer viene assegnato un indice numerico che
definisce se c’è più un gruppo geometrico nel set di dati vettoriale, ad es. se la geometria è foresta o
lago. Attualmente tale indice può essere solo un numero, in versioni di GRASS successive saranno
supportati anche i nomi dei campi nell’interfaccia utente.

Gli attributi degli elementi geometrici possono essere salvati nella LOCATION GRASS in formato
DBase o SQLITE3 o in database esterni come PostgreSQL, MySQL, Oracle, ecc.

Gli attributi contenuti nelle tabelle del database sono collegate alla geometria per mezzo di un valore
category. Category (key, ID) è un valore intero collegato alle primitive geometriche ed è usato come
collegamento ad una colonna chiave nella tabella del database.

Tip 35 CONOSCERE IL MODELLO DEL DATO VETTORIALE IN GRASS
Il miglior modo per capire il modello di dato vettoriale di GRASS e le sue capacità è quello di scaricare una
delle molte guide (tutorial) di GRASS nei quali tale modello è descritto più approfonditamente. Si veda
http://grass.osgeo.org/gdp/manuals.php per informazioni, libri e guide in diverse lingue.

7Sebbene sia possibile mescolare elementi geometrici di diverso tipo (punti, linee, contorni e centroidi), ciò è abba-
stanza insolito e perfino in GRASS viene usato solo in casi speciali come ad es. quando si esegue l’analisi di una rete
vettoriale. Di solito è preferibile che elementi geometrici diversi vengano digitalizzati su file distinti.
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9.6 Creazione di un nuovo layer vettoriale GRASS

9.6. Creazione di un nuovo layer vettoriale GRASS

Per creare un nuovo layer vettoriale GRASS tramite il plugin GRASS cliccare sullo strumento

Crea nuovo layer vettoriale GRASS . Inserire un nome nella casella di testo e iniziare la

digitalizzazione di punti, linee o poligoni, seguendo la procedura descritta alla Sezione 9.7.

Come detto in GRASS è possibile inserire ogni tipo di geometria (punti, linee ed aree) in un singolo
layer, in quanto viene impiegato un modello di dato vettoriale topologico, di conseguenza non è
necessario selezionare a priori il tipo di geometria che si intende digitalizzare quando si crea un
vettoriale in formato GRASS. In questo si differenzia ad es. dalla creazione di shapefile con QGIS,
in quanto questi ultimi usano un modello vettoriale denominato Simple Feature (si veda la Sezione
5.5.4).

Tip 36 CREAZIONE DI UNA TABELLA ATTRIBUTI PER UN NUOVO LAYER VETTORIALE GRASS
Se si desidera assegnare attributi alla geometria digitalizzata, accertarsi di definire lo schema della tabella
prima di iniziare a digitalizzare (si veda la Figura 35).

9.7. Digitalizzazione e modifica di layer vettoriali in GRASS

Gli strumenti di digitalizzazione per i layer vettoriali in GRASS sono accessibili dall’icona

Modifica vettoriale GRASS nella barra strumenti. Assicurarsi di caricare un vettoriale GRASS e
che esso sia selezionato nella legenda prima di attivare lo strumento di digitalizzazione. La Figura
32 mostra la finestra degli strumenti di digitalizzazione GRASS che viene mostrata quando si clicca
sullo strumento di modifica. Gli strumenti e le impostazioni di questa barra saranno discussi nelle
prossime sezioni.

Tip 37 DIGITALIZZARE POLIGONI IN GRASS
Per creare poligoni in GRASS, bisogna iniziare con il digitalizzarne i contorni, impostando preliminarmente il
modo Nessuna categoria. Una volta chiuso il poligono, aggiungere un centroide (marcatore dell’etichetta)
all’interno del contorno chiuso impostando preliminarmente la modalità Prossimo non in uso. Questa
procedura è necessaria in quanto il modello di dato vettoriale topologico collega le informazioni sull’attributo
del poligono sempre al centroide e non al contorno.

Barra strumenti per la modifica di dati vettoriali GRASS

Nella figura 31 sono mostrate le icone della barra strumenti per la digitalizzazione in GRASS fornita
dal plugin GRASS. La Tabella 4 mostra le funzioni disponibili.
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Figura 31: Barra strumenti di digitalizzazione GRASS

Tabella 4: Strumenti per la digitalizzazione in GRASS

Icone Strumento Scopo

Nuovo punto Digitalizza un nuovo punto

Nuova linea Digitalizza una nuova linea (annullare selezionando un altro strumento)

Nuovo contorno Digitizalizza nuovo contorno (annullare selezionando un altro strumento)

Nuovo centroide Digitalizza un nuovo centroide (imposta l’etichetta per area esitente)

Sposta vertice Sposta un vertice di un’esistente linea o contorno in una nuova posizione

Aggiungi vertice Aggiunge un vertice ad una linea o contorno esistente

Elimina vertice Cancella vertici da linee e contorni esistenti (confermare l’eliminazione del
vertice selezionato cliccando una seconda volta)

Sposta elemento Sposta il confine, la linea, il punto o il centroide selezionato in una nuova
posizione

Dividi linea Divide una linea o un contorno in due parti nel punto selezionato
(confermare cliccando una seconda volta)

Elimina elemento Elimina un contorno, una linea, un punto o un centroide esistente
(confermare cliccando una seconda volta)

Modifica attributi Edita gli attributi dell’elemento selezionato (si noti che ad un elemento
possono essere associati più attributi, si veda sopra)

Chiudi Chiudi la sessione e salva lo stato attuale (ricostruisce conseguentemente
la topologia)

Scheda Categoria

La scheda Categoria consente di definire il modo in cui i valori della categoria verranno assegnati
al nuovo elemento geometrico.

• Modalità : modalità con la quale viene assegnata la categoria (colonna cat nella tabella) alle
geometrie digitalizzate.
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Figura 32: Scheda Categoria negli strumenti per la digitalizzazione in GRASS

– Prossimo non in uso - applica il primo valore non utilizzato in ordine numerico crescente
all’elemento.

– Inserimento manuale - definizione manuale della categoria da assegnare all’elemento.

– Nessuna categoria - non assegnare alcun valore all’elemento. Questa modalità è in ge-
nere usata ad es. per i contorni dei poligoni ai quali la categoria viene collegata tramite il
centroide.

• Categoria - Il numero (ID) inserito o visualizzato viene associato ad ogni elemento digitalizzato.
Viene usato per collegare ogni elemento geometrico con i relativi attributi.

• Layer - Ogni elemento geometrico può essere collegato con molteplici tabelle attributo usando
diversi layer secondo il modello GRASS. Il layer di default è il numero 1.

Tip 38 CREARE UN LAYER GRASS AGGIUNTIVO CON QGIS
Se si vogliono aggiungere ulteriori layer al dato, inserire semplicemente un numero nel campo Layer e dare
invio. Nella scheda Tabella sarà a questo punto possibile creare il nuovo schema degli attributi da associare a
questo layer.

Scheda Preferenze

La scheda Preferenze consente di impostare la tolleranza per l’aggancio automatico tra elementi
(snapping) in pixels dello schermo. La soglia definisce a quale distanza massima nuovi punti o linee
sono agganciati ad altri nodi esistenti. Ciò aiuta ad evitare interruzioni o incroci tra contorni. Il valore
preimpostato è 10 pixels.
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Figura 33: Scheda Preferenze negli strumenti per la digitalizzazione in GRASS

Scheda Simbologia

La scheda Simbologia consente di visualizzare e impostare la simbologia e i colori dei vari tipi
geometrici nei vari stati topologici (ad es. contorni aperti/chiusi).

Figura 34: Scheda Simbologia negli strumenti per la digitalizzazione in GRASS

Scheda Tabella

La scheda Tabella fornisce informazioni sulla struttura della tabella nel database per un determi-
nato layer. Qui si possono aggiungere nuove colonne ad una tabella attributi esistente o creare un
nuovo schema tabella per un nuovo layer vettoriale GRASS o per un nuovo layer (si veda la Sezione
9.6).
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Figura 35: Scheda Tabella negli strumenti per la digitalizzazione in GRASS

Tip 39 PERMESSI DI MODIFICA IN GRASS

È necessario essere il proprietario del MAPSET GRASS che si vuole editare. Non è possibile modificare dati in
un MAPSET del quale non si è proprietari, anche se si possiedono si di esso permessi in scrittura.

9.8. Lo strumento Region di GRASS

L’impostazione di una regione (ovvero di una porzione di spazio geografico nella quale operare) è
molto importante in GRASS quando si lavora con dati raster. L’analisi vettoriale infatti di default non
è limitata dall’impostazione della regione ma viene fatta su tutta l’estensione del layer. Tutti i raster
di nuova creazione avranno l’estensione e risoluzione spaziale della regione GRASS definita, indi-
pendentemente dalla loro estensione e risoluzione originale. L’impostazione corrente della regione
GRASS è salvata nel file $LOCATION/$MAPSET/WIND che ne definisce i limiti nord, sud est e ovest, il
numero di righe e colonne e la risoluzione spaziale in senso orizzontale e verticale.

È possibile abilitare/disabilitare la visualizzazione della region di GRASS nella vista mappa in QGIS

usando il pulsante Visualizza GRASS regione attuale . .

Con lo strumento Modifica region GRASS attuale è possibile aprire una finestra di dialogo

per cambiare le impostazioni attuali della regione e la simbologia con la quale il rettangolo che la
rappresenta viene visualizzato nella vista mappa di QGIS. Inserire i nuovi limiti della regione e la
risoluzione e cliccare su OK . Lo strumento consente anche di selezionare l’estensione della regio-
ne interattivamente con il mouse nella vista mappa di QGIS. Cliccando quindi con il tasto sinistro del
mouse nella vista mappa si imposta il primo angolo del rettangolo che definirà la regione e cliccando
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in un altro punto lo si chiuderà. Cliccare quindi su OK per confermare. Il modulo GRASS g.region

mette a disposizione molti più parametri per definire l’estensione della regione e la risoluzione con
la quale si vuole condurre l’analisi raster. Si possono usare questi parametri usando lo strumento
appropriato nella barra GRASS, descritta nella Sezione 9.9.

9.9. La barra strumenti GRASS

Lo strumento Apri strumenti GRASS fornisce accesso alle funzionalità dei moduli GRASS

con i quali lavorare nella LOCATION e nel MAPSET impostati. Per usare gli strumenti di GRASS è
necessario aprire una LOCATION e un MAPSET sui quali si abbiano permessi di scrittura (in genere
concessi se si è l’utente che ha creato il MAPSET). Ciò è necessario in quanto i nuovi layer raster o
vettoriali creati durante l’analisi devono poter essere scritti nella LOCATION e nel MAPSET selezionato.

9.9.1. Lavorare con i moduli GRASS

Figura 36: Strumenti di GRASS e Lista Moduli con possibilità di ricerca

(a) Albero moduli (b) Lista moduli con casella di ricerca

La shell di GRASS negli strumenti fornisce accesso a praticamente tutti gli oltre 300 moduli GRASS
in modalità riga di comando. Per offrire un ambiente di lavoro maggiormente user-friendly, circa 200
di questi moduli e delle relative funzionalità sono presentate in finestre di dialogo. Questi modu-
li sono raggruppate in blocchi tematici ma possono anche essere cercati. Una lista completa dei
moduli GRASS disponibili nella versione di QGIS 1.4.0 è fornita in Appendice B. È anche possibile
personalizzare il contenuto degli strumenti GRASS come descritto alla Sezione 9.9.4.
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Come mostrato in Figura 36, è possibile cercare il modulo GRASS desiderato cercandolo per aree
tematiche nella scheda Albero moduli o nella scheda con casella di ricerca Lista moduli .

Cliccando sull’icona di un modulo grafico verrà aggiunta una nuova scheda alla finestra degli stru-

menti. In questa scheda si avranno tre ulteriori sottoschede denominate Opzioni , Output e

Manuale . Un esempio è mostrato in Figura 37 per il modulo v.buffer.

Figura 37: Finestre degli strumenti GRASS

(a) Scheda Opzioni (b) Scheda Output (c) Scheda Manuale

Opzioni

La scheda Opzioni fornisce una finestra semplificata nel quale di solito è possibile selezionare
un layer raster o vettoriale ed inserire ulteriori opzioni specifiche per l’esecuzione del modulo. Per
mantenere la leggibilità della finestra non sempre sono presenti tutte le opzioni, se si volessero usare
ulteriori parametri per il modulo è necessario avviare la shell di GRASS e eseguire il modulo dalla
riga di comando.

Output

La scheda Output fornisce informazioni sull’avanzamento delle operazioni eseguite dal modulo.

Quando si clicca sul pulsante Esegui , viene portata in primo piano la scheda Output nella quale
vengono visualizzate le informazioni sul processo in corso. Se l’operazione va a buon fine, si vedrà il
messaggio Operazione conclusa con successo.
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Manuale

La scheda Manual mostra la pagina di aiuto in formato HTML del modulo GRASS scelto. Qui può
essere controllata la disponibilità di ulteriori parametri o ottenere una conoscenza più approfondita
sulle operazioni che il modulo può eseguire. Ala fine di ogni pagina di manuale vi sono ulteriori
collegamenti al Main Help index, al Thematic index o al Full index. Questi link forniscono le
stesse informazioni che si avrebbero usando il modulo g.manual.

Tip 40 MOSTRARE I RISULTATI IMMEDIATAMENTE

Se si desidera visualizzare il risultato dell’analisi immediatamente nella vista mappa, è possibile cliccare sul
pulsante Visualizza Output nella porzione inferiore della scheda.

9.9.2. GRASS module examples

The following examples will demonstrate the power of some of the GRASS modules.

Creating contour lines

The first example creates a vector contour map from an elevation raster (DEM). Assuming you have
the Alaska LOCATION set up as explained in Section 9.4.

• First open the location by clicking the Open mapset button and choosing the Alaska

location.

• Now load the gtopo30 elevation raster by clicking Add GRASS raster layer and

selecting the gtopo30 raster from the demo location.

• Now open the Toolbox with the Open GRASS tools button.

• In the list of tool categories double click Raster -> Surface Management -> Generate vector
contour lines.

• Now a single click on the tool r.contour will open the tool dialog as explained above ?? . The

gtopo30 raster should appear as the Name of input raster gtopo30 .

• Type into the Increment between Contour levels 100 the value 100. (This will create contour

lines at intervals of 100 meters.)

• Type into the Name for output vector map ctour_100 the name ctour_100.
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• Click Run to start the process. Wait for several moments until the message Successfully

finished appears in the output window. Then click View Output and close .

Figura 38: GRASS Toolbox r.contour module

(a) r.contour Options (b) r.contour Output

Since this is a large region, it will take a while to display. After it finishes rendering, you can open the
layer properties window to change the line color so that the contours appear clearly over the elevation
raster, as in 5.4.

Next zoom in to a small mountainous area in the center of Alaska. Zooming in close you will notice
that the contours have sharp corners. GRASS offers the v.generalize tool to slightly alter vector maps
while keeping their overall shape. The tool uses several different algorithms with different purposes.
Some of the algorithms (i.e. Douglas Peuker and Vertex reduction) simplify the line by removing
some of the vertices. The resulting vector will load faster. This process will be used when you have
a highly detailed vector, but you are creating a very small scale map, so the detail is unnecessary.

Tip 41 THE SIMPLIFY TOOL

Note that the QGIS fTools plugin has a Simplify geometries tool that works just like the GRASS
v.generalize Douglas-Peuker algorithm.
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However, the purpose of this example is different. The contour lines created by r.contour have sharp
angles that should be smoothed. Among the v.generalize algorithms there is Chaikens which does
just that (also Hermite splines). Be aware that these algorithms can add additional vertices to the
vector, causing it to load even more slowly.

• Open the GRASS toolbox and double click the categories Vector -> Develop map ->
Generalization, then click on the v.generalize module to open its options window.

• Check that the ctour_100 vector appears as the Name of input vector ctour_100 .

• From the list of algorithms choose Chaiken’s. Leave all other options at their default, and scroll

down to the last row to enter the Name for output vector map ctour_100_smooth , and click

Run .

• The process takes several moments. Once Successfully finished appears in the output

windows, click View output and then close .

• You may change the color of the vector to display it clearly on the raster background and to
contrast with the original contour lines. You will notice that the new contour lines have smoother
corners than the original while staying faithful to the original overall shape.

Tip 42 OTHER USES FOR R.CONTOUR

The procedure described above can be used in other equivalent situations. If you have a raster map of
precipitation data, for example, then the same method will be used to create a vector map of isohyetal
(constant rainfall) lines

Creating a Hillshade 3D effect

Several methods are used to display elevation layers and give a 3D effect to maps. The use of contour
lines as shown above is one popular method often chosen to produce topographic maps. Another
way to display a 3D effect is by hillshading. The hillshade effect is created from a DEM (elevation)
raster by first calculating the slope and aspect of each cell, then simulating the sun’s position in the
sky and giving a reflectance value to each cell. Thus you get sun facing slopes lighted and the slopes
facing away from the sun (in shadow) are darkened.

• Begin this example by loading the gtopo30 elevation raster. Start the GRASS toolbox and under
the Raster category double click to open Spatial analysis -> Terrain analysis.

• Then click r.shaded.relief to open the module.

• Change the azimuth angle 270 to 315. Enter gtopo30_shade for the

Output shaded relief map gtopo30_shade new hillshade raster, and click run .
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Figura 39: GRASS module v.generalize to smooth a vector map

• When the process completes, add the hillshade raster to the map. You should see it displayed
in grayscale.

• To view both the hill shading and the colors of the gtopo30 together shift the hillshade map
below the gtopo30 map in the table of contents, then open the Properties window of gtopo30,

switch to the transparency tab and set its transparency level to about 25%.

You should now have the gtopo30 elevation with its colormap and transparency setting displayed
above the grayscale hillshade map. In order to see the visual effects of the hillshading, turn off the
gtopo30_shade map, then turn it back on.

Using the GRASS shell

The GRASS plugin in QGIS is designed for users who are new to GRASS, and not familiar with all the
modules and options. As such, some modules in the toolbox do not show all the options available,
and some modules do not appear at all. The GRASS shell (or console) gives the user access to
those additional GRASS modules that do not appear in the toolbox tree, and also to some additional
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options to the modules that are in the toolbox with the simplest default parameters. This example
demonstrates the use of an additional option in the r.shaded.relief module that was shown above.

Figura 40: The GRASS shell, r.shaded.relief module

The module r.shaded.relief can take a parameter zmult which multiplies the elevation values relative
to the X-Y coordinate units so that the hillshade effect is even more pronounced.

• Load the gtopo30 elevation raster as above, then start the GRASS tool-
box and click on the GRASS shell. In the shell window type the command:
r.shaded.relief map=gtopo30 shade=gtopo30_shade2 azimuth=315 zmult=3

and press
�

�

�

�Enter .

• After the process finishes shift to the Browse tab and double click on the new gtopo30_shade2

raster to display in QGIS.

• As explained above, shift the shaded relief raster below the gtopo30 raster in the Table of
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Contents, then check transparency of the colored gtopo30 layer. You should see that the 3D
effect stands out more strongly compared to the first shaded relief map.

Figura 41: Displaying shaded relief created with the GRASS module r.shaded.relief

Raster statistics in a vector map

The next example shows how a GRASS module can aggregate raster data and add columns of
statistics for each polygon in a vector map.

• Again using the Alaska data, refer to 9.4 to import the trees shapefile from the
vmap0_shapefiles directory into GRASS.

• Now an intermediary step is required: centroids must be added to the imported trees map to
make it a complete GRASS area vector (including both boundaries and centroids).

• From the toolbox choose Vector -> Manage features, and open the module v.centroids .

• Enter as the output vector map forest_areas and run the module.

• Now load the forest_areas vector and display the types of forests - deciduous, ever-

green, mixed - in different colors: In the layer Properties window, symbology tab, choo-

se Legend type Unique value H and set the Classification field VEGDESC to VEGDESC.
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(Refer to the explanation of the symbology tab 5.4.2 in the vector section).

• Next reopen the GRASS toolbox and open Vector -> Vector update by other maps.

• Click on the v.rast.stats module. Enter Name of raster gtopo30 , and

Name of vector polygon forest_areas .

• Only one additional parameter is needed: Enter column prefix elev , and click run . This is

a computationally heavy operation which will run for a long time (probably up to two hours).

• Finally open the forest_areas attribute table, and verify that several new columns have been
added including elev_min, elev_max, elev_mean etc. for each forest polygon.

9.9.3. Lavorare con il browser delle LOCATION GRASS

Un’altra utile funzione tra quelle presenti negli strumenti GRASS è il browser delle LOCATION. In
Figura 42 è possibile vedere un esempio che mostra la LOCATION impostata e i relativi MAPSETs.

Nella parte sinistra della finestra del browser si può navigare attraverso tutti i MAPSETs contenuti nella
LOCATION impostata. La porzione di destra mostra invece alcuni metadati del raster o del vettoria-
le selezionato, come la risoluzione, l’estensione spaziale, la fonte del dato, il percorso alla tabella
attributi associata per i dati vettoriali e lo storico comandi che ha generato quel dato.

La barra strumenti nella scheda Browser tab offre i seguenti strumenti per la gestione della
LOCATION selezionata:

• Aggiungi la mappa selezionata all’area di lavoro

• Copia la mappa selezionata

• Rinomina la mappa selezionata

• Elimina la mappa selezionata

• Imposta la regione corrente con la mappa selezionata

• Aggiorna

Gli strumenti Rinomina la mappa selezionata e Elimina la mappa selezionata funzionano
solo su mappe contenute nel MAPSET attivo. Tutti gli altri strumenti funzionano anche con layer raster
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Figura 42: Browser delle LOCATION GRASS

e vettoriali di altri MAPSET.

9.9.4. Personalizzazione degli strumenti GRASS

Praticamente tutti i moduli GRASS possono essere aggiunti agli strumenti GRASS. Per incorporare
i file XML di configurazione dei moduli è fornita un’interfaccia XML nella quale definire l’aspetto del
modulo e i parametri da visualizzare nello strumento.

Un esempio di file XML che genera il modulo v.buffer (v.buffer.qgm) ha il seguente aspetto:

<?xml version="1.0" encoding="UTF-8"?>

<!DOCTYPE qgisgrassmodule SYSTEM "http://mrcc.com/qgisgrassmodule.dtd">

<qgisgrassmodule label="Vector buffer" module="v.buffer">

<option key="input" typeoption="type" layeroption="layer" />

<option key="buffer"/>
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<option key="output" />

</qgisgrassmodule>

Il parser legge questa definizione e crea una nuova scheda negli strumenti quando si seleziona il
modulo. Informazioni più dettagliate su come aggiungere moduli, cambiare i gruppi di moduli ecc.
sono reperibile sul Wiki di QGIS all’indirizzo
http://wiki.qgis.org/qgiswiki/Adding_New_Tools_to_the_GRASS_Toolbox.
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10. Compositore di stampe

Il compositore di stampe fornisce funzionalità per la creazione di layout di stampa che saranno conti-
nuamente migliorate. Consente di aggiungere elementi al layout come la vista mappa, la legenda, la
barra di scala, immagini esterne e campi testuali. È possibile cambiare le dimensioni, raggruppare e
spostare ogni elemento e regolarne le proprietà per creare il layout desiderato. Il risultato può essere
stampato (anche come Postscript e PDF), esportato come immagine o come disegno vettoriale in
formato SVG.8 Si veda l’elenco degli strumenti nella tabella 5:

Tabella 5: Strumenti del compositore di stampe

Icona Scopo Icona Scopo

Esporta come immagine Espor

Stampa o esporta come PDF o
Postscript

Zoom

Ingrandisci Rimpicciolisci

Aggiorna la vista Aggiungi
QGIS

Aggiungi immagine al layout di stampa Aggiungi
stampa

Aggiungi una nuova legenda al layout di
stampa

Aggiungi
stampa

Seleziona/sposta oggetti del layout di
stampa

Sposta

Raggruppa oggetti del layout Separ

Alza di livello l’oggetto selezionato nel
layout

Abbassa
nel

Porta l’oggetto selezionato in primo
piano

egraphics[width=0.7cm]mActionMoveItemsToBottom Por

Per accedere al compositore di stampe, cliccare sul pulsante Print nella barra strumenti o

scegliere la voce di menu File > Compositore stampe .

8L’esportazione in SVG è supportata, ma non funziona correttamente con alcune recenti versioni di QT4. È necessario
fare delle prove e dei controlli individuali sul proprio sistema
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10.1. Uso del compositore di stampe

Prima di iniziare a lavorare con il compositore di stampe, è necessario caricare alcuni layer ra-
ster e vettoriali nella vista mappa di QGIS e regolarne le proprietà secondo le proprie esigen-

ze. Una volta effettuate tutte le impostazioni e applicata la simbologia cliccare sul pulsante

Compositore stampe .

Figura 43: Compositore di stampe

Aprendo il compositore di stampe viene visualizzato un foglio bianco al quale aggiungere vista map-
pa, legenda, barra di scala, immagini e testo. La Figura 43 mostra la vista iniziale del compositore
di stampe prima dell’aggiunta di un qualunque elemento. Nel compositore di stampe ci sono due
schede:

• La scheda Generale consente di impostare la dimensione del foglio, l’orientamento e la
qualità di stampa del file in uscita in dpi.
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• La scheda Oggetto mostra le proprietà dell’elemento selezionato nel layout di stampa. Clic-

care sull’icona Seleziona/Sposta oggetto per selezionare un elemento (ad es. legen-

da, barra di scala o etichetta testuale) nel layout. Cliccare dunque sulla scheda Oggetto e
personalizzare le impostazioni dell’elemento selezionato.

Possono essere aggiunti diversi elementi al compositore ed è anche possibile avere più di una vista
mappa o legenda o barra di scala nel layout di stampa. Ogni elemento ha le sue proprietà e, nel caso
delle viste mappa, la propria estensione.

10.1.1. Aggiungere una vista mappa al layout nel compositore di sta mpe

Per aggiungere una vista mappa, cliccare sul pulsante Aggiungi nuova mappa nella barra

strumenti del compositore di stampe e trascinare il mouse per definire un rettangolo nell’area occu-
pata dal foglio tenendo premuto il tasto sinistro per aggiungere la vista mappa. Verrà visualizzato un
riquadro vuoto con la scritta La mappa verrà stampata qui. Per visualizzare effettivamente la mappa,

selezionare Anteprima Cache H nella scheda Oggetto .

È possibile ridimensionare la mappa in un momento successivo cliccando sul pulsante

Seleziona/Sposta oggetto , selezionando un elemento e trascinando una delle maniglie blu agli an-

goli della mappa. Con la mappa selezionata, è possibile regolare ulteriori proprietà della vista mappa

nella scheda Oggetto . Ridimensionare la mappa specificando la larghezza e l’altezza o la scala.
Definire l’estensione della mappa usando i valori massimi/minimi per gli assi X e Y o cliccando sul

pulsante Imposta all’estensione della mappa . Aggiornare l’anteprima della mappa e selezionare
se si desidera avere un’anteprima della mappa dalla cache o un rettangolo vuoto con il messaggio
La mappa verrà stampata qui. Definire i colori e lo spessore del contorno della cornice dell’elemento,
impostare un colore di sfondo e l’opacità del foglio mappa. È anche possibile scegliere se visua-

lizzare o meno una cornice attorno agli elementi con la casella di controllo x Cornice (si veda la
Figura ?? ). Se si modifica la vista mappa nel programma usando lo zoom o spostando la vista o
cambiando le proprietà dei layer vettoriali o raster, è possibile aggiornare la vista nel compositore di

stampe cliccando sul pulsante Aggiorna la vista nella scheda Oggetto (si veda la Figura ?? ).

Per spostare l’area visualizzata nella vista mappa aggiunta nel compositore, cliccare sul pulsante

Sposta contenuto oggetto e spostare la vista nella cornice della vista mappa trascinando con

il tasto sinistro del mouse premuto.
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Tip 43 SALVARE UN LAYOUT DI STAMPA

Se si desidera salvare lo stato attuale di una sessione del compositore di stampe, cliccare su File >

Salva Progetto con nome per salvare lo stato dello spazio di lavoro incluso quello della sessione attuale
del compositore di stampe. In futuro sarà possibile salvare separatamente lo stato del compositore di stampa.

10.1.2. Aggiunta di altri elementi al compositore di stampa

Oltre ad aggiungere una vista mappa al layout di stampa, è anche possibile aggiungere, spostare e
personalizzare legenda, barra di scala, immagini e caselle testuali.

Etichette ed immagini

Per aggiungere una etichetta o un’immagine, cliccare sugli strumenti

Aggiungi nuova etichetta o Aggiungi immagine e posizionare gli elementi con il tasto

sinistro del mouse al layout di stampa.

Legenda e barra di scala

Per aggiungere una legenda o una barra di scala, cliccare sul pulsante

Aggiungi nuova legenda vettoriale o Aggiungi nuova barra di scala e posizionare l’elemento

con il tasto sinistro del mouse nel layout di stampa.

10.1.3. Strumenti per l’esplorazione del layout di stampa

Per l’esplorazione del layout nel compositore di stampe sono forniti quattro strumenti:

• Ingrandisci ,

• Rimpicciolisci ,

• Vista ad estensione massima e

• Aggiorna la vista , che serve nel caso in cui la vista nel layout non rispecchi quanto

presente nella vista mappa in QGIS.
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10.1.4. Creazione di file in uscita

La Figura 44 mostra il compositore di stampe con un layout di stampa completo di ognuno degli
elementi precedentemente descritti.

Figura 44: Compositore di stampe con layout completo di vista mappa, legenda, barra di scala e testo

Il compositore di stampe consente di creare diversi formati in uscita ed è possibile definirne la
risoluzione (qualità di stampa) e il formato pagina:

• L’icona Stampa consente di stampare il layout su una stampante collegata o su un file

PDF o Postscript in funzione del driver di stampa installato.

• L’icona Esporta come immagine esporta il layout in diversi formati immagine come

PNG, BPM, TIF, JPG, . . .
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• L’icona Esporta come SVG salva il layout di stampa in formato SVG (Scalable Vector

Graphic). Nota: Attualmente l’uscita in SVG è ad un livello molto iniziale. Il problema non sta
in QGIS, ma nella sottostante libreria Qt. Ci si augura che questo problema venga risolto nelle
prossime versioni della libreria.
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Quantum GIS è stato progettato con un’architettura estensibile tramite plugin. Ciò permette di ag-
giungere nuove caratteristiche e funzioni all’applicazione. Molte delle caratteristiche in QGIS sono in
effetti implementate come plugin di base Core o Esterni contribuiti dagli utenti.

• Plugins Core sono mantenuti dal team di sviluppo di QGIS e fanno automaticamente parte di
ogni distribuzione QGIS. Sono scritti in uno dei due seguenti linguaggi: C++ o Python. Ulteriori
informazioni riguardanti i plugin core sono disponibili nella sezione 12.

• Plugin Esterni sono attualmente tutti scritti in Python. Sono immagazzinati in archivi dei pac-
chetti esterni e mantenuti dai singoli autori. Possono essere aggiunti a QGIS usando il plu-
gin core chiamato Plugin Installer. Ulteriori informazioni riguardanti i plugin esterni sono
disponibili nella sezione 13.

11.1. Gestione dei plugin

La gestione dei plugin consiste nella loro abilitazione o disabilitazione usando il plugin Plugin

Manager. I plugin esterni devono prima essere installati usando il plugin Plugin Installer.

11.1.1. Abilitare un Plugin Core

L’abilitazione di un Plugin Core si ottiene dal menu principale Plugins > Manage Plugins... .

Il gestore dei plugin (QGIS Plugin Manager) elenca tutti i plugin disponibili e il loro stato (abilitato o
disabilitato). I plugin disponibili comprendono sia tutti i Core sia tutti gli Esterni che sono stati aggiunti
usando il plugin Plugin Installer (vedere la sezione 13). la figura 45 mostra la finestra di dialogo
del gestore dei plugin QGIS Plugin Manager. I plugin abilitati vengono memorizzati quando si esce
dall’applicazione, in maniera tale che al riavvio di QGIS l’utente li trovi già disponibili.

Tip 44 BLOCCO PLUGIN

Se vi accorgete che QGIS si blocca all’avvio, la colpa potrebbe essere di un plugin. È possibile disabilitare il
caricamento di tutti i plugin modificando il relativo file delle impostazioni (vedere 4.7 per localizzarlo). Una
volta individuate le impostazioni dei plugin bisogna impostare il valore di ognuno su false in modo da

impedirne il caricamento. Per esempio per disabilitare il plugin Delimited text, la modifica da effettuare sul
file $HOME/.config/QuantumGIS/qgis.conf di Linux dovrebbe apparire così: Add Delimited Text

Layer=false. Eseguire l’operazione per tutti i plugin della sezione, avviare successivamente QGIS ed
aggiungere i plugin uno alla volta tramite il gestore per determinare quale stia causando il problema.
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Figura 45: Plugin Manager

11.1.2. Caricamento di un plugin esterno in QGIS

Per integrare i plugin esterni in QGIS si deve prima caricare il plugin Plugin Installer come de-
scritto nella sezione 11.1.1. Successivamente si possono caricare i plugin esterni Python in due
passi:

1. Scaricare il plugin esterno dall’archivio dei pacchetti usando Plugin Installer (Sezione
11.1.3). Il nuovo plugin esterno verrà aggiunto alla lista dei plugin disponibili nel Plugin
Manager.

2. Caricare il plugin usando il Plugin Manager.

11.1.3. Uso dell’installatore di Plugin Python

Per scaricare e installare un plugin python esterno, selezionare il menu Plugins >

Fetch Python Plugins... . Apparirà la finestra Plugin Installer (figure 46) con il tab Plugins ,
contenente la lista sia di tutti i plugin python disponibili negli archivi remoti sia di quelli installati. Ogni
plugin può essere:
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Figura 46: Installazione di plugin Esterni Python

• not installed - significa che il plugin è disponibile nell’archivio remoto, ma non ancora installato.

Per installarlo, selezionarlo dalla lista e premere il pulsante Install plugin .

• new - idem come sopra, ma il plugin è visto per la prima volta.

• installed - il plugin è installato. Se è anche disponibile in qualsiasi archivio remoto il pulsan-

te Reinstall plugin è abilitato. Ma la versione disponibile in remoto è più vecchia di quella

installata, appare invece il pulsante Downgrade plugin .

• upgradeable - il plugin è installato, ma è disponibile una versione più recente. Il pulsante
Upgrade plugin è abilitato.

• invalid - il plugin è installato, ma è inutilizzabile. La ragione è spiegata nella descrizione del
plugin.

Plugins tab

Per installare un plugin, selezionarlo dalla lista e premere il pulsante Install plugin . Il plugin è

installato nella sua propria directory, per esempio per sotto $HOME/.qgis/python/plugins ed è
visibile solo per l’utente che lo ha installato. Vedere una lista di altre subdirectory usate per i plugin

QGIS 1.4.0 User Guide 133



11 PLUGINS DI QGIS

specifiche per ogni sistema operativo nella Sezione ?? . Se l’installazione va a buon fine, compare

un messaggio di conferma. A questo punto andare su Plugins > Manage Plugins... e caricare il
plugin installato.

Se l’installazione fallisce ne viene indicata la ragione. I problemi più frequenti sono correlati a errori
di connessione e moduli Python mancanti. Nel primo caso bisognerà attendere alcuni minuti o anche
ore, nel secondo è necessario installare nel sistema operativo i moduli mancanti prima di usare il

plugin. In Linux, i moduli più richiesti dovrebbero essere disponibili nel gestore dei pacchetti.
Per istruzioni sull’installazione in Windows, visitare la homepage del modulo. Se si usa un proxy, può

essere necessario configurarlo nel menu Settings > Options nella scheda Proxy .

Il pulsante Uninstall plugin è abilitato solo se il plugin selezionato è installato e non è un plugin
Core. Da notare che se si è installato un aggiornamento (update) di un Core plugin, si può sempre

disinstallare tale aggiornamento con il pulsante Uninstall plugin e ritornare alla versione contenuta
nel pacchetto di installazione di Quantum GIS. Ma il plugin non può venir disinstallato.

Repositories tab

La seconda scheda Repositories contiene una lista di archivi di plugin disponibili per l’installatore di
Plugin. Come impostazione di default viene usato solamente l’archivio ufficiale di QGIS (QGIS Official
Repository). Si possono aggiungere archivi contribuiti dagli utenti, incluso l’archivio centrale QGIS

Contributed Repository ed alcuni altri archivi usando il pulsante Add 3rd party repositories . Questi
archivi contengono un gran numero di plugin più o meno utili, ma bisogna tener presente che non
essendo mantenuti dal Team di Sviluppo di QGIS, quest’ultimo non se ne assume la responsabilità.
Si può anche gestire la lista dei plugin manualmente, cioè aggiungere, rimuovere o editare le singole
voci. È possibile disabilitare temporaneamente un particolare archivio usando il pulsante Edit... .

La casella di scelta x Check for updates on startup fa sì che QGIS cerchi gli aggiornamenti e
le news dei plugin. Se la funzione è selezionata tutti gli archivi elencati e abilitati nella scheda
Repositories sono verificati ogni volta che il programma viene aperto. Se è disponibile un nuovo

plugin o l’aggiornamento di uno di quelli già installati, compare una messaggio di notifica selezio-
nabile nella Barra di Stato. Se la casella di scelta non è selezionata, la ricerca di nuovi plugin e di
aggiornamenti viene effettuata solamente quando si lancia l’installatore di Plugin da menu.

Nel caso di problemi con la connessione internet, può esser visibile durante l’intera sessione di QGIS
un indicatore Looking for new plugins... nella Barra di Stato che può causare il blocco del programma
alla chiusura. In questo caso deselezionare la casella di scelta.
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11.2. Data Providers

I Data Provider sono plugin speciali che danno accesso ad un archivio di dati. Per default, QGIS
supporta i layer PostGIS e gli archivi di dati su disco supportati dalla libreria GDAL/OGR (Appendice
A.1). Un plugin Data Provider estende l’abilità di QGIS di utilizzare altre sorgenti di dati.

I plugin Data Provider sono registrati automaticamente all’avvio di QGIS. Non sono gestiti dal QGIS
Plugin Manager, ma usati dietro le quinte quando un tipo di dati viene aggiunto come layer in QGIS.
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12. Uso dei Plugin Core QGIS

QGIS 1.4.0 contiene 22 plugin di base che possono essere caricati tramite il QGIS Plugin Manager
(vedi la tabella 6).
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Tabella 6: QGIS Core Plugins

Icon Plugin Description

Aggiungi layer testo delimitato Carica e mostra file di testo delimitato contenenti coordinate x,y

Cattura Coordinate Cattura le coordinate del mouse usando SRS diverso

Etichetta di copyright Disegna una etichetta diritti d’autore con informazioni

Diagramma sovrapposto Disegna un grafico (a torta o barre) o simboli proporzionali sopra
un layer vettoriale

DXF2Shape Convertitore Converte da formato DXF a SHP

eVis Strumento di visualizzazione di eventi

fTools Insieme di strumenti per l’analisi, la geometria, l’elaborazione e la
ricerca

Strumenti GPS Strumenti per caricare e importare dati GPS

GRASS Attiva i potenti strumenti di GRASS

Georeferenziatore Aggiunge proiezioni ai file raster

Plugin di Interpolazione Interpolazione basata sui vertici di un layer vettoriale

Analisi geomorfologia Raster Calcola pendenza, esposizione, indice di asperità e curvatura
totale dei DEM

Plugin MapServer Export Esporta un progetto QGIS in un file mappa MapServer

Freccia nord Mostra una freccia che indica il nord sovrapposto alla mappa

Convertitore di layer OGR Traduce i layer vettoriali tra formati supportati OGR

OpenStreetMap Visualizza e modifica dati OpenStreetMap

Oracle Georaster Accedi a Oracle Spatial GeoRasters

Installatore di Plugin Scarica e installa i plugin QGIS python

SPIT Strumento di importazione di file shape in PostgreSQL/PostGIS

Stampa veloce Stampa rapidamente una mappa con sforzo minimo

Barra di Scala Disegna una barra di scala

WFS Carica e mostra un layer WFS
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12.1. Plugin di Cattura delle Coordinate

Il plugin di Cattura delle Coordinate è facile da usare e offre la capacità di mostrare sulla mappa
le coordinate per due Sistemi di Riferimento tramite Coordinate (Coordinate Reference Systems -
CRS). Basta cliccare un certo punto e copiare le coordinate negli appunti o usare la funzionalità di
tracciatura del mouse.

Figura 47: Plugin di cattura delle Coordinate

1. Lanciare QGIS, selezionare Proprietà Progetto dal menu Impostazioni e scegliere la

tab Sistema Riferimento Spaziale (SRS) . In alternativa, cliccare l’icona Stato SRS
nell’angolo in basso a destra della barra di stato.

2. Selezionare x Abilita la modifica immediata SRS Information NAD27/Alaska Albers con
EPSG 2964 (vedi anche la Sezione 8).

3. Caricare il layer vettoriale alaska.shp dal set di dati campione QGIS.

4. Caricare il plugin di Cattura di Coordinate nel Gestore dei Plugins (vedere la Sezione 11.1.1)

e selezionare l’icona Cattura delle Coordinate . Compare una finestra di dialogo della
Cattura di Coordinate come mostrato in Figura 47.

5. Selezionare l’icona Clicca per selezionare il SRS da usare durante la visualizzazione delle coordinate
espandere la lista Sistemi di Coordinate Geografiche e scegliere WGS84 (EPSG 4326).

6. Ora si può cliccare ovunque sulla mappa e il plugin mostrerà le coordinate NAD27/Alaska

Albers e WGS84 per il punto selezionato come mostrato nella Figura 47.
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7. Per abilitare la tracciatura mouse delle coordinate selezionare l’icona

tracciatura mouse .

8. Si possono anche copiare le coordinate selezionate negli appunti.
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12.2. Plugins Decorativi

I plugin decorativi includono il plugin Etichetta diritti d’autore, il plugin Freccia nord ed il plugin Barra
di scala. Sono usati per decorare la mappa aggiungendo elementi cartografici.

12.2.1. Plugin Etichetta diritti d’autore

Il nome del plugin è un po’ fuorviante, in realtà si può aggiungere qualsiasi testo alla mappa.

Figura 48: Plugin Etichetta di Copyright

1. Assicurarsi che il plugin sia caricato

2. Selezionare su Plugins > Decorazioni > Etichetta di Copyright o selezionare il pulsante

Etichetta di Copyright dalla barra degli Strumenti.

3. Digitare il testo che si vuole aggiungere alla mappa. Si può usare il codice HTML come mostrato
nell’esempio

4. Scegliere il posizionamento dell’etichetta dal menu a tendina Posizione In basso a destra H

5. Assicurasi che la casella x Abilita etichetta di Copyright sia selezionata

6. Premere OK
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Nell’esempio sopra, la prima linea è in grassetto, la seconda (creata usando <br>) contiene un
simbolo di copyright, seguito dal nome della nostra compagnia in corsivo.

12.2.2. Plugin Freccia nord

Il plugin Freccia nord aggiunge alla mappa una semplice freccia indicante il nord. Al momento c’è
un solo stile disponibile. Si può aggiustare manualmente l’angolo della freccia o lasciare che QGIS
indichi automaticamente la direzione. Se si sceglie di lasciar fare a QGIS, il programma fa la sua
migliore congettura circa come la freccia dovrebbe essere orientata. Per il posizionamento della
freccia si hanno quattro possibilità, corrispondenti ai quattro angoli della mappa.

Figura 49: Plugin Freccia nord

12.2.3. Plugin Barra di Scala

Il plugin Barra di scala aggiunge una semplice barra di scala alla mappa. Si può controllare lo stile
ed il posizionamento, come anche l’etichettatura della scala.

QGIS supporta solamente di mostrare la scala nella stessa unità di misura della mappa. Cioè, se
l’unità di misura dei layer è il metro, non si può creare una mappa in piedi. Allo stesso modo, se si
usano gradi decimali, non si può creare una barra di scala che mostri le distanze in metri.

Per aggiungere una barra di scala:

1. Selezionare Plugins > Decorazioni > Barra di Scala o premere il pulsante

Barra di Scala dalla barra degli Strumenti.

2. Scegliere il posizionamento dal menu a tendina Posizionamento In basso a sinistra H
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3. Scegliere lo stile dalla lista Stile della Barra di Scala Porta in basso H

4. Scegliere il colore della barra di scala Colore della barra o usare il

colore nero di default

5. Impostare la dimensione della barra e la sua etichetta Dimensione della barra 30 gradi N

H

6. Assicurarsi che la casella x Abilita barra di scala sia selezionata

7. Se si vuole, scegliere di arrotondare automaticamente il numero quando la mappa viene

ridimensionata x Arrotonda automaticamente il numero durante il ridimensionamento

8. Premere OK

Figura 50: Plugin Barra di Scala
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12.3. Plugin Testo delimitato

Il plugin Testo delimitato permette di caricare un file di testo delimitato come layer in QGIS.

Requisiti

Per vedere un file di testo delimitato come layer, il testo deve contenere:

1. Una riga capopagina delimitata di nomi di campo. Questa deve essere la prima riga del file di
testo.

2. La riga capopagina deve contenere un campo X ed uno Y. Questi campi possono avere
qualsiasi nome.

3. Le coordinate x e y devono essere specificate da numeri. Il sistema di coordinate non è
importante.

Come esempio di un file di testo valido importiamo il file di dati dell’elevazione di un punto elevp.csv

presente nel dataset di esempi di QGIS (Vedere la Sezione 3.2):

X;Y;ELEV

-300120;7689960;13

-654360;7562040;52

1640;7512840;3

[...]

Alcune note circa il file di testo:

1. Il file di testo usato come esempio usa ; come delimitatore. Qualsiasi carattere può essere
usato per delimitare i campi.

2. La prima riga è la riga capopagina. Essa contiene i campi X, Y e ELEV.

3. Nessun tipo di virgoletta () dev’essere usata per delimitare i campi di testo.

4. Le coordinate x sono contenuto nel campo X.

5. Le coordinate y sono contenuto nel campo Y.

Uso del Plugin

Per usare il plugin si deve aver QGIS in funzione ed usare il Gestore dei Plugin per caricarlo:

Avviare QGIS, quindi aprire il QGIS Plugin Manager scegliendo Plugin > Gestione Plugins

Il gestore dei plugin mostra una lista dei plugin disponibili. Quelli già caricati hanno una cro-
cetta nella casella alla sinistra del loro nome. Cliccare sulla casella alla sinistra del plugin
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x Aggiungi layer di testo delimitato e premere il pulsante OK per caricarlo come descritto nella
Sezione 11.1.

Cliccare la nuova barra degli strumenti Aggiungi layer di testo delimitato per aprire la finestra

di dialogo Aggiungi layer di testo delimitato come mostrato in Figura 51.

Figura 51: finestra di dialogo Aggiungi layer di testo delimitato

Prima selezionare il file qgis_sample_data/csv/elevp.csv per importare premendo il pulsante
Sfoglia . Una volta selezionato il file, il plugin cerca di processare il file usando l’ultimo delimitatore

utilizzato, in questo caso ;. Per processare per bene il file, è importante selezionare il giusto delimita-
tore. Per cambiare delimitatore a tab usare \t (questa è un’espressione regolare per il carattere tab).
Dopo aver cambiato il delimitatore premere Processa .

scegliere i campi X e Y dai menu a tendina e introdurre il nome di un layer elevp come mostrato in

Figura 51. Per aggiungere il layer alla mappa, premere il pulsante Aggiungi Layer . il file di testo
delimitato si comporta ora come qualsiasi altro layer di QGIS.
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12.4. Plugin Convertitore Dxf2Shp

Il plugin Convertitore dxf2shape permette di convertire i dati vettoriali dal formato DXF al formato
Shape. È molto semplice da maneggiare e offre la seguente funzionalità come mostrato in Figura
52.

• File DXF in Input : Scrivere il percorso del file DXF da convertire

• Output file : Scrivere il nome che si desidera attribuire al file Shape che verrà creato

• Tipo di file in output : Specifica il tipo di file in output. Al momento sono supportati i tipi:
polilinea, poligono e punto.

• Esporta le etichette di testo : Se si seleziona questa casella, viene creato un layer di punti
in forma di file Shape aggiuntivo, e la tabella dbf associata conterrà informazioni circa i campi
TESTO trovati nel file dxf e le stringhe di testo propriamente dette.

Figura 52: Plugin Convertitore Dxf2Shape

1. Avviare QGIS, caricare il plugin Dxf2Shape nel Gestore dei Plugins (Vedere Sezione 11.1.1)

e premere l’icona Convertitore Dxf2Shape che compare nel menu della barra degli

strumenti di QGIS. La finestra di dialogo del plugin Dxf2Shape appare come mostrato in Figura
52.

2. introdurre il file DXF in Input, un nome per il file Shape in Output ed il tipo di file Shape.

3. Abilitare la casella x Esporta le etichette di testo , se si vuole creare un layer addizionale di
punti con le etichette.

4. Premere Ok .
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12.5. eVis Plugin

The Biodiversity Informatics Facility at the American Museum of Natural History’s (AMNH) Center for
Biodiversity and Conservation (CBC) 9 has developed the Event Visualization Tool (eVis), another
software tool to add to the suite of conservation monitoring and decision support tools for guiding
protected area and landscape planning. This plugin enables users to easily link geocoded (i.e.,
referenced with latitude and longitude or X and Y coordinates) photographs, and other supporting
documents, to vector data in QGIS.

eVis is now automatically installed and enabled in new versions of QGIS, and as with all plugins, it
can be disabled and enabled using the Plugin Manager (See Section 11.1).

The eVis plugin is made up of three modules: the Database Connection tool, Event ID tool, and the
Event Browser. These work together to allow viewing of geocoded photographs and other documents
that are linked to features stored in vector files, databases, or spreadsheets.

12.5.1. Event Browser

The Event Browser module provides the functionality to display geocoded photographs that are lin-
ked to vector features displayed in the QGIS map window. Point data, for example, can be from a
vector file that can be input using QGIS or it can be from the result of a database query. The vector
feature must have attribute information associated with it to describe the location and name of the file
containing the photograph and, optionally, the compass direction the camera was pointed when the
image was acquired. Your vector layer must be loaded into QGIS before running the Event Browser.

Launch the Event Browser module

To launch the Event browser module either click on the Event Browser icon or click on

Plugins > eVis > eVis Event Browser . This will open the Generic Event Browser window.

The Generic Event Browser window has three tabs displayed at the top of the window. The Display
tab is used to view the photograph and its associated attribute data. The Options tab provides
a number of settings that can be adjusted to control the behavior of the eVis plugin. Lastly, the
Configure External Applications tab is used to maintain a table of file extensions and their associated
application to allow eVis to display documents other than images.

9This section is derived from Horning, N., K. Koy, P. Ersts. 2009. eVis (v1.1.0) User’s Guide. American Museum of
Natural History, Center for Biodiversity and Conservation. Available from http://biodiversityinformatics.amnh.org/,
and released under the GNU FDL.
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Understanding the Display window

To see the Display window click on the Display tab in the Generic Event Browser window. The
Display window is used to view geocoded photographs and their associated attribute data.

Figura 53: The eVis display window

• Display window : A window where the photograph will appear.

• Increase zoom button : Zoom in to see more detail. If the entire image cannot be displayed in
the display window, scroll bars will appear on the left and bottom sides of the window to allow
you to pan around the image.

• Reduce zoom button : Zoom out to see more area.

• Zoom to full extent button : Displays the full extent of the photograph.

• Attribute information window : All of the attribute information for the point associated with the
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photograph being viewed is displayed here. If the file type being referenced in the displayed
record is not an image but is of a file type defined in the Configure External Applications tab
then when you double-click on the value of the field containing the path to the file the application
to open the file will be launched to view or hear the contents of the file. If the file extension is
recognized the attribute data will be displayed in green.

• Navigation buttons : Use the Previous and Next buttons to load the previous or next feature
when more than one feature is selected.

• Feature indicator : This heading indicates which feature is being displayed and how many
features are available for display.

Understanding the Options window

Figura 54: The eVis Options window
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• File location : A dropdown list to specify the attribute field that contains the directory path or
URL for the photographs or other documents being displayed. If the location is a relative path
then the checkbox to the right of the dropdown menu must be clicked. The base path for a
relative path can be entered in the Base Path text box below. Information about the different
options for specifying the file location are noted in the section 4.5 below.

• Compass bearing display field : A dropdown list to specify the attribute field that contains
the compass bearing associated with the photograph being displayed. If compass bearing
information is available it is necessary to click the radio button to the left of the dropdown menu
title.

• Compass offset setting : Compass offsets can be used to compensate for declination (adjust
bearings collected using magnetic bearings to true north bearings). Click the Manual radio-
button to enter the offset in the text box or click the From Attribute radio-button to select the
attribute field containing the offsets. For both of these options east declinations should be
entered using positive values and west declinations should use negative values.

• Directory base path : The base path onto which the relative path defined in Figure 54 (A) will
be appended.

• Replace path : If this check-box is checked, only the file name from the A will be appended to
the Base Path.

• Apply rule to all documents : If checked, the same path rules that are defined for photographs
will be used for non-image documents such as movies, text documents, and sound files. If not
checked the path rules will only apply to photographs and other documents will ignore the Base
Path parameter.

• Save settings : If the check-box is checked the values for the associated parameters will be
saved for the next session when the window is closed or when the Save button below is pressed.

• Reset values : Resets the values on this line to the default setting.

• Restore faults : This will reset all of the fields to their default settings. It has the same effect as
clicking all of the Reset buttons.

• Save: This will save the settings without closing the Options pane.

Understanding the Configure External Applications window

• File reference table : A table containing file types that can be opened using eVis. Each file
type needs a file extension and the path to an application that can open that type of file. This
provides the capability of opening a broad range of files such as movies, sound recordings, and
text documents instead of only images.

• Add new file type : Add a new file type with a unique extension and the path for the application

QGIS 1.4.0 User Guide 149



12 USO DEI PLUGIN CORE QGIS

Figura 55: The eVis External Applications window

that can open the file.

• Delete current row : Delete the file type highlighted in the table and defined by a file extension
and a path to an associated application.

Specifying the location and name of a photograph

The location and name of the photograph can be stored using an absolute or relative path or a URL if
the photograph is available on a web server. Examples of the different approaches are listed in Table
?? .

Tabella 7: Example format using absolute path, relative path, and a URL

X Y FILE BEARING
780596 1784017 C:\Workshop\eVis_Data\groundphotos\DSC_0168.JPG 275
780596 1784017 /groundphotos/DSC_0169.JPG 80
780819 1784015 http://biodiversityinformatics.amnh.org/evis_test_-

data/DSC_0170.JPG

10

780596 1784017 pdf:http://www.testsite.com/attachments.php?attachment_-

id-12

76

Specifying the location and name of a other supporting documents

Supporting documents such as text documents, videos, and sound clips can also be displayed or
played by eVis. To do this it is necessary to add an entry in the file reference table that can be ac-
cessed from the Configure External Applications window in the Generic Event Browser that matches
the file extension to an application that can be used to open the file. It is also necessary to have
the path or URL to the file in the attribute table for the vector layer. One additional rule that can be
used for URLs that don’t contain a file extension for the document you want to open is to specify the
file extension before the URL. The format is - file extension:URL. The URL is preceded by the file
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extension and a colon, and is particularly useful for accessing documents from Wikis and other web
sites that use a database to manage the web pages (see Table ?? ).

Using the Generic Event Browser

When the Event Browser window opens a photograph will appear in the display window if the do-
cument referenced in the vector file attribute table is an image and if the file location information in
the Options window is properly set. If a photograph is expected and it does not appear it will be
necessary to adjust the parameters in the Options window.

If a supporting document (or an image that does not have a file extension recognized by eVis) is refe-
renced in the attribute table the field containing the file path will be highlighted in green in the attribute
information window if that file extension is defined in the file reference table located in the Configure
External Applications window. To open the document double-click on the green-highlighted line in
the attribute information window. If a supporting document is referenced in the attribute information
window and the file path is not highlighted in green then it will be necessary to add an entry for the
file’s filename extension in the Configure External Applications window. If the file path is highlighted
in green but does not open when double-clicked it will be necessary to adjust the parameters in the
Options window so the file can be located by eVis.

If no compass bearing is provided in the Options window a red asterisk will be displayed on top of
the vector feature that is associated with the photograph being displayed. If a compass bearing is
provided then an arrow will appear pointing in the direction indicated by the value in the compass
bearing display field in the Generic Event Browser window. The arrow will be centered over the point
that is associated with the photograph or other document.

To close the Generic Event Browser window click on the Close button from the Display window.

12.5.2. Event ID Tool

The Event ID module allows you to display a photograph by clicking on a feature displayed in the
QGIS map window. The vector feature must have attribute information associated with it to describe
the location and name of the file containing the photograph and optionally the compass direction the
camera was pointed when the image was acquired. This layer must be loaded into QGIS before
running the Event ID tool.

Launch the Event ID module

To launch the Event ID module either click on the Event ID icon or click on Plugins > eVis
> Event ID Tool . This will cause the cursor to change to an arrow with an“i” on top of it signifying
that the ID tool is active.
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To view the photographs linked to vector features in the active vector layer displayed in the QGIS
map window, move the Event ID cursor over the feature and then click the mouse. After clicking
on the feature, the Generic Event Browser window is opened and the photographs on or near the
clicked locality are available for display in the browser. If more than one photograph is available, you
can cycle through the different features using the Previous and Next buttons. The other controls are
described in the Event Browser section of this guide.

12.5.3. Database connection

The Database Connection module provides tools to connect to and query a database or other
ODDBC resource, such as a spreadsheet.

eVis can directly connect to four types of databases: Microsoft Access, PostgreSQL, MySQL, SQLI-
TE, and can also read from ODBC connections. When reading from an ODBC database (such as an
Excel spreadsheet) it is necessary to configure your ODBC driver for the operating system you are
using.

Launch the Database Connection module

To launch the Database Connection module either click on the appropriate icon or click

on Plugins > eVis > Database Connection . This will launch the Database Connection window.

The window has three tabs: Predefined Queries , Database Connection , and SQL Query . The
Output Console window at the bottom of the window displays the status of actions initiated by the
different sections of this module.

Connect to a database

Click on the Database Connection tab to open the database connection interface. Next, click on

the Database Type dropdown menu to select the type of database that you want to connect to. If a
password or username is required, that information can be entered in the Username and Password
textboxes.

Enter the database host in the Database Host textbox. This option is not available if you selec-
ted “MSAccess” as the database type. If the database resides on your desktop you should enter
“localhost.”

Enter the name of the database in the Database Name textbox. If you selected “ODBC” as the
database type, you need to enter the data source name.

When all of the parameters are filled in, click on the Connect button. If the connection is successful,
a message will be written in the Output Console window stating that the connection was established.
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If a connection was not established you will need to check that the correct parameters were entered
above.

Figura 56: The eVis Database connection window

• Database Type : A dropdown list to specify the type of database that will be used.

• Database Host : The name of the database host.

• Port The port number if a “MYSQL” database type is selected.

• Database Name The name of the database.

• Connect A button to connect to the database using the parameters defined above.

• Output Console The console window where messages related to processing are displayed.
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• Username : Username for use when a database is password protected.

• Password : Password for use when a database is password protected.

• Predefined Queries : Tab to open the “Predefined Queries” window.

• Database Connection : Tab to open the “Database Connection” window.

• SQL Query : Tab to open the “SQL Query” window.

• Help : Displays the on line help.

• OK: Close the main “Database Connection” window.

Running SQL queries

SQL queries are used to extract information from a database or ODBC resource. In eVis the output

from these queries is a vector layer added to the QGIS map window. Click on the SQL Query tab
to display the SQL query interface. SQL commands can be entered in this text window. A helpful
tutorial on SQL commands is available at http://www.w3schools.com/sql/. For example, to extract
all of the data from a worksheet in an Excel file, “select * from [sheet1$]” where“sheet1” is the name
of the worksheet.

Click on the Run Query button to execute the command. If the query is successful a Database File
Selection window will be displayed. If the query is not successful an error message will appear in the
Output Console widow.

In the Database File Selection window, enter the name of the layer that will be created from the
results of the query in the Name of New Layer textbox.

• SQL Query Text Window : A screen to type SQL queries.

• Run Query : Button to execute the query entered in the SQL Query Window.

• Console Window : The console window where messages related to processing are displayed.

• Help : Displays the on line help.

• OK: If this check-box is checked, only the file name from the A will be appended to the Base
Path.

• Apply rule to all documents : Closes the main “Database Connection” window.

Use the X Coordinate and Y Coordinate dropdown menus to select the field from the database
that store the “X” (or longitude) and “Y” (or latitude) coordinates. Clicking on the OK button causes
the vector layer created from the SQL query to be displayed in the QGIS map window.

To save this vector file for future use, you can use the QGIS “Save as shapefile” command that is
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Figura 57: The eVis SQL query tab

accessed by right clicking on the layer name in the QGIS map legend and then selecting “Save as
shapefile.”

Running predefined queries

With predefined queries you can select previously written queries stored in XML format in a file. This
is particularly helpful if you are not familiar with SQL commands. Click on the Predefined Queries
tab to display the predefined query interface.

To load a set of predefined queries click on the Open File icon. This opens the Open File

window which is used to locate the file containing the SQL queries. When the queries are loaded
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Tip 45 CREATING A VECTOR LAYER FROM A MICROSOFT EXCEL WORKSHEET

When creating a vector layer from a Microsoft Excel Worksheet you might see that unwanted zeros (“0”) have
been inserted in the attribute table rows beneath valid data.This can be caused by deleting the values for
these cells in Excel using the “backspace” key. To correct this problem you need to open the Excel file (you’ll
need to close QGIS if there if you are connected to the file to allow you to edit the file) and then use Edit >
Delete to remove the blank rows from the file. To avoid this problem you can simply delete several rows in the
Excel Worksheet using Edit > Delete before saving the file.

their titles, as defined in the XML file, will appear in the dropdown menu located just below the

Open File icon, the full description of the query is displayed in the text window under the dropdown
menu.

Select the query you want to run from the dropdown menu and then click on the SQL Query tab to
see that the query has been loaded into the query window. If it is the first time you are running a
predefined query or are switching databases, you need to be sure to connect to the database.

Click on the Run Query button in the SQL Query tab to execute the command. If the query is
successful a Database File Selection window will be displayed. If the query is not successful an error
message will appear in the Output Console window.

• Open Query File : Launches the “Open File” file browser to search for the XML file holding the
predefined queries.

• Predefined Queries : A dropdown list with all of the queries defined by the predefined queries
XML file.

• Query description : A short description of the query. This description is from the predefined
queries XML file.

• Console Window : The console window where messages related to processing are displayed.

• Help : Displays the on line help.

• OK: Closes the main “Database Connection” window.

XML format for eVis predefined queries

A complete sample XML file with three queries is displayed below:

<?xml version="1.0"?>

<doc>

<query>

<shortdescription>Import all photograph points</shortdescription>

<description>This command will import all of the data in the SQLite database to QGIS

</description>
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Figura 58: The eVis Perdefined queries tab

<databasetype>SQLITE</databasetype>

<databasehost />

<databaseport />

<databasename>C:\textbackslash Workshop/textbackslash

eVis\_Data\textbackslash PhotoPoints.db</databasename>

<databaseusername />

<databasepassword />

<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID</sqlstatement>

<autoconnect>false</autoconnect>

</query>

<query>

<shortdescription>Import photograph points "looking across Valley"</shortdescription>

<description>This command will import only points that have photographs "looking across

a valley" to QGIS</description>
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Tabella 8: The XML tags read by eVis

Tag Description
query Defines the beginning and end of a query statement.
shortdescription A short description of the query that appears in the eVis dropdown

menu.
description A more detailed description of the query displayed in the Predefined

Query text window.
databasetype The database type as defined in the Database Type dropdown menu in

the Database Connection tab.
databaseport The port as defined in the Port textbox in the Database Connection tab.
databasename The database name as defined in the Database Name textbox in the

Database Connection tab.
databaseusername The database username as defined in the Username textbox in the

Database Connection tab.
databasepassword The database password as defined in the Password textbox in the

Database Connection tab.
sqlstatement The SQL command.
autoconnect A flag (“true” or “false”) to specify if the above tags should be used

to automatically connect to database without running the database
connection routine in the Database Connection tab.

<databasetype>SQLITE</databasetype>

<databasehost />

<databaseport />

<databasename>C:\Workshop\eVis_Data\PhotoPoints.db</databasename>

<databaseusername />

<databasepassword />

<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID where COMMENTS=’Looking across

valley’</sqlstatement>

<autoconnect>false</autoconnect>

</query>

<query>

<shortdescription>Import photograph points that mention "limestone"</shortdescription>

<description>This command will import only points that have photographs that mention

"limestone" to QGIS</description>

<databasetype>SQLITE</databasetype>

<databasehost />

<databaseport />

<databasename>C:\Workshop\eVis_Data\PhotoPoints.db</databasename>
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<databaseusername />

<databasepassword />

<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID where COMMENTS like ’%limestone%’

</sqlstatement>

<autoconnect>false</autoconnect>

</query>

</doc>
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12.6. fTools Plugin

The goal of the fTools python plugin is to provide a one-stop resource for many common vector-based
GIS tasks, without the need for additional software, libraries, or complex workarounds. It provides a
growing suite of spatial data management and analysis functions that are both fast and functional.

fTools is now automatically installed and enabled in new versions of QGIS, and as with all plugins,
it can be disabled and enabled using the Plugin Manager (See Section 11.1). When enabled, the
fTools plugin adds a Vector menu to QGIS, providing functions ranging from Analysis and Research
Tools to Geometry and Geoprocessing Tools, as well as several useful Data Management Tools.

fTools functions

Tables 9 through 13 list the functions available via the fTools plugin, along with a brief descrip-
tion of each function. For further information on an individual fTools function, please click the

fTools Information menu item in the Vector menu.

Tabella 9: fTools Analysis tools

Analysis tools available via the fTools plugin
Icon Tool Purpose

Distance Matrix Measure distances between two point layers, and output results as a)
Square distance matrix, b) Linear distance matrix, or c) Summary of
distances. Can limit distances to the k nearest features.

Sum line length Calculate the total sum of line lengths for each polygon of a polygon
vector layer.

Points in polygon Count the number of points that occur in each polygon of an input
polygon vector layer.

List unique values List all unique values in an input vector layer field.

Basic statistic Compute basic statistics (mean, std dev, N, sum, CV) on an input field.

Nearest Neighbor
analysis

Compute nearest neighbour statistics to assess the level of clustering
in a point vector layer.

Mean
coordinate(s)

Compute either the normal or weighted mean center of an entire vector
layer, or multiple features based on a unique ID field.

Line intersections Locate intersections between lines, and output results as a point sha-
pefile. Useful for locating road or stream intersections, ignores line
intersections with length > 0.
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Tabella 10: fTools Research tools

Research tools available via the fTools plugin
Icon Tool Purpose

Random selection Randomly select n number of features, or n percentage of features

Random selection
within subsets

Randomly select features within subsets based on a unique ID field.

Random points Generate pseudo-random points over a given input layer.

Regular points Generate a regular grid of points over a specified region and export
them as a point shapefile.

Vector grid Generate a line or polygon grid based on user specified grid spacing.

Select by location Select features based on their location relative to another layer to form
a new selection, or add or subtract from the current selection.

Polygon from layer
extent

Create a single rectangular polygon layer from the extent of an input
raster or vector layer.

Tabella 11: fTools Geoprocessing tools

Geoprocessing tools available via the fTools plugin
Icon Tool Purpose

Convex
hull(s)

Create minimum convex hull(s) for an input layer, or based on an ID field.

Buffer(s) Create buffer(s) around features based on distance, or distance field.

Intersect Overlay layers such that output contains areas where both layers intersect.

Union Overlay layers such that output contains intersecting and non-intersecting
areas.

Symetrical
difference

Overlay layers such that output contains those areas of the input and
difference layers that do not intersect.

Clip Overlay layers such that output contains areas that intersect the clip layer.

Difference Overlay layers such that output contains areas not intersecting the clip layer.

Dissolve Merge features based on input field. All features with indentical input values
are combined to form one single feature.
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Tabella 12: fTools Geometry tools

Geometry tools available via the fTools plugin
Icon Tool Purpose

Check geometry Check polygons for intersections, closed-holes, and fix node ordering.

Export/Add geo-
metry columns

Add vector layer geometry info to point (XCOORD, YCOORD), line
(LENGTH), or polygon (AREA, PERIMETER) layer.

Polygon centroids Calculate the true centroids for each polygon in an input polygon layer.

Delaunay triangu-
lation

Calculate and output (as polygons) the delaunay triangulation of an input
point vector layer.

Simplify geometry Generalise lines or polygons with a modified Douglas-Peucker algorithm.

Multipart to sin-
gleparts

Convert multipart features to multiple singlepart features. Creates simple
polygons and lines.

Singleparts to
multipart

Merge multiple features to a single multipart feature based on a unique
ID field.

Polygons to lines Convert polygons to lines, multipart polygons to multiple singlepart lines.

Extract nodes Extract nodes from line and polygon layers and output them as points.

Tabella 13: fTools Data management tools

Data management tools available via the fTools plugin
Icon Tool Purpose

Export to projection Project features to new CRS and export as new shapefile.

Define projection Specify the CRS for shapefiles whose CRS has not been defined.

Join attributes Join additional attributes to vector layer attribute table and output re-
sults to a new shapefile. Additional attributes can be from a vector
layer or stand-alone dbf table.

Join attributes by
location

Join additional attributes to vector layer based on spatial relationship.
Attributes from one vector layer are appended to the attribute table of
another layer and exported as a shapefile

Split vector layer Split input layer into multiple separate layers based on input field.
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12.7. Plugin Georeferenziatore

Il Georeferenziatore permette di generare file di georeferenziazione per raster. Occorre se-
lezionare punti sul raster, aggiungere le loro coordinate ed il plugin calcola i parametri per il file di
georeferenziazione. più sono le coordinate che si forniscono, migliore sarà il risultato.

Come esempio genereremo un file di georeferenziazione per una carta topografi-
ca del Sud Dakota da SDGS. Essa potrà essere visualizzata insieme agli altri da-
ti della Location Spearfish60 di GRASS. È possibile scaricare la carta topografica qui:
http://grass.osgeo.org/sampledata/spearfish_toposheet.tar.gz

Come primo passo scaricare il file e decomprimerlo.

wget http://grass.osgeo.org/sampledata/spearfish_toposheet.tar.gz

tar xvzf spearfish_toposheet.tar.gz

cd spearfish_toposheet

Il passo successivo è avviare QGIS, caricare il plugin di georeferenziazione e selezionare il file
spearfish_topo24.tif.

Ora cliccare il pulsante Organizza le finestre di plugin per aprire l’immagine nel georeferenziatore
e organizzarla nella mappa di riferimento della mappa QGIS sulla propria scrivania (Vedere Figura
59).

Con il pulsante Aggiungi punto è possibile cominciare ad aggiungere punti sull’immagine raster ed
inserire le loro coordinate, il plugin calcolerà i parametri del file di georeferenziazione (Vedere Figura
60). Più sono le coordinate che si forniscono, migliore sarà il risultato. Per procedere ci sono due
opzioni:

1. Si può cliccare sul raster inserendo manualmente le coordinate X e Y del punto inserito

2. Si può cliccare sul raster e premere il pulsante da mappa per aggiungere le coordinate X e
Y con l’aiuto di una mappa già georeferenziata già caricata in QGIS.

Per questo esempio useremo la seconda opzione e inseriremo le coordinate per i pun-
ti selezionati con l’aiuto della mappa roads contenuta nella location spearfish60 da:
http://grass.osgeo.org/sampledata/spearfish_grass60data-0.3.tar.gz

Se non si sa come integrare la location spearfish60 con il plugin GRASS, vedere le informazioni
nella Sezione 9. Come si può vedere in Figura 60, il georeferenziatore fornisce tasti di zoom, pan,
aggiunta e rimozione di punti dall’immagine.

Dopo aver aggiunti abbastanza punti all’immagine, occorre selezionare il tipo di trasformazione per
il processo di georeferenziazione e salvare il risultante file di georeferenziazione insieme con il file
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Figura 59: Organizzare le finestre di plugin con la mappa QGIS

Tiff. Nel nostro esempio scegliamo una Transform type trasformazione lineare H anche se una

Transform type trasformazione di Helmert H sarebbe sufficiente.

I punti aggiunti alla mappa saranno salvati nel file spearfish_topo24.tif.points Insieme all’imma-
gine raster. Questo permette di riaprire il plugin Georeferenziatore e aggiungere o rimuovere punti
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Figura 60: Aggiungere punti all’immagine raster

Tip 46 SCEGLIERE IL TIPO DI TRASFORMAZIONE

La trasformazione lineare (affine) è una trasformazione di primo ordine e si usa per scalare, traslare e ruotare
immagini geometricamente corrette. Con la trasformazione di Helmert semplicemente si aggiunge
l’informazione delle coordinate all’immagine come in un geocoding. Se l’immagine è contorta, è necessario
usare software che fornisca trasformazioni polinomiali di secondo o terzo ordine, ad esempio GRASS GIS.

per ottimizzare il risultato. Il file spearfish_topo24.tif.points di quest’esempio mostra i punti:

mapX mapY pixelX pixelY

591630.196867999969982 4927104.309682800434530 591647 4.9271e+06

608453.589164100005291 4924878.995150799863040 608458 4.92487e+06

602554.903929700027220 4915579.220743400044739 602549 4.91556e+06

591511.138448899961077 4915952.302661700174212 591563 4.91593e+06

602649.526155399973504 4919088.353569299913943 602618 4.91907e+06

Usiamo le 5 coordinate dei punti per georeferenziare l’immagine raster. Per ottenere un risultato
corretto, è importante posizionare i punti con regolarità nell’immagine. Infine, si può controllare il
risultato, caricare la nuova mappa georeferenziata spearfish_topo24.tif e sovrapporla alla mappa
roads della location spearfish60.
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Figura 61: Mappa georeferenziata con la mappa roads della location spearfish60 sovrapposta
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12.8. Plugin GPS

12.8.1. Cos’è un GPS?

GPS sta per Global Positioning System ed indica un sistema satellitare che permette a chiunque
possegga un ricevitore GPS di trovare la propria posizione ovunque nel mondo. Viene usato come
ausilio nella navigazione, ad esempio in aereo, in barca o anche per semplici escursioni. Il ricevitore
GPS usa i segnali provenienti dai satelliti per calcolare la propria latitudine, longitudine and (talvolta)
elevazione. La maggior parte dei ricevitori ha anche la capacità di archiviare posizioni (note come
waypoints), sequenze di posizioni che costituiscono una rotta o route pianificata e una traccia or track
dei propri movimenti nel tempo. Waypoints, routes e tracks sono i tre elementi base dei dati GPS.
QGIS mostra i waypoints in layer di punti, mentre routes e tracks vengono mostrati in layer di linee.

12.8.2. Caricare i dati GPS da un file

Ci sono dozzine di diversi formati di file usati per archiviare dati GPS. Il formato usato da QGIS
si chiama GPX (GPS eXchange format, formato di scambio GPS), che è un formato standard di
interscambio che può contenere qualunque numero di waypoints, routes e tracks nello stesso file.

Per caricare un file GPX bisogna prima caricare il plugin. Plugins > Gestione Plugin... >

x Strumenti GPS . Quando questo plugin è caricato, un tasto indicante un piccolo dispositivo
manuale GPS compare nella barra degli strumenti. Un file GPX di esempio è disponibile nel data-
set: /qgis_sample_data/gps/national_monuments.gpx. Vedere la Sezione 3.2 per avere maggiori
informazioni sui dati di esempio.

1. Cliccare l’icona strumenti GPS e selezionare la tab Carica file GPX .

2. Sfoglia la cartella qgis_sample_data/gps/, selezionare il file GPX national_monuments.gpx

e premere Apri .

Usare il pulsante Sfoglia . . . per selezionare il file GPX, quindi selezionare con i checkbox i tipi
di dati che si desidera caricare dal file GPX. Ogni tipo di dato verrà caricato in uno layer separato
quando si preme il pulsante OK . Il file national_monuments.gpx include soltanto waypoints.

12.8.3. GPSBabel

Dato che QGIS usa file in formato GPX, è necessario un sistema per converti gli altri formati di file
GPS in GPX. Questo può essere fatto per molti formati usando il programma gratuito GPSBabel, che
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Figura 62: La finestra di dialogo Strumenti GPS

è disponibile a http://www.gpsbabel.org. Questo programma può anche trasferire i dati GPS tra
il computer e il dispositivo GPS. QGIS usa GPSBabel per fare queste cose, quindi si raccomanda
di installare questo programma. Tuttavia, se si vuole solamente caricare dati GPS da file GPX,
l’installazione non è necessaria. È noto che la versione 1.2.3 di GPSBabel funziona con QGIS, ma
non ci dovrebbero essere problemi anche con versioni successive.

12.8.4. Importazione di dati GPS

Per importare dati GPS da un file che non è in formato GPX, si può usare lo strumento
Importa un altro file nella finestra di dialogo Strumenti GPS. Qui si selezione il file che si vuole

importare, quali tipi di dati si vogliono importare da esso, dove deve essere archiviato il file convertito
GPX e quale deve esser il nome del nuovo layer.

Quando si seleziona il file da importare, si deve anche specificare il formato di quel file usando il
menu nelle finestra di dialogo di selezione file (vedere figura ?? ). non tutti i formati supportano tutti e
tre i tipi di dati, quindi per molti formati si potranno scegliere solamente uno o due tipi.

12.8.5. Scaricare dati GPS da un dispositivo

QGIS può usare GPSBabel per scaricare i dati da un dispositivo GPS direttamente in layer vettoriali.
Per questo si usa lo strumento Download dal GPS (vedere la Figura 63), dove si seleziona il tipo
di dispositivo GPS, La porta di comunicazione alla quale lo si è connesso, i tipi di dati che si vogliono
scaricare, il nome del file GPX dove i dati devono essere archiviati e il nome del nuovo layer.
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Figura 63: Lo strumento di download

Il tipo di dispositivo che si seleziona nel menu dispositivi GPS determina il modo con cui GPSBabel
cerca di comunicare con il dispositivo in questione. Se nessuno di questi tipi funziona con il dispositivo
che si ha, si può creare un tipo nuovo (vedere sezione 12.8.7).

la porta è un nome di file o un qualche altro nome che il sistema operativo usa nper riferirsi alla porta

fisica del computer cui è connesso il dispositivo GPS. In Linux è qualcosa come /dev/ttyS0 or

/dev/ttyS1 e in Windows è COM1 o COM2.

Quando si preme il pulsante OK i dati verranno scaricati dal dispositivo ed appariranno come layer
in QGIS.

12.8.6. Caricare dati GPS In un dispositivo

Si può anche caricare dati direttamente da un layer vettoriale di QGIS in un dispositivo GPS, usando

lo strumento Upload sul GPS . Il layer deve essere un layer GPX. Per far questo semplicemente si
seleziona il layer che si vuole caricare, il tipo di dispositivo GPS e la porta cui è connesso. Come per
lo strumento di download, bisogna specificare un nuov tipo di dispositivo se quello che si sta usando
non è nella lista.

Questo strumento è molto utile insieme con le capacità di pubblicazione vettoriali di QGIS. Si può ca-
ricare una mappa, creare alcuni waypoints e routes e poi caricarli ed utilizzarli nel proprio dispositivo
GPS.
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12.8.7. Definizione di un nuovo dispositivo

Ci sono molti tipi di dispositivi GPS. Gli sviluppatori di QGIS non possono testarli tutti, quindi se
se ne ha uno che non funziona con nessuno dei tipi elencati negli strumenti Download from GPS

and Upload to GPS si può definire il proprio tipo di dispositivo per esso. Questo può essere fatto

usando l’editor di periferiche GPS, che si lancia premendo il pulsante Modifica periferiche nelle
finestre di dialogo di download o di upload.

Per definire un nuovo dispositivo, semplicemente si preme il pulsante Nuova periferica , si sceglie
un nome, un comando di download ed uno di upload per il dispositivo, e infine si preme il pulsante
Aggiorna periferiche . Il nome verrà elencato nel menu dei dispositivi nelle finestre di dialogo di

upload e download, e può essere qualsiasi stringa. Il comando di download è il comando usato per
scaricare i dati dal dispositivo GPS al file GPX. Questo probabilmente sarà un comando di GPSBabel,
ma si può usare qualunque altra linea di comando che possa creare un file GPX. QGIS sostituirà le
parole chiave %type, %in, and %out quando fa funzionare il comando.

%type sarà sostituito da “-w” se si stanno scaricando waypoints, “-r” se si stanno scaricando routes
e “-t” se si stanno scaricando tracks. Queste sono opzioni della linea di comando che dicono a
GPSBabel quali tipi di dati scaricare.

%in sarà sostituito dal nome della porta scelta nella finestra di dialogo di download e %out sarà sosti-
tuito dal nome scelto per il file GPX in cui saranno archiviati i dati scaricati. Così, se si crea un tipo di
perfiferica con il comando di download “gpsbabel %type -i garmin -o gpx %in %out” (questo è in

realtà il comando di dowload per il tipo di dispositivo predefinto GPS device: Garmin serial H ) e

lo si usa poi per scaricare waypoints dalla porta “/dev/ttyS0” al file “output.gpx”, QGIS sostituirà le
parole chiave ed eseguirà il comando “gpsbabel -w -i garmin -o gpx /dev/ttyS0 output.gpx”.

Il comando di upload è il comando che si usa per caricare dati sul disposiyivo GPS. Si usano le
stesse parole chiave, ma %in è sostituita con il nome del file GPX per il layer che si sta caricando e
%out è sostituito dal nome della porta.

Per ulteriori informazioni su GPSBabel e per le opzioni disponibili per la sua lina di comando:
http://www.gpsbabel.org

Una volta creata il nuovo tipo di perfierica, essa apparirà nella lista dei dispositivi per gli strumenti di
download e upload.

QGIS 1.4.0 User Guide 170

http://www.gpsbabel.org


12.9 Interpolation Plugin

12.9. Interpolation Plugin

Il plugin di interpolazione permette d’interpolare un un layer raster TIN o IDW a partire da un layer
vettoriale caricato in QGIS. È molto semplice da maneggiare e fornisce le funzionalià mostrate in
Figura 64.

• Layer vettoriale in input : Seleziona il layer vettoriale caricato in QGIS.

• Attributo di interpolazione : Seleziona la colonna attributo usata per l’interpolazione o abilita

la casella x Usa Coordinata -Z .

• Metodo di interpolazione : Seleziona il metodo di interpolazione

Interpolazione triangolare (TIN) . . . H o Distanza Inversa Ponderata (IDW) . . . H .

• Numero di colonne/righe : definisce il numero per il file raster in output

• Output file : Definisce un nome per il file raster in output

Figura 64: Plugin di interpolazione

1. Avviare QGIS e caricare la elevp.csv tabella CSV con i punti elevazione in QGIS usando il
plugin di testo delimitato come descritto nella Sezione 12.3.ranslation for

2. Caricare il plugin di Interpolazione nel Gestore dei Plugin (see Section 11.1.1) e premere il

pulsante Interpolazione che appare nella barra menu strumenti in QGIS. la finestra di

dialogo del plugin di Interpolazione appare come in Figura 64.

3. Selezionare elevp . . . H come vettore di input e la colonna ELEV per interpolazione.

4. Selezionare Interpolazione triangolare . . . H come metodo di interpolazione, definire 3663

colonne e 1964 righe (questo è equivalente ad una risoluzione pixel di 1000 metri) come nome
del file raster di output elevation_tin.
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5. Premere Ok .

6. Premere due volte elevation_tin nella legenda della mappa per aprire la finestra di dialogo

Proprietà del Layer Raster e selezionare Pseudocolor . . . H come mappa di colore nella

scheda Simbologia . Oppure si può definire una nuova tabella di colori come descritto nella
Sezione 6.3.

Nella Figura ?? si vede il risultato di una interpolazione IDW con una risoluzione 366 colonne x 196
righe (10 km) per i dati elevp.csv visualizzati usando la tabella di colore Pseudocolor. L’elaborazione
impiega circa un paio di minuti, sebbene i dati riguardano soltanto la parte nord dell’Alaska.
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12.10. Labeling Plugin

The Labeling plugin provides smart labeling for vector point, line and polygon layers and

only requires a few parameters. This plugin will replace the current QGIS labeling and also supports
on-the-fly transformated layers.

1. Start QGIS and load a vector point, line or polygon layer.

2. Load the labeling plugin in the Plugin Manager (see Section 11.1.1), activate the layer in the

legend and click on the Labeling icon which appears in the QGIS toolbar menu.

Labeling point layers

First step is to activate the x Label this layer checkbox and select an attribute column to use for
labeling. After that you can define the label placement and text style, labeling priority, scale-based
visibility, if every part of multipart feature is to be labeled and if features act as obstacles for labels or
not (see Figure 65).

Figura 65: Smart labeling of vector point layers

Labeling line layers

First step is to activate the x Label this layer checkbox and select an attribute column to use for
labeling. After that you can define the label placement, orientation, distance to feature, text style,
labeling priority, scale-based visibility, if every part of a multipart line is to be labeled, if lines shall be
merged to avoid duplicate labels and if features act as obstacles for labels or not (see Figure 66).
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Figura 66: Smart labeling of vector line layers

Labeling polygon layers

First step is to activate the x Label this layer checkbox and select an attribute column to use for
labeling. After that you can define the label placement, distance and text style, labeling priority, scale-
based visibility, if every part of multipart feature is to be labeled and if features act as obstacles for
labels or not (see Figure 67).

Figura 67: Smart labeling of vector polygon layers
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Change engine settings

Additionally you can click the Engine settings button and select the search method, used to find
the best label placement. Available is Chain, Popmusic Tabu, Popmusic Chain, Popmusic Tabu Chain
and FALP.

Figura 68: Dialog to change label engine settings

Furthermore the number of candidates can be defined for point, line and polygon features, and you
can define whether to show all labels (including colliding labels) and label candidates for debugging.
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12.11. Plugin MapServer Export

Si può usare QGIS per comporre la propria mappa aggiungendo e arrangiando i layer, simboliz-
zandoli, personalizzando i colori, e infine creando un map file per Mapserver. Per usare il plugin
MapServer Export bisogna aver installato Python >= 2.4 nel proprio sistema e aver compilato QGIS
con il supporto per esso. Tutti i pacchetti binari includono il supporto python.

Il plugin MapServer Export in QGIS 1.4.0 è un plugin Python, il che significa che viene caricato
automaticamente nel Gestore dei Plugin come plugin core (see Section 12).

12.11.1. Creare il file Progetto

Il Plugin MapServer Export opera su un progetto QGIS salvato e non sui contenuti correnti della
finestra aperta e della sua legenda. Questo ha generato confusione per molta gente. Come descritto
più avanti, prima di cominciare ad utilizzare il Plugin MapServer Expor, è necessario predisporre i
layer vettoriali e raster che si vuole usare in MapServer e salvare queste impostazioni nel file progetto
QGIS

Figura 69: predisporre i layer vettoriali e raster in un file progetto QGIS
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In questo esempio vengono mostrati i quattro passi per arrivare ad essere pronti a creare il map file
in MapServer. Vengono usati file vettoriali e raster dal dataset campione di QGIS 3.2.

1. Aggiungere il layer raster landcover.tif premendo il tasto Aggiungere Layer Raster .

2. Aggiungere i file Shape lakes.shp, majrivers.shp e airports.shp dal dataset campionei

QGIS premendo il tasto Aggiungere Layer Vettoriale .

3. Cambiare i colri e simbilizzare i dati a piacere (vedere la Figura 69)

4. Salvare un nuovo progetto chiamato mapserverproject.qgs usando File >

Salva progetto .

12.11.2. Creazione del Map File

Lo strumento msexport per esportare un file progetto QGIS in un file mappa MapServer è instal-
lato nella directory binaria QGIS e può essere usato indipendentemente da QGIS. Da QGIs biso-
gna prima caricare il plugin MapServer Export con il QGIS Plugin Manager. Selezionare Plugins

> Gestione Plugins... per aprire il QGIS Plugin manager, scegliere il plugin MapServer Export e

premere OK . Ora avviare la finestra di dialogo MapServer Export (vedere Figura 70)

premendo il tasto nel menu strumenti.

File mappa
Scegliere un nome per il file mappa da creare. si può usare il tasto a destra per scegliere per
la directory dove si vuole che il file venga creato.

File progetto QGIS
Introdurre il percorso completo per il file progetto QGIS (.qgs) che si vuole esportare. Si può
usare il tasto a destra per cercare il file progetto QGIS.

Nome mappa
Un nome per la mappa. Questo nome è prefissato a tutte le immagini generate dal mapserver.

Larghezza mappa
Larghezza dell’immagine in output in pixel.

Altezza della mappa
Altezza dell’immagine in output in pixel.

Unità della mappa
Unità di misura usate per l’output.
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Figura 70: Finestra di dialogo MapServer Export

Tipo di immagine
Formato dell’immagine in output generata da MapServer.

Modello web
Percorso completo al file modello di Mapserver che sarà usato con il file mappa.

Intestazione web
Percorso completo al file intestazione di Mapserver che sarà usato con il file mappa.

Piede pagina web
Percorso completo al file piede pagina di Mapserver che sarà usato con il file mappa.

Soltanto gli input File Mappa e file progetto QGIS sono richiesti per creare un file maoppa, tuttavia
ci si può ritrovare con un file mappa non funzionante, a seconda di quale è l’uso che se ne vuole fare.
Anche se QGIS è capace di creare un file mappa da un file progetto, può essere necessario qualche
aggiustamento per raggiungere il risultato desiderato. Proviamo comunque a creare il file mappa
usando il file progetto mapserverproject.qgs appena creato (vedere Figura 70):

1. Aprire il Plugin MapServer Export premendo il tasto MapServer Export .

2. Introdurre il nome qgisproject.map per il nuovo file mappa.

3. Selezionare il file progetto QGIS mapserverproject.qgs appena salvato.

4. Introdurre un nome MyMap per la mappa.
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5. Introdurre 600 per la larghezza e 400 per l’altezza.

6. I layer sono in metri, quindi si cambiano le unità a metri.

7. Scegliere png come tipo d’immagine.

8. Premere OK per generare il nuovo file mappa qgisproject.map. QGIS mostrerà il risultato.

Si può visualizzare il file mappa con qualsiasi editore o visualizzatore di testo. Se si apre il file, si
noterà che lo strumento d’esportazione aggiunge i metadati necessari per abilitare la mappa per
WMS.

12.11.3. Testare il Fle Mappa

Si può testare il risultato fin qui ottenuto usando lo strumento shp2img per creare un’immagine dal
file mappa. L’utilità shp2img è parte di MapServer e FWTools. Per creare un’immagine dalla mappa:

• Aprire una finestra terminale

• Se la mappa on è stata salvata nella directory Home, cambiare alla cartelle in cui è stata salvata

• Lanciare shp2img -m qgisproject.map -o mapserver_test.png e mostrare l’immagine

Questo crea un PNG con tutti i layer inclusi nel file progetto QGIS. In aggiunta, l’estensione del PNG
sarà la stessa di quando si è salvato il progetto. Come si vede in Figura 71, tutte le informazioni
eccetto i simboli degli aeroporti sono incluse.

Se si prevede di usare il file mappa per rechieste WMS, probabilmente non sarà necessario alcun
adattamento. Se invece si prevede di usarlo con un modello di mappatura o un’interfaccia persona-
lizzata, potrebbe essere necessario un po’ di lavoro. Per vedere come è facile passare da QGIS alle
mappe di servizio sul web, vedere il flash video di 5 minuti di Christopher Schmidt. Egli usa QGIS
versione 0.8, ma è comunque utile. 10

10http://openlayers.org/presentations/mappingyourdata/
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Figura 71: Test PNG creato con shp2img con tutti i layer MapServer Export
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12.12. Plugin Convertitore Layer OGR

Il plugin convertitore layer OGR permette di convertire dati vettoriali da un formato vettoriale sup-
portato da OGR ad un altro formato vettoriale sempre supportato da OGR. È molto semplice da
maneggiare e offre funzionalità come mostrato in Figura 72. I formati supportati possono variare a
seconda del pacchetto GDAL/OGR installato.

• Sorgente Formato/Set di dati/Layer : Introduce il formato OGR e il percorso al file vettoriale
da convertire

• Destinazione Formato/Set di dati/Layer : Introduce il formato OGR e il percorso al file
vettoriale in output

Figura 72: Plugin Convertitore Layer OGR

1. lanciare QGIS, caricare il Plugin Convertitore Layer OGR nel Gestore dei Plugin (vedere Se-

zione 11.1.1) e premere il tasto Convertitore Layer OGR che appare nel menu della

barra strumenti QGIS. Appare la finestra di dialogo del plugin Convertitore Layer OGR come
mostrato in Figura 72.

2. Selezionare il formato OGR supportato ESRI Shapefile . . . H e il percorso per il file

vettoriale di input alaska.shp nell’area Sorgente.
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3. Selezionare il formato OGR supportato GML . . . H , definire un percorso e il nome per il file

vettoriale in output alaska.gml nell’area destinazione.

4. Premere Ok .
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12.13. Oracle GeoRaster Plugin

In Oracle databases, raster data can be stored in SDO_GEORASTER objects available with the

Oracle Spatial extension. In QGIS, the Oracle GeoRaster Plugin is supported by GDAL, and

depends on Oracle’s Database product being installed and working on your machine. While Oracle
is proprietary software, they provide their software free for development and testing purposes. Here
is one simple example of how to load raster images to GeoRaster:

$ gdal_translate -of georaster input_file.tif geor:scott/tiger@orcl

This will load the raster into the default GDAL_IMPORT table, as a column named RASTER.

12.13.1. Managing connections

Firstly, the Oracle GeoRaster Plugin must be enabled using the Plugin Manager (see Section 11.1.1).
The first time you load a GeoRaster in QGIS, you must create a connection to the Oracle database

that contains the data. To do this, begin by clicking on the Select GeoRaster toolbar button,

it will open the Select Oracle Spatial GeoRaster dialog window. Click on New to open the dialog
window, and specify the connection parameters (See Figure 73):

• Name: Enter a name for the database connection.

• Database instance : Enter the name of the database that you will connect to.

• Username : Specify your own username that you will use to access the database.

• Password : The password associated with your username that is required to access the
database.

Now, back on the main Oracle Spatial GeoRaster dialog window (See Figure 74), use the drop-down
list to choose one connection, and use the Connect button to establish a connection. You may

also Edit the connection by opening the previous dialog and making changes to the connection

information, or use the Delete button to remove the connection from the drop-down list.

12.13.2. Selecting a GeoRaster

Once a connection has been established, the sub-datasets window will show the names of all the
tables that contains GeoRaster columns in that database in the format of a GDAL subdataset name.
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Figura 73: Create Oracle connection dialog

Click on one of the listed subdatasets and then click on Select to choose the table name. Now
another list of subdatasets will show with the names of GeoRaster columns on that table. This is
usually a short list, since most users will not have more than one or two GeoRaster columns on the
same table.

Click on one of the listed subdatasets and then click on Select to choose one of the the ta-
ble/column combination. The dialog will now show all the rows that contains GeoRaster objects.
Note that the subdataset list will now show the Raster Data Table and Raster Id’s pairs.

At anytime the Selection entry can be edited in order to go directly to a known GeoRaster or to go
back to the beginning and select another table name.

The Selection data entry can also be used to enter a Where clause at the end
of the identification string, e.g., “geor:scott/tiger@orcl,gdal_import,raster,geoid=”. See
http://www.gdal.org/frmt_georaster.html for more information.

12.13.3. Displaying GeoRaster

Finally, by selecting a GeoRaster from the list of Raster Data Table and Raster Id’s, the raster image
will be loaded into QGIS.

The Select Oracle Spatial GeoRaster dialog window can be closed now and next time it opens it will
keep the same connection, and will show the same previous list of subdataset making it very easy to
open up another image from the same context.

Note: GeoRasters that contains pyramids will display much faster but the pyramids need to be
generated outside of QGIS using Oracle PL/SQL or gdaladdo.

The following is example using gdaladdo:
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Figura 74: Select Oracle GeoRaster dialog

gdaladdo georaster:scott/tiger@orcl,georaster\_table,georaster,georid=6 -r

nearest 2 4 6 8 16 32

This is an example using PL/SQL: cd ..

$ sqlplus scott/tiger

SQL> DECLARE

gr sdo_georaster;

BEGIN

SELECT image INTO gr FROM cities WHERE id = 1 FOR UPDATE;

sdo_geor.generatePyramid(gr, ’rLevel=5, resampling=NN’);

UPDATE cities SET image = gr WHERE id = 1;

COMMIT;

END;

/
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12.14. OpenStreetMap Plugin

In recent years the OpenStreetMap project has gained popularity because in many countries no free
geo data such as digital roadmaps are available. Target of the OSM project is to create a free editable
map of the world from GPS data, aerial photography or simply from local knowledge. To support this
idea QGIS provides a plugin that enables its users to work with OSM data.

The plugin provides all basic functionalities for OSM data manipulation, such as data loading, im-
porting, saving, downloading, editing and uploading data back to the OpenStreetMap server. While
implementing OSM plugin an inspiration was taken from existing OSM data editors. The purpose was
to combine their functionalities to get the best possible result.

The following subsection gives a brief introduction to principles of the OSM project. If you are not
interested in information on OSM just skip the next section. Parts of the following paragraphs are
copied from the OpenStreetMap web site at http://www.openstreetmap.org.

The OpenStreetMap project

OpenStreetMap is a project to create a free editable map of the world. The maps are created using
data from portable GPS devices, aerial photography, other free sources or simply from local know-
ledge. The project was started because most maps have legal or technical restrictions on their use,
holding back people from using them in creative, productive, or unexpected ways. Both rendered ima-
ges and the vector dataset of OSM are available for download under a Creative Commons Attribution
ShareAlike 2.0 licence.

OpenStreetMap was inspired by sites such as Wikipedia - the map display (see Figure 75) features
a prominent Edit tab and a full revision history is maintained. Registered users can upload GPS
track logs and edit the vector data using the given editing tools.

OSM data primitive is an object class that can be stored via the API in the server. The three supported
types of data are: Node , Way and Relation .

• A node is a latitude/longitude pair of coordinates. It is used as building a block for other features
and as a feature itself (Points Of Interest), if they are tagged as required.

• A way is a list of at least two nodes that describe a linear feature such as a street, or similar.
Nodes can be members of multiple ways.

• A relation is a group of zero or more primitives with associated roles. It is used to specify
relationships between objects, and may also model an abstract object.

Several different logical features in a common map (’Point Of Interest’, ’Street’, ’Tram Line’, ’Bus Stop’
etc.) are defined by these primitives. Map features are well-known in the OSM community and are
stored as tags, based of a key and a value. OSM is usually distibuted in XML format. XML payload is
used for the communication with the OSM server as well.
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Figura 75: OpenStreetMap data in the web

QGIS - OSM Connection

The first part of this subsection describes how OSM data primitives are displayed in QGIS vector
layers. As written above, OSM data consist of Nodes, Ways and Relations. In QGIS they are di-
splayed in three diffrent layer types: Point layer, Line layer and Polygon layer. It’s not possible to
remove any of these layers and work with the other ones.

• A Point layer displays all features of type Node that stands alone. That means that only Nodes
that are not included in any Way belongs to the Point layer.

• A Line layer displays those OSM features of type Way that are not closed. That means, none
of these Ways starts and ends with the same Node.

• A Polygon layer displays all Ways that are not included in Line layer.

OpenStreetMap has one more data primitive except for the three mentioned above. This is called
Relation . There is purposely no vector layer to display Relations. A Relation defines relation between
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any number of data primitives. After Point, Line or Polygon is identified on a map, the plugin shows a
list of all relations, the identified feature is part of.

Challenging was to design the connection between OSM data and the standard QGIS editing tools.
These tools are made to edit a single vector layer at a time, no matter of what feature types it displays.
This means that if OSM data are loaded to QGIS through the plugin, you could (theoretically) edit
Point layer, Line layer or Polygon layer with these standard tools separately.

The problem is, that Line layer consists of two different types of OSM features - Ways and Nodes.
Why? Because in OSM format a Way is composed of Nodes. If you start editing a Line layer and
change the shape of some line, your action must affect not only the OSM Way but also the OSM
Nodes that are part of it.

QGIS standard editing tools cannot tell the OSM provider, which members of which line has changed
and how. It can tell only what’s the new geometry of which line, and that’s not enough to propagate
changes to the OSM database correctly. The Line layer does also not know the identifiers of the line
members. The same problem occurs when you try to edit the Polygon layer.

For this reason, the OSM plugin need its own tools for editing OSM data. While they are used,
the OSM layers can be changed correctly. The Plugin editing tools consists of tools for Point, Line,
Polygon and Relation creation, deletion and moving.

Note: To create a connection between the OSM plugin and standard editing tools, changes in
QuantumGIS core code would be necessary.

12.14.1. Installation

The OpenStreetMap plugin is a core plugin inside QGIS. If you have python support enabled, the
’OpenStreetMap’ plugin can be selected in the Plugin Manager as described in section 11.1.1).

12.14.2. Basic user interface

The first time the OSM plugin is started (and after the first data are loaded), several new OSM plugin
icons appear in the QGIS toolbar menu together with new graphical components as shown in Figure
76:

OSM Features widget

The OSM Feature widget helps to identify OSM features. It shows basic information on feature type
and identifier as well as info on who has when changed a feature. The OSM Feature widget also
provides all editing tools (in the top part of it). More information on those tools can be found in the
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Figura 76: OSM plugin user interface

sections below. The widget is initially disabled. It activates itself after successfull loading some OSM
data.

OSM Undo/Redo widget

This Undo/Redo widget is used to undo and redo edit actions. It consists not only of a classical Undo
and Redo button, it also shows a list with a brief description of the edit actions that were done. The
OSM Undo/Redo widget is initially closed. You can show it using a button on OSM Feature widget.

Toolbar menu icons

Load OSM from file : is used to load data from a special OpenStreetMap XML file.

Show/Hide OSM Feature Manager is used to show or hide the OSM Feature widget. The

OSM Feature widget is a panel that helps with OSM feature identification and with OSM data
editing.
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Download OSM data is used to download data from the OpenStreetMap server.

Upload OSM data is used to upload changes (on current data).

Import data from a layer is used to import data from a vector layer. At least one vector layer

must be loaded and current OSM data must be selected.

Save OSM to file is used to save OSM data back to an XML file.

More detailed information on all the widgets, buttons and dialogs can be found in appropriate sections
of this plugin section according to their functionality (editing, identification, etc.).

12.14.3. Loading OSM data

The first action that should be done after starting the OSM Plugin is opening data from an OSM file.
OSM data can be import as shapefile or downloaded directly from the OpenStreetMap server. Here
we are focusing on the first mentioned method.

To load data from a file use the Load OSM from file icon. If there is no such button, maybe
someone disabled OpenStreetMap toolbar in your QGIS instalation. You can enable it again selecting
Settings > Toolbars > OpenStreetMap .

Purpose of its elements is explained below.

OpenStreetMap file to load : Click on the button to select the .osm file you want to load data from.

Add columns for tags : This option determines a connection between OSM and QGIS data. Each
feature of OSM data has some tags (pairs of key and value), that define the feature properties.
Each feature of a QGIS vector layer also has its attributes (key and value). With this option
you can define which properties of OSM objects should be visible when displaying detailed
information about QGIS features.

Replace current data : Checking this option means that new data should replace current data the
user is working with. Layers of current data will be removed and new ones will be loaded. When
loading OSM data for the first time, this option is not active, because there is nothing to replace.

Use custom renderer : This option determines how many details of the map will be used. There are
three pre-defined OSM styles for map displaying. Use Small scale if you want to view OSM

data at low level, to see all details and to edit something. If not you can use Medium scale or

Large scale . QGIS 1.4.0 doesn’t support changing the renderer style dynamically.
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Figura 77: Load OSM data dialog

Click Ok to load your data. If this is the first time OSM file is loaded, the plugin must first parse the
database. This may take few seconds or minutes - it depends on the amount of loaded data.

12.14.4. Viewing OSM data

After OSM data are loaded, you can identify map features using the appropriate tool. Use the

Identify feature button on the top-left of OSM Feature widget. Using this tool you can easily explore

all map objects. When the mouse cursor is placed over an object, you can see all information on it
directly in the OSM Feature widget. There is also a dynamic rubberband displayed on the map so
that the user is able to determine which feature is currently identified.

The Properties tab of the widget contains of all feature tags. Clicking on the Relation tab shows
you a list of all relations connected with identified feature.

If you want to hold a feature for a while to be able to read its properties and relations, move the mouse
cursor at the same time, try left-clicking while you are over the feature. Identification process will stop
until next left-clicking.

Sometimes there are more than one feature at a point where left-clicking was performed. This hap-
pens especially when clicking on cross-roads or if you didn’t zoom enough into the map. In this
situation only one of such features is identified (and marked with the rubberband) but the plugin re-
members all of them. Then (still in the pause mode) you can change identified features cyclical with
right-clicking.
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12.14.5. Editing basic OSM data

In the title of this section ’basic data’ means non-relation OSM features - nodes and ways. If you
prefer reading information on relation editing, just skip this section and read the next one.

Basic data editing is a key part of OSM Plugin. You can change property, position or shape of any
existing basic feature. You can remove features or add new ones. All such changes on nodes and
ways are remembered for comfortable usage of Undo/Redo operations and for easy upload of all
changes to OpenStreetMap server.

Changing feature tags

Changing the property/tag of an OSM feature can be done directly in the table of feature tags. The
Tags table of basic features can be found on the OSM Feature widget. Don’t forget to identify feature
first.

Figura 78: Changing an OSM feature tag

If you want to change a tag value, just double-click in the appropriate row of column ’Value’
and type or select a new value. If you want to remove a tag, click in its row, then use button
Remove selected tags on the right bottom under the table.

To add new tags just type its key and value into the last row of the table - where ’<next tag value>’ is
written. Notice that you cannot change the key of an existing tag pair. For comfortable usage, there
are some combo boxes of all existing tag keys and their typical values.

QGIS 1.4.0 User Guide 192



12.14 OpenStreetMap Plugin

Point creation,

For point creation there is a Create point button on the OSM Feature widget. To create some

points just click on the button and start clicking on the map. If your cursor is over some map feature,
the feature is marked/identified immediately. If you click on the map when a line or polygon is marked,
a new point is created directly on such line or polygon - as its new member. If your cursor is over
an existing point, new point cannot be created. In such case the OSM plugin will show following
message:

Figura 79: OSM point creation message

The mechanism of helping a user to hit the line or polygon is called snapping and is enabled by
default. If you want to create a point very close to some line (but not on it) you must disable snapping
by holding the

�

�

�

�Ctrl key first.

Line creation

For line creation there is a Create line button on the OSM Feature widget. To create a line
just click the button and start left-clicking on the map. Each of your left-clicks is remembered as a
member vertex of the new line. Line creation ends when first right-click is performed. The new line
will immediately appear on the map.

Note : A Line with less than two members cannot be created. In such case the operation is ignored.

Snapping is performed to all map vertices - points from Point vector layer and all Line and Polygon
members. Snapping can be disabled by holding the

�

�

�

�Ctrl key.

Polygon creation

For polygon creation there is a Create polygon button on the OSM Feature widget. To create a

polygon just click the button and start left-clicking on the map. Each of your left-clicks is remembered
as a member vertex of the new polygon. The Polygon creation ends when first right-click is performed.
The new polygon will immediately appear on the map. Polygon with less than three members cannot
be created. In such case operation is ignored. Snapping is performed to all map vertexes - points
(from Point vector layer) and all Line and Polygon members. Snapping can be disabled by holding
the

�

�

�

�Ctrl key.
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Map feature moving

If you want to move a feature (no matter what type) please use the Move feature button from
the OSM Feature widget menu. Then you can browse the map (features are identified dynamically
when you go over them) and click on the feature you want to move. If a wrong feature is selected
after your click, don’t move it from the place. Repeat right-clicking until the correct feature is identified.
When selection is done and you move the cursor, you are no more able to change your decision what
to move. To confirm the move, click on the left mouse button. To cancel a move, click another mouse
button.

If you are moving a feature that is connected to another features, these connections won’t be
damaged. Other features will just adapt themselves to a new position of a moved feature.

Snapping is also supported in this operation, this means:

• When moving a standalone (not part of any line/polygon) point, snapping to all map segments
and vertices is performed.

• When moving a point that is a member of some lines/polygons, snapping to all map segments
and vertices is performed, except for vertices of point parents.

• When moving a line/polygon, snapping to all map vertices is performed. Note that the OSM
Plugin tries to snap only to the 3 closest-to-cursor vertices of a moved line/polygon, otherwise
the operation would by very slow. Snapping can be disabled by holding

�

�

�

�Ctrl key during the
operation.

Map feature removing

If you want to remove a feature, you must identify it first. To remove an identified feature, use the

Remove this feature button on the OSM Feature widget. When removing a line/polygon, the
line/polygon itself is deleted, so are all its member points that doesn’t belong to any other line/polygon.

When removing a point that is member of some lines/polygons, the point is deleted and the geome-
tries of parent lines/polygons are changed. The new parent geometry has less vertices than the old
one.

If the parent feature was a polygon with three vertexes, its new geometry has only two vertexes. And
because there cannot exist polygon with only two vertices, as described above, the feature type is
automatically changed to Line.

If the parent feature was a line with two vertexes, its new geometry has only one vertex. And because
there cannot exist a line with only one vertex, the feature type is automatically changed to Point.
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12.14.6. Editing relations

Thanks to existency of OSM relations we can join OSM features into groups and give them common
properties - in such way we can model any possible map object: borders of a region (as group of
ways and points), roads of a bus, etc. Each member of a relation has its specific role. There is a
pretty good support for OSM Relations in our plugin. Let’s see how to examine, create, update or
remove them.

Examining relation

If you want to see relation properties, first identify one of its members. After that open the Relations
tab on the OSM Feature widget. At the top of the tab you can see a list of all relations the identified
feature is part of. Please choose the one you want to examine and look at its information below. In
the first table called ’Relation tags’ you find the properties of the selected relation. In the table called
’Relation members’ you see brief information on the relation members. If you click on a member, the
plugin will make a rubberband on it in the map.

Relation creation

There are 2 ways to create a relation:

1. You can use the Create relation button on OSM Feature widget.

2. You can create it from the Relation tab of OSM Feature widget using the Add relation
button.

In both cases a dialog will appear. For the second case, the feature that is currently identified is
automatically considered to be the first relation member, so the dialog is prefilled a little. When
creating a relation, please select its type first. You can select one of predefined relation types or write
your own type. After that fill the relation tags and choose its members.

If you have already selected a relation type, try using the Generate tags button. It will gene-

rate typical tags to your relation type. Then you are expected to enter values to the keys. Choosing

relation members can be done either by writing member identifiers, types and roles or using the

identify tool and clicking on map.

Finally when type, tags and members are chosen, the dialog can be submitted. In such case the
plugin creates a new relation for you.
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Changing relation

If you want to change an existing relation, identify it first (follow steps written above in Section ’E-

xamining relation’). After that click on the Edit relation button. You will find it on the OSM
Feature widget. A new dialog appears, nearly the same as for the ’create relation’ action. The dialog
is pre-filled with information on given relations. You can change relation tags, members or even its
type. After submiting the dialog your changes will be commited.

12.14.7. Downloading OSM data

To download data from OpenStreetMap server click on the Download OSM data button. If
there is no such button, the OSM toolbar may be disabled in your QGIS instalation. You can enable
it again at Settings > Toolbars > OpenStreetMap . After clicking the button a dialog occurs and
provides following functionalities:

Figura 80: OSM download dialog

Extent : Specifies an area to download data from intervals of latitude and longitude degrees. Becau-
se there is some restriction of OpenStreetMap server on how much data can be downloaded,
the intervals must not be too wide. More detailed info on extent specification can is shown after

clicking the help button on the right.

Download to : Here you are expected to write a path to the file where data will be stored. If you
can’t remember the structure of your disk, don’t panic. The browse button will help you.

Open data automatically after download : Determines, if the download process should be followed
by loading the data process or not. If you prefer not to load data now, you can do it later by

using the Load OSM from file button.
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Replace current data : This option is active only if ⊙ Open data automatically after download is
checked. Checking this option means that downloaded data should replace current data we
are working with now. Layers of the current data will be removed and new ones will be loaded.
When starting QGIS and downloading OSM data for the first time, this option is initially inactive,
because there is nothing to replace.

Use custom renderer : This option is active only if the ⊙ Open data automatically after download
checkbox is checked. It determines how many details will be in the map. There are three
predefined OSM styles for map displaying. Use Small scale if you want to view OSM data

at low level, to see all details and to edit something. If not you can use Medium scale or

Large scale . QGIS 1.4.0 does not support changing the renderer style dynamically.

Click the Download button to start the download process.

A progress dialog will continuously inform you about how much of data is already downloaded.
When an error occures during the download process, a dialog tells you why. When action finishes
succesfully both the progress dialog and download dialog will close themselves.

12.14.8. Uploading OSM data

Note that the upload is always done on current OSM data. Before opening the OSM Upload dialog,
please be sure that you really have the right active layer OSM data.

To upload current data to the OSM server click on the Upload OSM data button. If there is no

such button, OSM toolbar in your QGIS installation is disabled. You can enable it again in Settings

> Toolbars > OpenStreetMap . After clicking the upload button a new dialog will appear.

At the top of the dialog you can check, if you are uploading the correct data. There is a short name
of a current database. In the table you find information on how many changes will be uploaded.
Statistics are displayed separately for each feature type.

In the ’Comment on your changes’ box you can write brief information on meaning of your upload
operation. Just write in brief what data changes you’ve done or let the box empty. Fill ’OSM account’
arrays so that the server could authenticate you. If you don’t have an account on the OSM server,

it’s the best time to create one at http://www.openstreetmap.org. Finally use Upload to start an
upload operation.
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Figura 81: OSM upload dialog

12.14.9. Saving OSM data

To save data from a current map extent to an XML file click on the Save OSM to file button. If
there is no such button, the OSM toolbar in your QuantumGIS installation is probably disabled. You
can enable it again in Settings > Toolbars > OpenStreetMap . After clicking on the button a new
dialog appears.

Select features you want to save into XML file and the file itself. Use the Ok button to start the
operation. The process will create an XML file, in which OSM data from your current map extent are
represented. The OSM version of the output file is 0.6. Elements of OSM data (<node>, <way>,
<relation>) do not contain information on their changesets and uids. These informations are not
compulsory yet, see DTD for OSM XML version 0.6. In the output file OSM elements are not ordered.

Notice that not only data from the current extent are saved. Into the output file the whole polygons
and lines are saved even if only a small part of them is visible in the current extent. For each saved
line/polygon all its member nodes are saved too.
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Figura 82: OSM saving dialog

12.14.10. Import OSM data

To import OSM data from an opened non-OSM vector layer follow this instructions: Choose current

OSM data by clicking on one of their layers. Click on the Import data from a layer button.

If there is no such button, someone has probably disable the OpenStreetMap toolbar in your QGIS
installation. You can enable it again in Settings > Toolbars > OpenStreetMap .

After clicking on the button following message may show up:

Figura 83: OSM import message dialog

In such case there is no vector layer currently loaded. The import must be d one from a loaded layer
- please load a vector layer from which you want to import data. After a layer is opened, your second
try should give you a better result (don’t forget to mark the current OSM layer again):

Use the submit dialog to start the process of OSM data importing. Reject it if you are not sure you
want to import something.
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Figura 84: Import data to OSM dialog
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12.15. Raster Terrain Modelling Plugin

The Raster Terrain Modelling plugin can be used to calculate the slope, aspect, ruggedness, and
total curvature for digital elevation models (DEM). It is very simple to handle and provides an intiui-
tive graphical user interface for creating new raster layers (See Figure 85). The plugin requires the
following parameters to be specified before running:

• Analysis : Can be one of slope, aspect, ruggedness, or total curvature

• Input layer : Specify the input raster from a list of loaded raster layers.

• Output layer : Specify a name and path for the output raster file.

• Output format : Specify a format type for the output raster file (Default is GeoTiff).

Slope: Calculates slope angle for each cell in degrees (based on first order derivative estimation).

Aspect: Exposition (starting with 0 for north direction, in degrees counterclockwise).

Ruggedness factor: A quantitative measurement of terrain heterogeneity.

Total curvature: A curvature measure that combines plan- and profile curvature.

Figura 85: Raster Terrain Modelling Plugin
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Using the plugin

1. Start QGIS and load a DEM raster layer.

2. Load the Raster Terrain Modelling plugin in the Plugin Manager (see Section 11.1.1) and click

on the Raster Terrain Modelling icon which appears in the QGIS toolbar menu. The

Raster Terrain Modelling plugin dialog appears as shown in Figure 85.

3. Select an analysis method (e.g. Slope ).

4. Specify an output file path, and an output file type.

5. Click Ok .
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12.16. Plugin Stampa veloce

Il plugin Quick Print permette di stampare la mappa corrente in formato PDF con il minimo
sforzo. Tutto quello che l’utente deve fare è aggiungere un Titolo Mappa, un Nome Mappa e scegliere
la dimensione della pagina (Vedere Figura 86).

Figura 86: Finestra di dialogo per la stampa veloce (Quick Print)

Figura 87 qui sotto mostra il risultato di una stampa veloce DIN A4 dal dataset campione dell’Alaska.
Se si vuole maggior controllo sul layout della mappa, è meglio usare il plugin Compositore di Stampe,
descritto nella Sezione 10.
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Figura 87: Risultato ottenuto con Quick Print come DIN A4 PDF
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12.17. Other core plugins

The remaining core plugins are listed in Table 14, along with references to the chapters in this manual
which cover their usage.

Tabella 14: Other Core Plugins

Icon Plugin Manual Reference

Diagram Overlay Chapter ??

GRASS Chapter 9 and Appendix B

Plugin Installer Chapter 11.1.3

SPIT Chapter 5.2.4

WFS Chapter ??
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13. Uso dei Plugin esterni QGIS Python

I plugin esterni QGIS sono scritti in Python e sono mantenuti sia negli archivi ’Official’ e ’User contri-
buted’, sia in vari altri archivi esterni moderati dai singoli autori. La tabella 15 mostra una lista di plugin
attualmente disponibili nell’archivio ’Official’, con una breve descrizione. Documentazione dettagliata
sull’uso, la minima versione di QGIS richiesta, l’homepage, gli autori e altre importanti informazioni
vengono fornite insieme con gli stessi plugin esterni e non sono incluse in questo manuale. 11 12

Si può trovare una lista aggiornata dei plugin ’Official’ nell’archivio ufficiale di QGIS in
http://qgis.osgeo.org/download/plugins.html. Questa lista è inoltre disponibile automatica-

mente dal Plugin installer via Scarica Python Plugins... .

Tabella 15: Attuali Plugin QGIS esterni moderati

Icona Plugin esterno Descrizione

Zoom al punto Fa lo zoom alle coordinate specificate nella finestra di dialogo di
input. Si può specificare il livello di zoom così come il controllo
dell’estensione della vista.

Installatore di Plugin La versione più recente dell’Installatore di plugin Python.

Una descrizione dettagliata della procedura di installazione per i plugin python esterni si può trovare
nella Sezione 11.1.2.

Tip 47 AGGIUNGI ALTRI ARCHIVI

Per aggiungere l’archivio ’User contributed’ e/o altri archivi di autori esterni, aprire l’Installatore di plugin

( plugins > Fetch Python Plugins... ), andare alla scheda Repositories e premere

Aggiungi repository di terze parti . Se non si vuole uno o più degli archivi aggiunti, disabilitarli con il tasto

Edit... o rimuoverli completamente con il tasto Delete .

11Gli aggiornamenti dei plugin core possono essere disponibili in questo archivio come fonte esterna.
12I plugin fTools, Mapserver Export e Installer sono anch’essi plugin Python, ma sono parte del sorgente QGIS, e sono

caricati automaticamente e selezionabili nel gestore dei plugin QGIS Plugin Manager (vedere Sezione 11.1.2).
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14.1. Mailinglist

QGIS è attivamente in sviluppo e come tale non sempre funziona come ci si aspetterebbe. La
maniera migliore di avere aiuto è registrarsi in una mailing list di utenti QGIS: qgis-users.

qgis-users

Le tue domande raggiungerà un pubblico più ampio e della risposta beneficeranno anche altri. Ci si
può registrare alla mailing list qgis-users vistitando il sito:
http://lists.osgeo.org/mailman/listinfo/qgis-user

qgis-developer

Se si è sviluppatori alle prese con problemi di natura più tecnica, si può registrarsi alla mailing list
qgis-developer:
http://lists.osgeo.org/mailman/listinfo/qgis-developer

qgis-commit

Ogni volta che viene fatto un commit all’archivio codici QGIS, viene postata una e-mail in questa lista.
Se si vuole essere informati di ogni cambiamento alla base codici attuale, si può registrarsi:
http://lists.osgeo.org/mailman/listinfo/qgis-commit

qgis-trac

Questa lista fornisce motifiche e-mail in relazione alla gestione del progetto, inclusi rapporti di mal-
funzionamenti, obiettivi, e richieste di funzioni e caratteristiche. Per registrarsi a questa lista:
http://lists.osgeo.org/mailman/listinfo/qgis-trac

qgis-community-team

Questa lista si occupa di argomenti come la documentazione, aiuto contestuale, guida utente, espe-
rienza online incluso siti web, blog, mailing list, forum, e impegno di traduzione. Se si vuole anche
lavorare su una guida utente, questa lista è un buon punto di partenza per far domande. si può
registrarsi a:
http://lists.osgeo.org/mailman/listinfo/qgis-community-team

qgis-release-team

Questa lista si occupa di argomenti come il processo di rilascio, la creazione di pacchetti dei codici
binari per i diversi sistemi operativi e l’annuncio al mondo del rilascio di nuove versioni. Si può
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sottoscrivere a:
http://lists.osgeo.org/mailman/listinfo/qgis-release-team

qgis-psc

Questa lista è usata per discutere questioni di pertinenza della Commissione Direttiva, cioè inerenti
la generale gestione e direzione di Quantum GIS. Si può sottoscrivere a:
http://lists.osgeo.org/mailman/listinfo/qgis-psc

Siete i benvenuti a registrarvi in queste liste. Ricordate di contribuire alle liste fornendo risposte e
condividendo le vostre esperienze. Tenete presente che qgis-commit e qgis-trac sono progettate
come mezzo di notifica e non per accogliere post degli utenti.

14.2. IRC

Siamo anche presenti su IRC - visitateci registrandovi al canale #qgis su irc.freenode.net. Si pre-
ga di attendere un po’ per le risposte, dato che molte persone sul canler fanno anche altre cose e
quindi ci può volere un po’ di tempo per notare la vostra domanda. È disponibile anche un suppor-
to commerciale per QGIS. Vedere questo sito http://qgis.org/content/view/90/91 per ulteriori
informazioni.

Se vi siete persi una discussione su IRC, non è un problema! Viene mantenuto registro di tutte le
discussioni, così è più facile stare al passo. Basta andare su http://logs.qgis.org e leggere i log
IRC.

14.3. Tracciatore di malfunzionamenti (Bug Tracker)

Mentre la mailing list qgis-users è utile per generiche domande come fare xyz in QGIS, potre-
ste voler notificare noi per eventuali malfunzionamenti di QGIS. Potete farlo usando il tracciato-
re di malfunzionamenti a https://trac.osgeo.org/qgis/. Quando si crea un nuovo ticket per
un malfunzionamento, fornire un indirizzo e-mail al quale noi possiamo richiedere informazioni
aggiuntive.

Per favore ricordate che i vostri malfunzionamenti non sempre hanno la priorità che sperate (a se-
conda della gravità). Alcuni possono richiedere un significativo sforzo di sviluppo per rimediare e la
forza lavoro non è sempre disponibile per questo.

Anche la richiesta di funzionalità può essere inoltrata usando lo stesso sistema di ticket come per i
malfunzionamenti. Si prega di assicurarsi di selezionare il tipo enhancement.

Se avete trovato un malfunzionamento e l’avete risolto da soli, potete inoltrare anche questa ripara-
zione. Di nuovo, il simpatico sistema di ticket a https://trac.osgeo.org/qgis/ ha anche questa
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14.4 Blog

tipologia. Selezionare patch dal menu dei tipi. Qualcuno degli sviluppatori ne farà una revisione e lo
applicherà in QGIS.
Per favore, non allarmatevi se la vostra riparazione non viene applicata subito - gli sviluppatori
possono essere impegnati in altri lavori.

14.4. Blog

La comunità QGIS mantiene anche un weblog (BLOG) a http://blog.qgis.org che ha alcuni arti-
coli interessanti per gli utenti come per gli sviluppatori. Siete invitati a contribuire al blog dopo esservi
registrati!

14.5. Wiki

Infine, manteniamo anche un sito web WIKI a http://wiki.qgis.org dove potete trovare una varietà
di utili informazioni correlate allo sviluppo di QGIS, ai piani di rilascio di nuove versioni, collegamenti
ai siti da cui scaricare, consiglio di traduzione del messaggio e così via. Esplorateli, ci sono cose
molto interessanti dentro.
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A FORMATI SUPPORTATI

A. Formati supportati

A.1. Formati OGR supportati

Alla data di stesura di questo documento, i seguenti formati sono supportati dalla libreria OGR. I
formati che sono supportati anche da QGIS sono indicati in grassetto .

• Arc/Info Binary Coverage

• Comma Separated Value (.csv)

• DODS/OPeNDAP

• Shapefile ESRI

• FMEObjects Gateway

• GML

• IHO S-57 (ENC)

• Mapinfo File

• Microstation DGN

• OGDI Vectors

• ODBC

• Oracle Spatial

• PostgreSQL13

• SDTS

• SQLite

• UK .NTF

• U.S. Census TIGER/Line

• VRT - Virtual Datasource

13QGIS implementa le proprie funzioni PostgreSQL. OGR dovrebbe essere compilato con il supporto a PostgreSQL
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A.2 Formati raster GDAL supportati

A.2. Formati raster GDAL supportati

Alla data di stesura di questo documento, la libreria GDAL supporta i seguenti formati. Si noti che
non è detto che tutti funzionino in QGIS per varie ragioni. Per esempio, alcuni formati necessitano di
librerie esterne con licenza commerciale e quindi non liberamente distribuibili con QGIS. Nella lista
dei formati visibile quando si carica un raster in QGIS sono presenti solo quei formati che sono stati
ben testati. Altri formati possono essere caricati selezionando il filtro Tutti gli altri file (*) filter. I formati
dei quali è nonto il funzionamento il QGIS è indicato in grassetto .

• Arc/Info ASCII Grid

• Arc/Info Binary Grid (.adf)

• Microsoft Windows Device Independent Bitmap (.bmp)

• BSB Nautical Chart Format (.kap)

• VTP Binary Terrain Format (.bt)

• CEOS (Spot for instance)

• First Generation USGS DOQ (.doq)

• New Labelled USGS DOQ (.doq)

• Military Elevation Data (.dt0, .dt1)

• ERMapper Compressed Wavelets (.ecw)

• ESRI .hdr Labelled

• ENVI .hdr Labelled Raster

• Envisat Image Product (.n1)

• EOSAT FAST Format

• FITS (.fits)

• Graphics Interchange Format (.gif)

• GRASS Rasters 14

• TIFF / GeoTIFF (.tif)

• Hierarchical Data Format Release 4 (HDF4)

• Erdas Imagine (.img)

14Il supporto ai raster GRASS in QGIS è fornito dall’apposito plugin
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A FORMATI SUPPORTATI

• Atlantis MFF2e

• Japanese DEM (.mem)

• JPEG JFIF (.jpg)

• JPEG2000 (.jp2, .j2k)

• JPEG2000 (.jp2, .j2k)

• NOAA Polar Orbiter Level 1b Data Set (AVHRR)

• Erdas 7.x .LAN and .GIS

• In Memory Raster

• Atlantis MFF

• Multi-resolution Seamless Image Database MrSID

• NITF

• NetCDF

• OGDI Bridge

• PCI .aux Labelled

• PCI Geomatics Database File

• Portable Network Graphics (.png)

• Netpbm (.ppm,.pgm)

• USGS SDTS DEM (*CATD.DDF)

• SAR CEOS

• USGS ASCII DEM (.dem)

• X11 Pixmap (.xpm)
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B. Moduli degli strumenti GRASS

La shell di GRASS avviabile dagli strumenti GRASS fornisce accesso a praticamente tutti (oltre 300)
moduli GRASS in modalità riga di comando. Per offrire un ambiente di lavoro più confortevole per
l’utente, all’incirca 200 di questi moduli e funzionalità sono disponibili con interfaccia grafica.

B.1. Moduli negli strumenti GRASS per l’importazione e l’esp ortazione di dati

Questa sezione elenca tutti i moduli con interfaccia grafica presenti tra gli strumenti GRASS per
importare ed esportare dati nella location e mapset impostato.

B.2. Moduli negli strumenti GRASS per la conversione tra tipi di dato

Questa Sezione elenca tutti i moduli con interfaccia grafica negli strumenti GRASS per convertire
dati raster a vettoriali e viceversa nella location e mapset GRASS selezionati.

B.3. Moduli negli strumenti GRASS per la definizione della reg ione e l’impostazione
della proiezione

Questa Sezione elenca tutti i moduli con interfaccia grafica negli strumenti GRASS per la gestione e
la modifica della regione del mapset attuale e per configurare la proiezione.
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B MODULI DEGLI STRUMENTI GRASS

Tabella 16: Strumenti GRASS: moduli per l’importazione di dati

Moduli per l’importazione di dati tra gli strumenti GRASS
Nome del modulo Scopo
r.in.arc Converte un file raster in formato ESRI ARC/INFO ascii (GRID) in un

layer raster (binario)
r.in.ascii Converte un file raster in formato testo ASCII in un layer raster (binario)
r.in.aster Georeferenzia, rettifica, e importa immagini Terra-ASTER imagery e

relativi DEM usando il comango gdalwarp
r.in.gdal Importa raster supportati da GDAL in formato raster binario GRASS
r.in.gdal.loc Importa raster supportati da GDAL in formato raster binario GRASS e

crea una location su misura per la visualizzazione del dato
r.in.gridatb Importa file GRIDATB.FOR (TOPMODEL) in formato raster GRASS
r.in.mat Importa file binari MAT-File(v4) in formato raster GRASS
r.in.poly Crea mappe raster da file ascii descriventi poligoni/linee presenti nella

directory attuale
r.in.srtm Importa file SRTM HGT in GRASS
i.in.spotvgt Importa file SPOT VGT NDVI in mappe raster
v.in.dxf Importa layer vettoriali in formato DXF
v.in.e00 Importa layer vettoriali ESRI E00
v.in.garmin Importa vettori da unità/formati gps usando il comando gpstrans
v.in.gpsbabel Importa vettori da unità/formati gps usando il comando gpsbabel
v.in.mapgen Importa vettoriali in formato MapGen or MatLab in GRASS
v.in.ogr Importa layer vettoriali OGR/PostGIS
v.in.ogr.loc Importa layer vettoriali OGR/PostGIS e crea una location su misura per

la visualizzazione dei dati
v.in.ogr.all Importa tutti i layer vettoriali OGR/PostGIS presenti in una certa

sorgente dati
v.in.ogr.all.loc Importa tutti i layer vettoriali OGR/PostGIS presenti in una certa sor-

gente dati e crea una location su misura per la visualizzazione del
dato
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B.3 Moduli negli strumenti GRASS per la definizione della regione e l’impostazione della
proiezione

Tabella 17: Strumenti GRASS: moduli per per l’esportazione di dati

Moduli per l’esportazione di dati tra gli strumenti GRASS
Nome modulo Scopo
r.out.gdal.gtiff Esporta layer raster in formato Geo TIFF
r.out.arc Converte un raster in un file ESRI ARCGRID
r.gridatb Esporta raster GRASS in file GRIDATB.FOR (TOPMODEL)
r.out.mat Esporta un raster GRASS verso il formato binario MAT-File
r.out.bin Esporta un raster GRASS in una matrice binaria
r.out.png Esporta raster GRASS come immagini non georeferenziate in formato

immagine PNG
r.out.ppm Converte una mappa raster GRASS in formato immagine PPM alla

risoluzione impostata per la region in GRASS
r.out.ppm3 Converte 3 layer raster (RGB) GRASS in formato immagine PPM alla

risoluzione impostata per la region in GRASS
r.out.pov Converte un raster in un campo di altezze per POVRAY
r.out.tiff Esporta una mappa raster GRASS verso un’immagine in formato TIFF

a 8/24bit alla risoluzione impostata per la region in GRASS
r.out.vrml Esporta una mappa raster in formato Virtual Reality Modeling

Language (VRML)
v.out.ogr Esporta layer vettoriali in vari formati supportati dalla libreria OGR
v.out.ogr.gml Esporta layer vettoriali verso il formato GML
v.out.ogr.postgis Esporta layer vettoriali verso vari formati (tramite la libreria OGR)
v.out.ogr.mapinfo Esporta layer vettoriali verso il formato Mapinfo
v.out.ascii Converte un raster binario di GRASS verso il formato vettoriale GRASS

ASCII
v.out.dxf Converte un vettoriale GRASS verso il formato DXF

Tabella 18: Strumenti GRASS: moduli per la conversione tra tipi di dato

Moduli per la conversione tra tipi di dato tra gli strumenti GRASS
Nome modulo Scopo
r.to.vect.point Converte un raster in un vettoriale di punti
r.to.vect.line Converte un raster in un vettoriale di linee
r.to.vect.area Converte un raster in un vettoriale di aree
v.to.rast.constant Converte un vettore ad un raster usando un valore costante per le

categorie
v.to.rast.attr Converte un vettore in un raster usando gli attributi per le categorie
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B MODULI DEGLI STRUMENTI GRASS

Tabella 19: Strumenti GRASS: moduli per la gestione della regione e della proiezione

Moduli per la gestione della regione e della proiezione tra gli strumenti GRASS
Nome modulo Scopo
g.region.save Salva la regione corrente con nome
g.region.zoom Restringi la regione corrente fino a quando non incontra celle non vuote

di una data mappa raster
g.region.multiple.raster Imposta la regione in modo che combaci con l’estensione di più raster
g.region.multiple.vector Imposta la regione in modo che combaci con l’estensione di più

vettoriali
g.proj.print Stampa le informazioni di proiezione per la location corrente
g.proj.geo Stampa le informazioni di proiezione di un file georeferenziato (raster,

vettore o immagine)
g.proj.ascii.new Stampa le informazioni di proiezione di un file ASCII georeferenziato

contenente la descrizione della proiezione in formato WKT
g.proj.proj Stampa le informazioni di proiezione da un file descrittivo di proiezione

in formato PROJ.4
g.proj.ascii.new Stampa informazioni di proiezione da un file ASCII georeferenziato con-

tenente la descrizione della proiezione in formato WKT e crea una nuo-
va location basata su queste informazioni e sull’estensione di questo
file

g.proj.geo.new Stampa le informazioni di proiezione di un file georeferenziato (ra-
ster, vettore o immagine) e crea una nuova location basata su queste
informazioni e sull’estensione di questo file

g.proj.proj.new Stampa le informazioni di proiezione da un file descrittivo di proiezio-
ne in formato PROJ.4 e crea una nuova location basata su queste
informazioni e sull’estensione di questo file

m.cogo Una semplice utility per convertire misure di direzione e distanze
in coordinate e viceversa. Viene assunto un sistema di coordinate
cartesiano

QGIS 1.4.0 User Guide 216



B.4 Moduli negli strumenti GRASS per le operazioni su dati raster

B.4. Moduli negli strumenti GRASS per le operazioni su dati ra ster

Questa Sezione elenca tutti i moduli con interfaccia grafica negli strumenti GRASS per l’effettuazione
di operazioni su dati raster salvati nella location e nel mapset selezionato.

Tabella 20: Strumenti GRASS: moduli per le operazioni su dati raster

Moduli per le operazioni su dati raster tra gli strumenti GRASS
Nome modulo Scopo
r.compress Comprime e decomprime mappe raster
r.region.region Imposta i limiti della regione di un raster a quella di default
r.region.raster Imposta i limiti della regione di un raster a quelli dell’estensione di una

mappa raster esistente
r.region.vector Imposta i limiti della regione di un raster a quelli di una mappa vettoriale

esistente
r.region.edge Imposta i limiti della regione di un raster ai valori impostati (n-s-e-w)
r.region.alignTo Imposta la regione del raster in modo che abbia la risoluzione spaziale

e i limiti di una mappa di riferimento indicata
r.null.val Trasforma il valore di cella specificato in valore nullo
r.null.to Assegna il valore specificato alle celle nulle
r.quant Algoritmo per produrre il file dei quantili di una mappa con valori a

virgola mobile
r.resamp.stats Ricampiona una mappa raster usando il metodo dell’aggregazione

statistica
r.resamp.interp Ricampiona una mappa raster per mezzo dell’interpolazione dei valori
r.resample Ricampiona una mappa raster verso una nuova risoluzione spaziale

precedentemente impostata
r.resamp.rst Reinterpola e esegue l’analisi topografica per mezzo del metodo

regularized spline con i parametri tension e smoothing
r.support Crea, rigenera o modifica i file di supporto di una mappa raster
r.support.stats Aggiorna le statistiche della mappa raster
r.proj Riproietta una mappa raster dalla location originale indicata a quella

corrente
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B MODULI DEGLI STRUMENTI GRASS

Tabella 21: Strumenti GRASS: moduli per la gestione del colore dei dati raster

Moduli per la gestione del colore dei dati raster tra gli strumenti GRASS
Nome modulo Scopo
r.colors.table Imposta la tabella colori del raster a quella selezionata tra quelle

predefinite
r.colors.rules Imposta la tabella colori del raster in base alle regole impostate
r.colors.rast Imposta la tabella colori del raster usando le impostazioni di un raster

esistente
r.blend Miscela le componenti di colore di due mappe raster del valore

impostato
r.composite Miscela le componenti di colore rosso, verde e blu per ottenere un

singolo file raster a colori
r.his Genera mappe raster separate per le componenti rosso, verde e blu

combinando i valori di tonalità (hue), intensità (intensity), e saturazio-
ne (saturation) (metodo his) di una mappa raster in input specificata
dall’utente
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B.4 Moduli negli strumenti GRASS per le operazioni su dati raster

Tabella 22: Strumenti GRASS: moduli per le operazioni di processamento spaziale di dati raster

Moduli per l’analisi geospaziale di dati raster tra gli stumenti di GRA SS
Nome modulo Scopo
r.buffer Crea un buffer di dimensione impostata sui valori del raster
r.mask Crea una maschera (MASK) per limitare l’estensione spaziale sulla

quale eseguire le operazioni sul raster
r.mapcalc Esegue operazioni geospaziali sul raster in modo algebrico
r.mapcalculator Procedura guidata e semplificata per l’esecuzione di operazioni

algebriche geospaziali su mappe raster
r.neighbors Analisi raster di tipo neighbors, con creazione di una nuova mappa ra-

ster i cui valori in una certa posizione sono funzione (media, mediana,
moda, minimo, massimo...) di un certo numero di valori (size) scelti
dall’utente nelle vicinanze di quella posizione

v.neighbors Creazione di una mappa raster in cui i valori di una certa cella sono fun-
zione dei valori degli attributi assegnati a punti o centroidi presenti nel-
le vicinanze della medesima entro un certo raggio di ricerca impostato
dall’utente

r.cross Creazione di una nuova mappa raster che contenga un numero di
categorie pari alle singole combinazioni di categorie dei raster in input

r.series Creazione di una mappa raster in cui ogni cella assume il valore stabi-
lito dalla funzione impostata che opera sui valori di cella delle mappe
scelte dall’utente

r.patch Creazione di una singola mappa raster mediante collage di altre mappe
raster singole

r.statistics Fornisce le statistichedi un layer cover sulla base delle sue relazioni
con un layer base stabilite dalla funzione specificata

r.cost Creazione di una mappa raster contenente il costo cumulativo conse-
guente lo spostamento tra diverse posizioni geografiche su una mappa
raster i cui valori di cella rappresentino costi

r.drain Crea una mappa raster contenente una linea di flusso sulla base dei
valori contenuti in una mappa di elevazione

r.shaded.relief Crea mappe ombreggiate
r.slope.aspect.slope Genera mappe di acclività da modelli digitali di elevazione
r.slope.aspect.aspect Genera mappe di orientazione dei versanti da modelli digitali di

elevazione
r.param.scale Estrae i parametri morfometrici di un’area da un modello digitale di

elevazione
r.texture Genera una mappa raster con le caratteristiche tessiturali di una mappa

raster (prima serie di indici)
r.texture.bis Genera una mappa raster con le caratteristiche tessiturali di una mappa

raster (seconda serie di indici)
r.los Analisi di visibilità su mappe raster
r.clump Raggruppa celle contigue in un’unica categoria
r.grow Genera una mappa raster in cui le aree contigue vengono accresciute

di una cella rispetto alla mappa di partenza
r.thin Assottiglia gli elementi lineari di una mappa raster
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Tabella 23: Strumenti GRASS: moduli per la gestione di superfici

Moduli per la gestione di superfici tra gli strumenti di GRASS
Nome modulo Scopo
r.random Crea una mappa di punti vettoriali campionando una mappa raster in

modo casuale
r.random.cells Genera celle casuali legate tra loro da relazioni spaziali
v.kernel Genera una mappa raster di densità sulla base di un vettoriale di punti

usando un Gaussian kernel
r.contour Produce una mappa vettoriale delle isoipse a partire da una mappa

raster con l’intervallo specificato
r.contour2 Produce una mappa vettoriale delle isoipse elencate dall’utente a

partire da una mappa raster
r.surf.fractal Crea una superificie frattale con dimensione del frattale specificata
r.surf.gauss Crea una mappa raster della deviazione gaussiana la cui media e

deviazione standard è impostata dall’utente
r.surf.random Genera una mappa raster delle deviazioni random il cui intervallo è

impostato dall’utente
r.bilinear Interpolazione bilineare di mappe raster
v.surf.bispline Interpolazione bicubica o bilinear spline con regolarizzazione di

Tykhonov
r.surf.idw Interpolazione di superfici 3d con metodo idw (inverse distance

weighted)
r.surf.idw2 Altra opzione di generazione di superfici 3d con metodo idw
r.surf.contour Generazione di superfici 3d da isoipse raster
v.surf.idw Generazione di superfici 3d per interpolazione di valori di un vettoriale

(metodo idw)
v.surf.rst Generazione di superici 3d per interpolazione di valori di un vettoriale

(metodo Regularized Spline Tension, RST)
r.fillnulls Riempie le aree prive di dati in un raster usando l’interpolazione con il

modulo v.surf.rst
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B.4 Moduli negli strumenti GRASS per le operazioni su dati raster

Tabella 24: Strumenti GRASS: moduli per la modifica delle categorie raster ed etichette

Moduli per le categorie e le etichette tra gli strumenti GRASS
Nome modulo Scopo
r.reclass.area.greater Riclassifica una mappa raster con parcelle di estensioni in ettari

superiori al valore stabilito dall’utente
r.reclass.area.lesser Riclassifica una mappa raster con parcelle di estensioni in ettari inferiori

al valore stabilito dall’utente
r.reclass Riclassifica un raster usando un file di regole preformattato dall’utente
r.recode Ricodifica una mappa raster
r.rescale Riscala gli intervalli dei valori di categoria di una mappa raster

Tabella 25: Strumenti GRASS: moduli per la modellazione idrologica

Moduli per la modellazione idrologica tra gli strumenti GRASS
Nome modulo Scopo
r.carve Trasforma un file vettoriale dei percorsi dei corsi d’acqua in un raster di

determinata larghezza e altezza e lo sottrae al DEM di base per dare
un DEM in uscita

r.fill.dir Filtra e genera una mappa di elevazione priva di depressioni e
una mappa delle direzioni di flusso a partire da un certa mappa di
elevazione

r.lake.xy Riempie i laghi a partire da un punto di alimentazione di coordinate
specificate xy fino ad un livello determinato

r.lake.seed Riempie i laghi a partire da una mappa raster contenente il punto di
alimentazione fino ad un livello determinato

r.topidx Crea una mappa di volume 3D sulla base di una mappa di elevazione
2D e di una mappa raster di valori

r.basins.fill Genera una mappa raster dei bacini imbriferi
r.water.outlet Programma per l’individuazione di bacini imbriferi
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Tabella 26: Strumenti GRASS: moduli per la generazione di report e l’analisi statistica

Moduli per la generazione di report e l’analisi statistica tra gli strum enti di GRASS
Nome modulo Scopo
r.category Stampa le categorie e le etichette descrittive delle stesse di una mappa

raster specificata dall’utente
r.sum Somma i valori delle celle raster
r.report Fornisce le statistiche di una mappa raster
r.average Individua la media dei valori in una mappa di copertura entro le aree

alle quali sia stata assegnata la stessa categoria di una mappa di base
specificata dall’utente

r.median Individua la mediana dei valori in una mappa di copertura entro le aree
alle quali sia stata assegnata la stessa categoria di una mappa di base
specificata dall’utente

r.mode Individua la moda dei valori in una mappa di copertura entro le aree
alle quali sia stata assegnata la stessa categoria di una mappa di base
specificata dall’utente

r.volume Calcola il volume di gruppi di dati e produce una mappa di punti
vettoriale contenente i centroidi di questi raggruppamenti

r.surf.area Calcola l’area di una rete di punti triangolare 3D regolarmente distribuiti
rappresentanti i centri di celle raster

r.univar Calcola le statistiche univariate di celle non nulle in un raster
r.covar Fornisce una matrice di covarianza/correlazione a partire da mappe

raster specificate dall’utente
r.regression.line Calcola la regressione lineare tra due mappe raster secondo la formula:

y = a + b * x
r.coin Tabella la ricorrenza reciproca (coincidenza) di categorie per due

mappe raster
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B.5 Moduli negli strumenti GRASS per le operazioni su dati vettoriali

B.5. Moduli negli strumenti GRASS per le operazioni su dati ve ttoriali

Questa Sezione elenca tutti i moduli con interfaccia grafica negli strumenti GRASS per l’effettuazione
di operazioni su dati vettoriali salvati nella location e nel mapset selezionato.
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Tabella 27: Strumenti GRASS: moduli per la modifica di dati vettoriali

Moduli per la modifica di dati vettoriali tra gli strumenti di GRASS
Nome modulo Scopo
v.build.all Ricostruisce la topologia di tutti i vettori del mapset
v.clean.break Spezza le linee ad ogni intersezione
v.clean.snap Aggancia le linee ai vertici entro una distanza impostata
v.clean.rmdangles Rimuove i dangles
v.clean.chdangles Cambia il dangle dal tipo boundary al tipo linea
v.clean.rmbridge Rimuove i bridges che collegano un’area e un’isola o due isole
v.clean.chbridge Cambia il bridge che collega un’area e un’isola o due isole da un tipo

ad un altro
v.clean.rmdupl Rimuove le linee doppie (fare attenzione alle categorie!)
v.clean.rmdac Rimuove i centroidi doppi in un’area
v.clean.bpol Spezza il perimetro (boundary) in ogni punto condiviso tra due o più

poligoni sul quale convergono segmenti con angolo diverso
v.clean.prune Rimuove i vertici da linee e perimetri (boundaries) entro un valore

impostato
v.clean.rmarea Rimuove aree piccole (rimuove il più lungo perimetro con area

adiacente)
v.clean.rmline Rimuove tutte le linee o perimetri di lunghezza zero
v.clean.rmsa Rimuove piccoli angoli tra linee e nodi
v.type.lb Converte linee in perimetri
v.type.bl Converte perimetri in linee
v.type.pc Converte punti in centroidi
v.type.cp Converte centroidi in punti
v.centroids Aggiunge centroidi mancanti a perimetri chiusi
v.build.polylines Costruisce polilinee da segmenti di linee
v.segment Crea punti/segmenti da in layer vettoriali di linee e posizioni in input
v.to.points Crea punti lungo un vettoriale di linee in input
v.parallel Crea linee parallele a quelle in input
v.dissolve Dissolve limiti tra aree adiacenti
v.drape Converte vettori 2D in vettori 3D campionando un raster di elevazione
v.transform Esegue una trasformazione affine su una mappa vettoriale
v.proj Consente di riproiettare layer vettoriale
v.support Aggiorna i metadati di una mappa vettoriale
v.generalize Generalizzazione di mappe vettoriali
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Tabella 28: Strumenti GRASS: moduli per la gestione del collegamento ai database

Moduli per la gestione del collegamento ai database tra gli stument i di GRASS
Nome modulo Scopo
v.db.connect Connette un vettoriale ad un database
v.db.sconnect Disconnette un vettoriale da un database
v.db.what.connect Imposta/Mostra la connesione al database per un certo vettoriale

Tabella 29: Strumenti GRASS: moduli per la modifica delle categorie di un vettoriale

Moduli per la modifica delle categorie di un vettoriale tra gli strument i di GRASS
Nome modulo Scopo
v.category.add Aggiunge elementi al layer (TUTTI gli elementi del layer selezionato!)
v.category.del Cancella valori di categoria
v.category.sum Aggiunge un valore alle categorie esistenti
v.reclass.file Riclassifica i valori di categoria usando un file di regole
v.reclass.attr Riclassifica i valori di categoria usando una colonna attributi (di tipo

intero positivo)

Tabella 30: Strumenti GRASS: moduli per lavorare con vettoriali di punti

Moduli per lavorae con vettoriali di punti tra gli strumenti di GRAS S
Nome modulo Scopo
v.in.region Crea una nuova mappa vettoriale con l’estensione della regione

corrente
v.mkgrid.region Crea una griglia nella regione corrente
v.in.db Importa punti da una tabella database che ne contiene le coordinate
v.random Genera una mappa vettoriale GRASS di punti casuali 2D/3D
v.kcv Raggruppa casualmente punti in set di test
v.outlier Rimuove estremi da dati vettoriali di punti
v.hull Crea un poligono convesso
v.delaunay.line Triangolazione Delaunay per punti (mediante linee)
v.delaunay.area Triangolazione Delaunay per punti (mediante areae)
v.voronoi.line Diagrammi Voronoi (mediante linee)
v.voronoi.area Diagrammi Voronoi (mediante aree)
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Tabella 31: Strumenti GRASS: moduli per l’analisi spaziale di vettoriali e per l’analisi di reti

Moduli per l’analisi spaziale di vettoriali e per l’analisi di reti tra gli st rumenti di GRASS
Nome modulo Scopo
v.extract.where Seleziona elementi sulla base di attributi
v.extract.list Estrae gli elementi selezionati in base alla lista
v.select.overlap Seleziona gli elementi sovrapposti da quelli di un’altra mappa
v.buffer Creazione di buffer su vettoriali
v.distance Trova nel vettore ’to’ l’elemento più vicino al vettore ’from’
v.net.nodes Crea nodi su una rete
v.net.alloc Alloca la rete
v.net.iso Taglia la rete secondo isolinee di costo
v.net.salesman Connette nodi lungo la strada più corta (commesso viaggiatore)
v.net.steiner Connette i nodi selezionati lungo la diramazione più corta (Steiner tree)
v.patch Crea una nuova mappa vettoriale combinando altre mappe
v.overlay.or Unione logica di vettori
v.overlay.and Intersezione logica di vettori
v.overlay.not Sottrazione logica di vettori
v.overlay.xor Non-intersezione logica di vettori

Tabella 32: Strumenti GRASS: moduli per l’aggiornamento di vettoriali sulla base di altre mappe

Moduli per l’aggiornamento di vettoriali sulla base di altre mappe tra gli strumenti di GRASS
Nome modulo Scopo
v.rast.stats Calcola le statistiche univariate da una mappa raster GRASS sulla base

di oggetti vettoriali
v.what.vect Carica mappe delle quali editare la tabella attributi
v.what.rast Carica i valori del raster nella posizione di punti vettoriali nella tabella

attributi di questi ultimi
v.sample Campiona un file raster nella posizione dei punti vettoriali

Tabella 33: Strumenti GRASS: moduli per i report e le statistiche su un vettoriale

Moduli per i report e le statistiche su un vettoriale tra gli strument i di GRASS
Nome modulo Scopo
v.to.db Inserisce le variabili geometriche nel database del vettoriale
v.report Fornisce un report delle statistiche sulla geometria per i vettoriali
v.univar Calcola le statistiche univariate di una colonna scelta nella tabella

attributi di un vettoriale
v.normal Test di normalità per punti vettoriali
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B.6. Moduli negli strumenti GRASS per le operazioni su immagi ni

Questa Sezione elenca tutti i moduli con interfaccia grafica negli strumenti GRASS per modificare ed
analizzare immagini salvate nella location e nel mapset selezionato.

Tabella 34: Strumenti GRASS: moduli per l’analisi di immagini

Moduli per l’analisi di immmagini tra gli strumenti di GRASS
Nome modulo Scopo
i.image.mosaik Mosaica fino a 4 immagini
i.rgb.his Funzione per la trasformazione del colore di un’immagine dallo spazio

Red Green Blue (RGB) a quello Hue Intensity Saturation (HIS)
i.his.rgb Funzione per la trasformazione del colore di un’immagine dallo spazio

Hue Intensity Saturation (HIS) a quello Red Green Blue (RGB)
i.landsat.rgb Auto-bilanciamento del colore per immagini LANDSAT
i.fusion.brovey Trasformazione di Brovey per fondere canali multispettrali e canali

pancromatici ad alta risoluzione
i.zc Individuazione degli zero-crossing edge per il processamento di

immagini
i.mfilter
i.tasscap4 Trasformazione Tasseled Cap (Kauth Thomas) per dati LANDSAT-TM 4
i.tasscap5 Trasformazione Tasseled Cap (Kauth Thomas) per dati LANDSAT-TM 5
i.tasscap7 Trasformazione Tasseled Cap (Kauth Thomas) per dati LANDSAT-TM 7
i.fft Trasformazione fast fourier (FFT) per il processamento di immagini
i.ifft Trasformazioni inversa fast fourier per il processamento di immagini
r.describe Stampa una lista chiara di valori di categoria trovati nella mappa raster

indicata
r.bitpattern Confronta bit patterns con una mappa raster
r.kappa Calcola l’errore matriciale e il parametro kappa per stabilire

l’accuratezza dei risultati di una classificazione
i.oif Calcola il fattore indice ottimale per bande landsat tm
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B.7. Moduli negli strumenti GRASS per la gestione dei databas e

Questa Sezione elenca tutti i moduli con interfaccia grafica negli strumenti GRASS per gestire, col-
legare e lavorare con database interni ed esterni. Le operazioni su database esterni sono eseguite
tramite OGR e non sono descritte in questa sezione.

Tabella 35: Strumenti GRASS: moduli per i database

Moduli per la gestione ed analisi di database tra gli strumenti di GRA SS
Nome modulo Scopo
db.connect Imposta la connessione al db generale per il mapset
db.connect.schema Imposta la connessione generale al db per il mapset con uno schema
v.db.reconnect.all Ricollega il vettoriale ad un nuovo database
db.login Imposta user/password per il driver/database
db.in.ogr Importa la tabella attributi in vari formati
v.db.addtable Crea e aggiunge una nuova tabella ad un vettoriale
v.db.addcol Aggiunge una o più colonne alla tabella attributi associata ad una certa

mappa vettoriale
v.db.dropcol Elimina una colonna dalla tabella attributi collegata ad una certa mappa

vettoriale
v.db.renamecol Rinomina una colonna della tabella attributi associata ad un vettoriale
v.db.update_const Assegna un nuovo valore costante ad una colonna della tabella attributi

di un vettoriale
v.db.update_query Assegna un nuovo valore costante ad una colonna della tabella attributi

di un vettoriale solo per gli elementi per i quali il risultato della query
impostata è TRUE

v.db.update_op Assegna un nuovo valore, risultante da operazioni su una o più colonne
esistenti, ad una colonna della tabella attributi di un vettoriale

v.db.update_op_query Assegna un nuovo valore, risultante da operazioni su una o più colonne
esistenti, ad una colonna della tabella attributi di un vettoriale, solo per
gli elementi per i quali il risultato della query impostata è TRUE

db.execute Esegue un’espressione SQL
db.select Stampa i risultati della selezione dal database secondo la richiesta SQL
v.db.select Stampa gli attributi di una mappa vettoriale
v.db.select.where Stampa gli attributi di una mappa vettoriale in base ad una richiesta

SQL
v.db.join Consente di unire una tabella a quella esistente di una mappa vettoriale
v.db.univar Calcola la statistica univariata sulla colonna selezionata della tabella di

un vettoriale
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B.8. Moduli negli strumenti GRASS per il 3D

Questa Sezione elenca tutti i moduli con interfaccia grafica negli strumenti GRASS per lavorare con
dati 3D. GRASS fornisce ulteriori moduli, attualmente disponibili solo tramite la shell.

Tabella 36: Strumenti GRASS: Visualizzazione 3D

Moduli per la visualizzazione e l’analisi 3D tra gli strumenti di GRASS
Nome modulo Scopo
nviz Apre la vista tridimensionale in nviz

B.9. Moduli negli strumenti GRASS per l’aiuto in linea

Il manuale di riferimento GRASS GIS Reference Manual offre una panoramica completa di tutti i
moduli GRASS disponibili, senza limitarsi a quelli implementati, a volte con funzioni ridotte, negli
strumenti di GRASS in QGIS.

Tabella 37: Strumenti GRASS: manuale di riferimento

Moduli per consultare il Reference Manual tra gli strumenti di GRA SS
Nome modulo Scopo
g.manual Mostra le pagine del manuale GRASS in formato HTML
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C. GNU General Public License

GNU GENERAL PUBLIC LICENSE

Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place - Suite 330, Boston, MA
02111-1307, USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not
allowed.

Preamble

The licenses for most software are designed to take away your freedom to share and change it. By contrast,
the GNU General Public License is intended to guarantee your freedom to share and change free software–to
make sure the software is free for all its users. This General Public License applies to most of the Free Software
Foundation’s software and to any other program whose authors commit to using it. (Some other Free Software
Foundation software is covered by the GNU Library General Public License instead.) You can apply it to your
programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are
designed to make sure that you have the freedom to distribute copies of free software (and charge for this
service if you wish), that you receive source code or can get it if you want it, that you can change the software
or use pieces of it in new free programs; and that you know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you
to surrender the rights. These restrictions translate to certain responsibilities for you if you distribute copies of
the software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the recipients
all the rights that you have. You must make sure that they, too, receive or can get the source code. And you
must show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which gives you
legal permission to copy, distribute and/or modify the software.

Also, for each author’s protection and ours, we want to make certain that everyone understands that there is
no warranty for this free software. If the software is modified by someone else and passed on, we want its
recipients to know that what they have is not the original, so that any problems introduced by others will not
reflect on the original authors’ reputations.

Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that
redistributors of a free program will individually obtain patent licenses, in effect making the program proprietary.
To prevent this, we have made it clear that any patent must be licensed for everyone’s free use or not licensed
at all.

The precise terms and conditions for copying, distribution and modification follow. TERMS AND CONDITIONS
FOR COPYING, DISTRIBUTION AND MODIFICATION
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0. This License applies to any program or other work which contains a notice placed by the copyright holder
saying it may be distributed under the terms of this General Public License. The Program, below, refers to any
such program or work, and a work based on the Program means either the Program or any derivative work
under copyright law: that is to say, a work containing the Program or a portion of it, either verbatim or with
modifications and/or translated into another language. (Hereinafter, translation is included without limitation in
the term modification.) Each licensee is addressed as you.

Activities other than copying, distribution and modification are not covered by this License; they are outside its
scope. The act of running the Program is not restricted, and the output from the Program is covered only if its
contents constitute a work based on the Program (independent of having been made by running the Program).
Whether that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program’s source code as you receive it, in any medium,
provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice and
disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of any warranty;
and give any other recipients of the Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty
protection in exchange for a fee.

2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based on the
Program, and copy and distribute such modifications or work under the terms of Section 1 above, provided that
you also meet all of these conditions:

a) You must cause the modified files to carry prominent notices stating that you changed the files and the date
of any change.

b) You must cause any work that you distribute or publish, that in whole or in part contains or is derived from
the Program or any part thereof, to be licensed as a whole at no charge to all third parties under the terms of
this License.

c) If the modified program normally reads commands interactively when run, you must cause it, when started
running for such interactive use in the most ordinary way, to print or display an announcement including an
appropriate copyright notice and a notice that there is no warranty (or else, saying that you provide a warranty)
and that users may redistribute the program under these conditions, and telling the user how to view a copy of
this License. (Exception: if the Program itself is interactive but does not normally print such an announcement,
your work based on the Program is not required to print an announcement.)

These requirements apply to the modified work as a whole. If identifiable sections of that work are not derived
from the Program, and can be reasonably considered independent and separate works in themselves, then this
License, and its terms, do not apply to those sections when you distribute them as separate works. But when
you distribute the same sections as part of a whole which is a work based on the Program, the distribution of
the whole must be on the terms of this License, whose permissions for other licensees extend to the entire
whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you;
rather, the intent is to exercise the right to control the distribution of derivative or collective works based on the
Program.

In addition, mere aggregation of another work not based on the Program with the Program (or with a work
based on the Program) on a volume of a storage or distribution medium does not bring the other work under
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the scope of this License.

3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or
executable form under the terms of Sections 1 and 2 above provided that you also do one of the following:

a) Accompany it with the complete corresponding machine-readable source code, which must be distributed
under the terms of Sections 1 and 2 above on a medium customarily used for software interchange; or,

b) Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no more
than your cost of physically performing source distribution, a complete machine-readable copy of the corre-
sponding source code, to be distributed under the terms of Sections 1 and 2 above on a medium customarily
used for software interchange; or,

c) Accompany it with the information you received as to the offer to distribute corresponding source code. (This
alternative is allowed only for noncommercial distribution and only if you received the program in object code
or executable form with such an offer, in accord with Subsection b above.)

The source code for a work means the preferred form of the work for making modifications to it. For an execu-
table work, complete source code means all the source code for all modules it contains, plus any associated
interface definition files, plus the scripts used to control compilation and installation of the executable. However,
as a special exception, the source code distributed need not include anything that is normally distributed (in
either source or binary form) with the major components (compiler, kernel, and so on) of the operating system
on which the executable runs, unless that component itself accompanies the executable.

If distribution of executable or object code is made by offering access to copy from a designated place, then
offering equivalent access to copy the source code from the same place counts as distribution of the source
code, even though third parties are not compelled to copy the source along with the object code.

4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this
License. Any attempt otherwise to copy, modify, sublicense or distribute the Program is void, and will automati-
cally terminate your rights under this License. However, parties who have received copies, or rights, from you
under this License will not have their licenses terminated so long as such parties remain in full compliance.

5. You are not required to accept this License, since you have not signed it. However, nothing else grants you
permission to modify or distribute the Program or its derivative works. These actions are prohibited by law if
you do not accept this License. Therefore, by modifying or distributing the Program (or any work based on the
Program), you indicate your acceptance of this License to do so, and all its terms and conditions for copying,
distributing or modifying the Program or works based on it.

6. Each time you redistribute the Program (or any work based on the Program), the recipient automatically
receives a license from the original licensor to copy, distribute or modify the Program subject to these terms
and conditions. You may not impose any further restrictions on the recipients’ exercise of the rights granted
herein. You are not responsible for enforcing compliance by third parties to this License.

7. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not
limited to patent issues), conditions are imposed on you (whether by court order, agreement or otherwise) that
contradict the conditions of this License, they do not excuse you from the conditions of this License. If you
cannot distribute so as to satisfy simultaneously your obligations under this License and any other pertinent
obligations, then as a consequence you may not distribute the Program at all. For example, if a patent license
would not permit royalty-free redistribution of the Program by all those who receive copies directly or indirectly
through you, then the only way you could satisfy both it and this License would be to refrain entirely from
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distribution of the Program.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of
the section is intended to apply and the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims or
to contest validity of any such claims; this section has the sole purpose of protecting the integrity of the
free software distribution system, which is implemented by public license practices. Many people have made
generous contributions to the wide range of software distributed through that system in reliance on consistent
application of that system; it is up to the author/donor to decide if he or she is willing to distribute software
through any other system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this
License.

8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by copy-
righted interfaces, the original copyright holder who places the Program under this License may add an explicit
geographical distribution limitation excluding those countries, so that distribution is permitted only in or among
countries not thus excluded. In such case, this License incorporates the limitation as if written in the body of
this License.

9. The Free Software Foundation may publish revised and/or new versions of the General Public License from
time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address
new problems or concerns.

Each version is given a distinguishing version number. If the Program specifies a version number of this
License which applies to it and any later version, you have the option of following the terms and conditions
either of that version or of any later version published by the Free Software Foundation. If the Program does
not specify a version number of this License, you may choose any version ever published by the Free Software
Foundation.

10. If you wish to incorporate parts of the Program into other free programs whose distribution conditions are
different, write to the author to ask for permission. For software which is copyrighted by the Free Software
Foundation, write to the Free Software Foundation; we sometimes make exceptions for this. Our decision will
be guided by the two goals of preserving the free status of all derivatives of our free software and of promoting
the sharing and reuse of software generally.

NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE
PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STA-
TED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM -
AS IS WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WI-
TH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY
SERVICING, REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY

COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE PRO-
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GRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPE-

CIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE

THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INAC-

CURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO

OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN

ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
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C.1. Quantum GIS Qt exception for GPL

In addition, as a special exception, the QGIS Development Team gives permission to
link the code of this program with the Qt library, including but not limited to the following
versions (both free and commercial): Qt/Non-commerical Windows, Qt/Windows, Qt/X11,
Qt/Mac, and Qt/Embedded (or with modified versions of Qt that use the same license as
Qt), and distribute linked combinations including the two. You must obey the GNU General
Public License in all respects for all of the code used other than Qt. If you modify this file,
you may extend this exception to your version of the file, but you are not obligated to do
so. If you do not wish to do so, delete this exception statement from your version.
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D. GNU Free Documentation License

Version 1.3, 3 November 2008

Copyright c© 2000, 2001, 2002, 2007, 2008 Free Software Foundation, Inc.

<http://fsf.org/>

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing
it is not allowed.

Preamble

The purpose of this License is to make a manual, textbook, or other functional and useful document
“free” in the sense of freedom: to assure everyone the effective freedom to copy and redistribute
it, with or without modifying it, either commercially or noncommercially. Secondarily, this License
preserves for the author and publisher a way to get credit for their work, while not being considered
responsible for modifications made by others.

This License is a kind of “copyleft”, which means that derivative works of the document must themsel-
ves be free in the same sense. It complements the GNU General Public License, which is a copyleft
license designed for free software.

We have designed this License in order to use it for manuals for free software, because free software
needs free documentation: a free program should come with manuals providing the same freedoms
that the software does. But this License is not limited to software manuals; it can be used for any
textual work, regardless of subject matter or whether it is published as a printed book. We recommend
this License principally for works whose purpose is instruction or reference.

1. APPLICABILITY AND DEFINITIONS

This License applies to any manual or other work, in any medium, that contains a notice placed by
the copyright holder saying it can be distributed under the terms of this License. Such a notice grants
a world-wide, royalty-free license, unlimited in duration, to use that work under the conditions stated
herein. The “Document ”, below, refers to any such manual or work. Any member of the public is a
licensee, and is addressed as “you ”. You accept the license if you copy, modify or distribute the work
in a way requiring permission under copyright law.

A “Modified Version ” of the Document means any work containing the Document or a portion of it,
either copied verbatim, or with modifications and/or translated into another language.
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A “Secondary Section ” is a named appendix or a front-matter section of the Document that deals
exclusively with the relationship of the publishers or authors of the Document to the Document’s
overall subject (or to related matters) and contains nothing that could fall directly within that overall
subject. (Thus, if the Document is in part a textbook of mathematics, a Secondary Section may not
explain any mathematics.) The relationship could be a matter of historical connection with the subject
or with related matters, or of legal, commercial, philosophical, ethical or political position regarding
them.

The “Invariant Sections ” are certain Secondary Sections whose titles are designated, as being
those of Invariant Sections, in the notice that says that the Document is released under this License.
If a section does not fit the above definition of Secondary then it is not allowed to be designated as
Invariant. The Document may contain zero Invariant Sections. If the Document does not identify any
Invariant Sections then there are none.

The “Cover Texts ” are certain short passages of text that are listed, as Front-Cover Texts or Back-
Cover Texts, in the notice that says that the Document is released under this License. A Front-Cover
Text may be at most 5 words, and a Back-Cover Text may be at most 25 words.

A “Transparent ” copy of the Document means a machine-readable copy, represented in a format
whose specification is available to the general public, that is suitable for revising the document
straightforwardly with generic text editors or (for images composed of pixels) generic paint programs
or (for drawings) some widely available drawing editor, and that is suitable for input to text formatters
or for automatic translation to a variety of formats suitable for input to text formatters. A copy made
in an otherwise Transparent file format whose markup, or absence of markup, has been arranged
to thwart or discourage subsequent modification by readers is not Transparent. An image format is
not Transparent if used for any substantial amount of text. A copy that is not “Transparent” is called
“Opaque ”.

Examples of suitable formats for Transparent copies include plain ASCII without markup, Texinfo input
format, LaTeX input format, SGML or XML using a publicly available DTD, and standard-conforming
simple HTML, PostScript or PDF designed for human modification. Examples of transparent image
formats include PNG, XCF and JPG. Opaque formats include proprietary formats that can be read
and edited only by proprietary word processors, SGML or XML for which the DTD and/or processing
tools are not generally available, and the machine-generated HTML, PostScript or PDF produced by
some word processors for output purposes only.

The “Title Page ” means, for a printed book, the title page itself, plus such following pages as are
needed to hold, legibly, the material this License requires to appear in the title page. For works in
formats which do not have any title page as such, “Title Page” means the text near the most prominent
appearance of the work’s title, preceding the beginning of the body of the text.

The “publisher ” means any person or entity that distributes copies of the Document to the public.

A section “Entitled XYZ ” means a named subunit of the Document whose title either is precisely XYZ
or contains XYZ in parentheses following text that translates XYZ in another language. (Here XYZ
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stands for a specific section name mentioned below, such as “Acknowledgements ”, “Dedications ”,
“Endorsements ”, or “History ”.) To “Preserve the Title ” of such a section when you modify the
Document means that it remains a section “Entitled XYZ” according to this definition.

The Document may include Warranty Disclaimers next to the notice which states that this License
applies to the Document. These Warranty Disclaimers are considered to be included by reference
in this License, but only as regards disclaiming warranties: any other implication that these Warranty
Disclaimers may have is void and has no effect on the meaning of this License.

2. VERBATIM COPYING

You may copy and distribute the Document in any medium, either commercially or noncommercially,
provided that this License, the copyright notices, and the license notice saying this License applies to
the Document are reproduced in all copies, and that you add no other conditions whatsoever to those
of this License. You may not use technical measures to obstruct or control the reading or further
copying of the copies you make or distribute. However, you may accept compensation in exchange
for copies. If you distribute a large enough number of copies you must also follow the conditions in
section 3.

You may also lend copies, under the same conditions stated above, and you may publicly display
copies.

3. COPYING IN QUANTITY

If you publish printed copies (or copies in media that commonly have printed covers) of the Document,
numbering more than 100, and the Document’s license notice requires Cover Texts, you must enclose
the copies in covers that carry, clearly and legibly, all these Cover Texts: Front-Cover Texts on the
front cover, and Back-Cover Texts on the back cover. Both covers must also clearly and legibly identify
you as the publisher of these copies. The front cover must present the full title with all words of the
title equally prominent and visible. You may add other material on the covers in addition. Copying
with changes limited to the covers, as long as they preserve the title of the Document and satisfy
these conditions, can be treated as verbatim copying in other respects.

If the required texts for either cover are too voluminous to fit legibly, you should put the first ones listed
(as many as fit reasonably) on the actual cover, and continue the rest onto adjacent pages.

If you publish or distribute Opaque copies of the Document numbering more than 100, you must either
include a machine-readable Transparent copy along with each Opaque copy, or state in or with each
Opaque copy a computer-network location from which the general network-using public has access
to download using public-standard network protocols a complete Transparent copy of the Document,
free of added material. If you use the latter option, you must take reasonably prudent steps, when you
begin distribution of Opaque copies in quantity, to ensure that this Transparent copy will remain thus
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accessible at the stated location until at least one year after the last time you distribute an Opaque
copy (directly or through your agents or retailers) of that edition to the public.

It is requested, but not required, that you contact the authors of the Document well before redistribu-
ting any large number of copies, to give them a chance to provide you with an updated version of the
Document.

4. MODIFICATIONS

You may copy and distribute a Modified Version of the Document under the conditions of sections 2
and 3 above, provided that you release the Modified Version under precisely this License, with the
Modified Version filling the role of the Document, thus licensing distribution and modification of the
Modified Version to whoever possesses a copy of it. In addition, you must do these things in the
Modified Version:

A. Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, and
from those of previous versions (which should, if there were any, be listed in the History section
of the Document). You may use the same title as a previous version if the original publisher of
that version gives permission.

B. List on the Title Page, as authors, one or more persons or entities responsible for authorship of
the modifications in the Modified Version, together with at least five of the principal authors of
the Document (all of its principal authors, if it has fewer than five), unless they release you from
this requirement.

C. State on the Title page the name of the publisher of the Modified Version, as the publisher.

D. Preserve all the copyright notices of the Document.

E. Add an appropriate copyright notice for your modifications adjacent to the other copyright
notices.

F. Include, immediately after the copyright notices, a license notice giving the public permission to
use the Modified Version under the terms of this License, in the form shown in the Addendum
below.

G. Preserve in that license notice the full lists of Invariant Sections and required Cover Texts given
in the Document’s license notice.

H. Include an unaltered copy of this License.

I. Preserve the section Entitled “History”, Preserve its Title, and add to it an item stating at least
the title, year, new authors, and publisher of the Modified Version as given on the Title Page. If
there is no section Entitled “History” in the Document, create one stating the title, year, authors,
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and publisher of the Document as given on its Title Page, then add an item describing the
Modified Version as stated in the previous sentence.

J. Preserve the network location, if any, given in the Document for public access to a Transparent
copy of the Document, and likewise the network locations given in the Document for previous
versions it was based on. These may be placed in the “History” section. You may omit a network
location for a work that was published at least four years before the Document itself, or if the
original publisher of the version it refers to gives permission.

K. For any section Entitled “Acknowledgements” or “Dedications”, Preserve the Title of the sec-
tion, and preserve in the section all the substance and tone of each of the contributor
acknowledgements and/or dedications given therein.

L. Preserve all the Invariant Sections of the Document, unaltered in their text and in their titles.
Section numbers or the equivalent are not considered part of the section titles.

M. Delete any section Entitled “Endorsements”. Such a section may not be included in the Modified
Version.

N. Do not retitle any existing section to be Entitled “Endorsements” or to conflict in title with any
Invariant Section.

O. Preserve any Warranty Disclaimers.

If the Modified Version includes new front-matter sections or appendices that qualify as Secondary
Sections and contain no material copied from the Document, you may at your option designate some
or all of these sections as invariant. To do this, add their titles to the list of Invariant Sections in the
Modified Version’s license notice. These titles must be distinct from any other section titles.

You may add a section Entitled “Endorsements”, provided it contains nothing but endorsements of
your Modified Version by various parties—for example, statements of peer review or that the text has
been approved by an organization as the authoritative definition of a standard.

You may add a passage of up to five words as a Front-Cover Text, and a passage of up to 25 words as
a Back-Cover Text, to the end of the list of Cover Texts in the Modified Version. Only one passage of
Front-Cover Text and one of Back-Cover Text may be added by (or through arrangements made by)
any one entity. If the Document already includes a cover text for the same cover, previously added
by you or by arrangement made by the same entity you are acting on behalf of, you may not add
another; but you may replace the old one, on explicit permission from the previous publisher that
added the old one.

The author(s) and publisher(s) of the Document do not by this License give permission to use their
names for publicity for or to assert or imply endorsement of any Modified Version.

5. COMBINING DOCUMENTS
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You may combine the Document with other documents released under this License, under the terms
defined in section 4 above for modified versions, provided that you include in the combination all of the
Invariant Sections of all of the original documents, unmodified, and list them all as Invariant Sections
of your combined work in its license notice, and that you preserve all their Warranty Disclaimers.

The combined work need only contain one copy of this License, and multiple identical Invariant Sec-
tions may be replaced with a single copy. If there are multiple Invariant Sections with the same name
but different contents, make the title of each such section unique by adding at the end of it, in paren-
theses, the name of the original author or publisher of that section if known, or else a unique number.
Make the same adjustment to the section titles in the list of Invariant Sections in the license notice of
the combined work.

In the combination, you must combine any sections Entitled “History” in the various original do-
cuments, forming one section Entitled “History”; likewise combine any sections Entitled “Ackno-
wledgements”, and any sections Entitled “Dedications”. You must delete all sections Entitled
“Endorsements”.

6. COLLECTIONS OF DOCUMENTS

You may make a collection consisting of the Document and other documents released under this
License, and replace the individual copies of this License in the various documents with a single copy
that is included in the collection, provided that you follow the rules of this License for verbatim copying
of each of the documents in all other respects.

You may extract a single document from such a collection, and distribute it individually under this
License, provided you insert a copy of this License into the extracted document, and follow this
License in all other respects regarding verbatim copying of that document.

7. AGGREGATION WITH INDEPENDENT WORKS

A compilation of the Document or its derivatives with other separate and independent documents or
works, in or on a volume of a storage or distribution medium, is called an “aggregate” if the copyright
resulting from the compilation is not used to limit the legal rights of the compilation’s users beyond
what the individual works permit. When the Document is included in an aggregate, this License
does not apply to the other works in the aggregate which are not themselves derivative works of the
Document.

If the Cover Text requirement of section 3 is applicable to these copies of the Document, then if the
Document is less than one half of the entire aggregate, the Document’s Cover Texts may be placed
on covers that bracket the Document within the aggregate, or the electronic equivalent of covers if
the Document is in electronic form. Otherwise they must appear on printed covers that bracket the
whole aggregate.
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8. TRANSLATION

Translation is considered a kind of modification, so you may distribute translations of the Document
under the terms of section 4. Replacing Invariant Sections with translations requires special permis-
sion from their copyright holders, but you may include translations of some or all Invariant Sections
in addition to the original versions of these Invariant Sections. You may include a translation of this
License, and all the license notices in the Document, and any Warranty Disclaimers, provided that
you also include the original English version of this License and the original versions of those notices
and disclaimers. In case of a disagreement between the translation and the original version of this
License or a notice or disclaimer, the original version will prevail.

If a section in the Document is Entitled “Acknowledgements”, “Dedications”, or “History”, the re-
quirement (section 4) to Preserve its Title (section 1) will typically require changing the actual
title.

9. TERMINATION

You may not copy, modify, sublicense, or distribute the Document except as expressly provided under
this License. Any attempt otherwise to copy, modify, sublicense, or distribute it is void, and will
automatically terminate your rights under this License.

However, if you cease all violation of this License, then your license from a particular copyright holder
is reinstated (a) provisionally, unless and until the copyright holder explicitly and finally terminates
your license, and (b) permanently, if the copyright holder fails to notify you of the violation by some
reasonable means prior to 60 days after the cessation.

Moreover, your license from a particular copyright holder is reinstated permanently if the copyright
holder notifies you of the violation by some reasonable means, this is the first time you have received
notice of violation of this License (for any work) from that copyright holder, and you cure the violation
prior to 30 days after your receipt of the notice.

Termination of your rights under this section does not terminate the licenses of parties who have
received copies or rights from you under this License. If your rights have been terminated and not
permanently reinstated, receipt of a copy of some or all of the same material does not give you any
rights to use it.

10. FUTURE REVISIONS OF THIS LICENSE

The Free Software Foundation may publish new, revised versions of the GNU Free Documentation
License from time to time. Such new versions will be similar in spirit to the present version, but may
differ in detail to address new problems or concerns. See http://www.gnu.org/copyleft/.
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Each version of the License is given a distinguishing version number. If the Document specifies that
a particular numbered version of this License “or any later version” applies to it, you have the option
of following the terms and conditions either of that specified version or of any later version that has
been published (not as a draft) by the Free Software Foundation. If the Document does not specify
a version number of this License, you may choose any version ever published (not as a draft) by the
Free Software Foundation. If the Document specifies that a proxy can decide which future versions
of this License can be used, that proxy’s public statement of acceptance of a version permanently
authorizes you to choose that version for the Document.

11. RELICENSING

“Massive Multiauthor Collaboration Site” (or “MMC Site”) means any World Wide Web server that
publishes copyrightable works and also provides prominent facilities for anybody to edit those works.
A public wiki that anybody can edit is an example of such a server. A “Massive Multiauthor Collabo-
ration” (or “MMC”) contained in the site means any set of copyrightable works thus published on the
MMC site.

“CC-BY-SA” means the Creative Commons Attribution-Share Alike 3.0 license published by Creative
Commons Corporation, a not-for-profit corporation with a principal place of business in San Francisco,
California, as well as future copyleft versions of that license published by that same organization.

“Incorporate” means to publish or republish a Document, in whole or in part, as part of another
Document.

An MMC is “eligible for relicensing” if it is licensed under this License, and if all works that were
first published under this License somewhere other than this MMC, and subsequently incorporated
in whole or in part into the MMC, (1) had no cover texts or invariant sections, and (2) were thus
incorporated prior to November 1, 2008.

The operator of an MMC Site may republish an MMC contained in the site under CC-BY-SA on the
same site at any time before August 1, 2009, provided the MMC is eligible for relicensing.

ADDENDUM: How to use this License for your documents

To use this License in a document you have written, include a copy of the License in the document
and put the following copyright and license notices just after the title page:

Copyright c© YEAR YOUR NAME. Permission is granted to copy, distribute and/or modify
this document under the terms of the GNU Free Documentation License, Version 1.3 or
any later version published by the Free Software Foundation; with no Invariant Sections,
no Front-Cover Texts, and no Back-Cover Texts. A copy of the license is included in the
section entitled “GNU Free Documentation License”.
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If you have Invariant Sections, Front-Cover Texts and Back-Cover Texts, replace the “with . . . Texts.”
line with this:

with the Invariant Sections being LIST THEIR TITLES, with the Front-Cover Texts being
LIST, and with the Back-Cover Texts being LIST.

If you have Invariant Sections without Cover Texts, or some other combination of the three, merge
those two alternatives to suit the situation.

If your document contains nontrivial examples of program code, we recommend releasing these
examples in parallel under your choice of free software license, such as the GNU General Public
License, to permit their use in free software.
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